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Notice

Every effort was made to ensure that the information in this document was 
accurate at the time of printing. However, information is subject to change 
without notice, and Viavi reserves the right to provide an addendum to this 
document with information not available at the time that this document was 
created.

Copyright 

© Copyright 2016 Viavi, LLC. All rights reserved. Viavi, Enabling Broad-
band and Optical Innovation, and its logo are trademarks of Viavi, LLC. All 
other trademarks and registered trademarks are the property of their 
respective owners. No part of this guide may be reproduced or transmitted 
electronically or otherwise without written permission of the publisher.

Trademarks

Viavi, MTS/T-BERD 4000, MTS/T-BERD 2000 and SmartOTDR are trade-
marks or registered trademarks of Viavi in the United States and/or other 
countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet 
Explorer are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark of Netscape 
Communications Corporation in the United States and other countries.

Ordering information

This guide is a product of Viavi's Technical Information Development 
Department, issued as part of the User Manual.
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WEEE Directive Compliance

Viavi has established processes in compliance with the Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and 
should be collected separately and disposed of according to your national 
regulations. In the European Union, all equipment purchased from Viavi 
after 2005-08-13 can be returned for disposal at the end of its useful life. 
Viavi will ensure that all waste equipment returned is reused, recycled, or 
disposed of in an environmentally friendly manner, and in compliance with 
all applicable national and international waste legislation.

It is the responsibility of the equipment owner to return the equipment to 
Viavi for appropriate disposal. If the equipment was imported by a reseller 
whose name or logo is marked on the equipment, then the owner should 
return the equipment directly to the reseller.

Instructions for returning waste equipment to Viavi can be found in the 
Environmental section of Viavi’s web site at www.viavisolutions.com. If you 
have questions concerning disposal of your equipment, contact Viavi’s 
WEEE Program Management team.
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About This Guide
The MTS/T-BERD 2000 of Viavi provides a handheld, modular platform 
designed for the construction, validation and maintenance of fiber 
networks.

The topics discussed in this chapter are as follows:

• “Purpose and scope” on page xviii

• “Assumptions” on page xviii

• “Technical assistance” on page xviii

• “Recycling Information” on page xviii

• “Conventions” on page xix
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Purpose and scope
The purpose of this guide is to help you successfully use the MTS/T-BERD 
2000 features and capabilities. This guide includes task-based instructions 
that describe how to install, configure, use, and troubleshoot the MTS/T-
BERD 2000 with modules.

Assumptions
We are assuming that you have basic computer and mouse/track ball 
experience and are familiar with basic telecommunication and fiber optic 
concepts and terminology.

Technical assistance 
If you require technical assistance, call 1-844-GO-VIAVI. For the latest TAC 
information, go to http://www.viavisolutions.com/en/services-and-support/
support/technical-assistance.

Recycling Information
Viavi recommends that customers dispose of their instruments and periph-
erals in an environmentally sound manner. Potential methods include 
reuse of parts or whole products and recycling of products components, 
and/or materials.
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Waste Electrical and electronic Equipment (WEEE) 
Directive

In the European Union, this label indicates that this product should not be 
disposed of with household waste. Il should be deposited at an appropriate 
facility to enable recovery and recycling.

Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

Table 1 Typographical conventions

Description Example

User interface actions 
appear in this typeface.

On the Status bar, click 
Start.

Buttons or switches that 
you press on a unit appear 
in this TYPEFACE.

Press the ON switch

Code and output mes-
sages appear in this 
typeface.

All results okay

Text you must type exactly 
as shown appears in this 
typeface.

Type: a:\set.exe in the 
dialog box

Variables appear in this 
typeface.

Type the new hostname.

Book references appear in 
this typeface. 

Refer to Newton’s Tele-
com Dictionary
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Table 3 Symbol conventions

A vertical bar | means “or”: 
only one option can 
appear in a single com-
mand.

platform [a|b|e]

Square brackets [ ] indi-
cate an optional argument.

login [platform 
name]

Slanted brackets < > group 
required arguments.

<password>

Table 2 Keyboard and menu conventions 

Description Example

A plus sign +  indicates 
simultaneous keystrokes.

Press Ctrl+s

A comma indicates con-
secutive key strokes.

Press Alt+f,s

A slanted bracket indicates 
choosing a submenu from 
menu.

On the menu bar, click 
Start > Program Files.

NOTEThis symbol represents a general hazard.

Table 1 Typographical conventions (Suite)

Description Example

MTS2100 4100 Module US rev11.book  Page xx  Jeudi, 7. janvier 2016  1:29 13



About This Guide
Conventions

User Manual 77000010208 Rev. 011 xxi

Table 4 Safety definitions

NOTEThis symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related informa-
tion or tip.

NOTEThis symbol, located on the equipment or its 
packaging indicates that the equipment must not be 
disposed of in a land-fill site or as municipal waste, 
and should be disposed of according to your national 
regulations.

NOTEWARNING

Indicates a potentially hazardous situation which, if not 
avoided, could result in death or serious injury.

NOTECAUTION

Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury.
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Chapter 1Principle of Measurement

This chapter gives the principles of the measurements made by the optical 
modules.

The topics discussed in this chapter are as follows:

• “Principle of reflectometry measurements” on page 2

• “Principle of optical power and attenuation measurements” on page 5
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Principle of reflectometry measurements
Optical time domain reflectometry consists in injecting a light pulse into one 
end of the optical fiber to be analyzed and observing, at the same end, the 
optical intensity passing through the fiber in the opposite direction to the 
propagation of the pulse.
The signal detected is exponentially diminishing in form, typical of the 
phenomenon of backscattering, with superimposed peaks due to reflec-
tions from the ends of the fiber or other variations in the refractive index.

Information yielded by the measurement
From a backscatter trace it is possible, in particular, to determine the posi-
tion of a section of fiber within a link. The measurement result must reveal: 

Figure 1 Trace showing typical backscattering
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• the attenuation

• the location of faults, by their distance from a point of origin,

• attenuation with respect to distance (dB/km)

• the reflectance of a reflective event or a link.

Validity of Measurement ITU-T
ITU-T in recommendations G.650, G.651 and G.652, give backscatter 
measurement as an alternative method for measuring attenuation, the 
method of reference being the cut fiber.

The field of application of backscatter is not limited, but the conditions for 
application of this method are nevertheless stipulated:

• injection conditions: Fresnel reflections must be limited at fiber input.

• a high-power source (laser) should be used.

• receiver bandwidth should be chosen to achieve a compromise 
between pulse rise time and noise level.

• backscatter power should be represented on a logarithmic scale.

Reflectance
Reflectance is a value with which the coefficient of reflection of a reflecting 
optical element can be quantified. It is defined as the ratio of the power 
reflected by the element over the incident power.

These reflections are due to variations in refractive index all along the 
optical link in certain telecommunications applications. If they are not 
controlled, they may degrade the performance of the system by perturbing 

To locate faults, a reflectometer measures only time. Conse-
quently, group velocity must be introduced in order to determine 
the distance of the location. This is done by introducing the 
refractive index of the fiber into the instrument.
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the operation of the emitting laser (especially DFB lasers) or may generate 
interference noise in the receiver by multiple reflections.

The reflectometer is particularly well suited to the measurement of discrete 
reflectances on an optical fiber link. To calculate the coefficient of reflec-
tion, it is necessary to measure the total amplitude of the Fresnel reflection 
generated and then to apply a conversion formula to obtain the reflectance 
value.

This formula takes into account:

• the total amplitude of the reflection measured by the reflectometer.

• the pulse width used to measure the amplitude of the reflection (in 
nanoseconds) 

• the backscatter coefficient of the fiber used:

– typical values of the backscatter coefficient for a pulse of 1 ns and

– for a single-mode fiber:-79 dB at 1310 nm

-81 dB at 1550 nm and 1625 nm

– for a multi-mode fiber:-70 dB at 850 nm

-75 dB at 1300 nm

NOTE

To measure the widest range of reflection coefficient, it is neces-
sary to insert a variable optical attenuator between the reflectom-
eter and the link to be tested. This attenuator enables the level of 
the trace to be adjusted so as to avoid saturation of the reflec-
tometer by the reflection to be evaluated.
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Principle of optical power and attenuation 
measurements

Power measurements
A power meter, is all that is needed to measure emitted or received power:

• to measure emitted power, connect the power meter directly to the 
output of the optical emitter;

• to measure the power at the input of an optical receiver, the power 
meter is connected to the end of the fiber, at the point where the 
optical receiver would be connected.

Attenuation measurements (optical link loss)
For measurement of the attenuation of power in a complete link or in 
elements such as sections of fiber, connections or optical components, a 
light source and a power meter are required. 

This attenuation is usually deduced from the measurement of optical power 
at two points:

Attenuation A(dB) = P1 (dBm) - P2 (dBm)

To perform accurate measurements, the following conditions are neces-
sary

• Use a light source which is stable both in time and as a function of 
temperature.

Laser light 
Refer- Link under test Power meter of 

1 2
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• Make sure that all connections and fibers and the receiving cell are 
perfectly clean.

• Use a reference link between the laser source and the test subject. If 
several measurements are to be made under identical light injection 
conditions, this reference fiber must not be disconnected during the 
period while measurements are taking place.

Insertion loss method

1 The power meter is first connected to the laser source via the refer-
ence fiber: P1 is measured.

2 Then the fiber to be tested is inserted between the reference fiber 
and the power meter: P2 is measured.

The difference between P2 and P1 gives the attenuation of the fiber 
under test.

It is preferable to use the same type of connector at both ends of the 
fiber being tested, to ensure the same connection conditions for 
measuring P1 and P2.

Accuracy of measurements

• A high degree of accuracy is often required. It is then necessary to 
perform a preliminary calibration without the fiber under test to elimi-
nate the losses due to connections as far as this is possible. To do 
this, use the «Reference Value» function.
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Chapter 2Starting up

This chapter describes how to start using the MTS/T-BERD.

The topics discussed in this chapter are as follows:

• “Unpacking the device - Precautions” on page 8

• “Fitting and removing a module (not available with SmartOTDR)” on 
page 8

• “Connecting fiber optic cable” on page 11

• “Optical connectors and interchangeable adapters” on page 14
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Unpacking the device - Precautions
We suggest that you keep the original packing material. It is designed for 
reuse (unless it is damaged during shipping). Using the original packing 
material ensures that the device is properly protected during shipping.

If another packaging is used (for returning the equipment for example), 
Viavi cannot give warranty on good protection of the equipment.

If needed, you can obtain appropriate packing materials by contacting Viavi 
Technical Assistance Center.

Fitting and removing a module (not 
available with SmartOTDR)

Fitting a module
1 Turn the instrument face down on the work surface.

2 Set the two notches on the module part (1a) into the two holes 
provided for that purpose on the Base (1b).

3 Make flush the 2 connections (2a & 2b), on module and base.

4 Once positioned, fix the module to the base screwing the 2 screws 
(3a) fixing the receptacle.

5 With a T-BERD/MTS 4000, repeat the process if a second small 
module must be installed at the back of the platform.

The MTS/T-BERD must be switched off, and if it is operating 
on the mains, its supply cable must be unplugged.
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Figure 2 Fixing the module to the 2000 Base-Unit

Captive screws fixing the module

1b
1b

2a

2b

2000 Platform with module installed

2000 Platform without module

1a
1a

3a
3a
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Removing a module
1 Unscrew the two captive fixing screws of the module completely (up 

to the stop).

2 Remove the two slots of the module from their housing onto the 
base.

3 Carefully remove the module out of its slot.

Figure 3 Fixing the module to the 4000 Base-Unit

Captive screws fixing the module(s)

1a1b

2b

2a

1a

2a
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Connecting fiber optic cable

Inspecting and cleaning connector end faces

• Optical connector contamination is the #1 source of performance 
degradation and test equipment repair

• A single particle mated into the core of a fiber can cause significant 
back reflection, insertion loss and equipment damage. Visual inspec-
tion is the only way to determine if the fiber connectors are truly clean 
before mating them.

Follow this simple "INSPECT BEFORE YOU CONNECT" process to 
ensure fiber end faces are clean prior to mating connectors

Always inspect and clean the connector end face of the 
optical fiber cable and the test port before mating both 
together.

Viavi is not responsible for damage and reduced perfor-
mance caused by bad fiber handling and cleaning.

Figure 4 "Inspect Before You Connect" process
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Optical connector types
There are many optical connectors in the market place. Always ensure to 
use a high quality connector that meets the international standards. 

Two main types of connectors are deployed in the telecommunication 
industry: 

1 Straight polished connectors, so called PC or UPC

2 Angled polished connectors, so called APC

The PC or UPC-type test port is identified by a grey cap with the addition 
of a "PC" label. 

The APC-type test port is identified by a green cap with the addition of a 
"APC" label.

Figure 5 Modules with APC and PC connector for T-BERD/MTS 2000 & 
4000
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Caution

Never connect a PC connector into an APC test port or vice versa. This will 
result in damaging the connector end faces.

Connecting Fiber optic cable to test port
After ensuring proper cleaning of both end connectors, follow the below 
steps in order to correctly and safely connect the optical fiber into the test 
port:

1 Carefully align the connector and test port to prevent the fiber end 
from touching the outside of the port and scratching the end face.

Figure 6 PC/APC bad connection

WARNING

Viavi declines responsibilities of connector damages if a poor 
quality connector is used or APC to PC connections made. Test 
port connector repair will be charged

WARNING

All the universal connectors are available on the OTDR Modules, 
except on the LA Module.
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2 Push the connector to firmly place it inside ensuring physical end 
face contact.

Optical connectors and interchangeable 
adapters

Fiber Optic modules may come equipped with a universal connector and 
adapter selected at time of order.

NOTE

If your connector features a keying mechanism, ensure that it is 
correctly fitted into the test port's insert.

NOTE

If your connector features a screw-on sleeve, tighten the connec-
tor to firmly maintain the fiber in place. Do not over tighten as this 
will damage the fiber and the test port.

WARNING

Never force the connector ferrule or insert it with an angle into 
the test port adapter. Mechanical stress may permanently dam-
age the ceramic sleeve of the adapter or the end face of the con-
nector. A new adapter purchase only will get the unit back to 
operation
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Adapter types
Viavi offers 5 different adapters, all compatible with this connector, allowing 
the user to switch from one adapter to another according to which fiber type 
he intends to work with.
Adapter types supplied are: FC, SC, DIN, ST and LC.

Switching adapter type
In order to switch from an adapter to another, proceed as shown.

Figure 7 5 different types of adapters may be mounted on the universal 
connector

FC Adapter (EUFCAD)

DIN Adapter (EUDINAD) ST Adapter (EUSTAD)

SC Adapter (EUSCAD)
LC Adapter (EULCAD)

Figure 8 Removing and refitting an adapter

Pull out in the direction of the 
arrow in order to release the 
adapter from the lug holes

To place an adapter, position 
the handle as shown in order to 
engage with the the lugs, push 
hard and pull the handle down
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Changing the adapter on a LA OTDR Module 
and on the SmartOTDR

The LA modules are equipped with specific connector and adapters.

The adapters available are FC or SC adapters, screw type.

To mount a new adapter onto the LA Module:

1 Unscrew the two screws of the adapter currently mounted onto the 
connector.

2 Remove the adapter

3 Set the new adapter vertically on the optical connector, making flush 
the «mark» on the adapter with the mark on the connector.

4 Fix the adapter with the two screws.

Figure 9 Position of the adapter onto the connector
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Once adapter is mounted, the module is ready to be used onto the 
Base-Unit.

Cleaning universal connectors
Remove the adapter in order to access the ferrule and clean it using a 
cotton swab.

Figure 10 Fixing the adapter

NOTE

When changing the optical connector, take caution not to scratch 
the connector mating surfaces. Carefully align the removable 
piece and the baseplate ferrule when inserting the adapter part.
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Chapter 3Activating OTDR function

Once the OTDR module is correctly set onto the equipment and the MTS/
T-BERD is switched on, the desired OTDR function must be selected 
before any OTDR configuration, or measurement.

The topics discussed in this chapter are as follows:

• "Selecting the Smart Test" page 20

• "Selecting the OTDR Expert function" page 21
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Selecting the Smart Test

Principle of the Smart Test
The Smart Test is used to perform OTDR acquisitions using a pre-loaded 
configuration file (no setup required) and access to essential analysis 
features.

Selecting Smart Test
The Smart Test function is available whatever is the OTDR module set onto 
the MTS/T-BERD.

To select this function, after the equipment starts:

1 Press the HOME button

2 Select the Smart Test icon 

The icon turns yellow .

Figure 11 Home page
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After a few seconds, the Results page displays.

Selecting the OTDR Expert function

Principle of the OTDR Expert
The OTDR Expert is used to

• perform OTDR acquisitions with full OTDR setup capabilities, and 
advanced analysis features.

• create configuration files that can be loaded by Smart Test users.

Selecting OTDR Expert
The OTDR Expert function is available whatever is the OTDR module set 
onto the MTS/T-BERD.

To select this function, after the equipment start:

NOTE

The selection of Smart Test icon automatically deselects the 
Expert OTDR icon and vice-versa.

NOTE

In the case a Singlemode/Multimode module, one line contains 
the Multimode icons and a second one the Singlemode icons.

To distinguish both modes, multimode icons contain the MM 
mark.
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1 Press the HOME button

2 Select the OTDR Expert icon 

The icon turns yellow .

After a few seconds, the Results page displays.

NOTE

The selection of OTDR Expert icon automatically deselects the 
Smart Test icon and vice-versa.

NOTE

In the case a Singlemode/Multimode module, one line contains 
the Multimode icons and a second one the Singlemode icons.

To distinguish both modes, multimode icons contain the MM 
mark.
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Chapter 4Configuring the reflectometry 

test

This chapter describes the different stages in configuring a reflectometry 
measurement using an OTDR module, in Smart Test or Expert OTDR.

The topics discussed in this chapter are as follows:

• "Configuring the unit for Smart Test" page 24

• "Configuring the test in Expert OTDR" page 27
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Configuring the unit for Smart Test
Once the Smart Test icon is validate, the Results page displays automat-
ically.

Before any test in Smart Test:

1 select the configuration file, which contains all acquisition parameters 
and file storage setup, and which has been created in Expert mode 
(see “Saving OTDR configuration in a file” on page 50).

2 the user can then configure / modify some parameters before starting 
the test

Selecting the configuration file
To load the configuration file to be used for Smart Test test:

1 Press SETUP hard key.

2 On bottom right of setup page, press Load Config. menu key.

3 In the Explorer, select the desired file configuration (example: Auto 
test singlemode) 

4 Press Load > Load as SMART Config. menu keys.

A beep is emitted to validate the selection of the configuration file.
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5 Press RESULTS hard key to go to results page and perform OTDR 
acquisition with the pre loaded configuration.

Modifying some parameters before the 
acquisition

In Smart Test mode, the user have access to 4 parameters he can modified 
before launching the test.

To display and modify i necessary the parameters:

1 Once Results page is displayed, press SETUP hard key

The Setup page for OTDR acquisition in Smart Test mode displays.

Figure 12 Load file as Smart Test Configuration

NOTE

Most of the configuration files are available into the equipment, in 
disk/config.
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Laser The acquisition will be carried out on the
wavelength(s) selected (for multiple-wavelength
modules). In case of a multi-wavelength module,
select All to perform a measurement for all the
wavelengths available (this parameter visible
exclusively on modules with one single OTDR port).
The possible values depend on the module used. 

Fiber Number Modify, if necessary, the number of the fiber using left
and right direction keys.

Distance unit select the unit to be used for distance (km / kfeet /
miles / meter / feet).

Config. This parameter displays the configuration file selected
for Smart Test acquisition, and cannot be modified.

Press RESULTS hard key to return to results page and launch the acquisi-
tion (it can be launched directly from the Setup page).

Figure 13 Smart Test Setup page
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Configuring the test in Expert OTDR
Once the Expert OTDR icon is selected, the Results page automatically 
displays.

In Expert OTDR, the parameters for acquisition and for file storage can be 
configured.

1 To call up the test configuration window, press the SETUP button.

Dialog boxes and menu keys on the same screen enable selection of

In these windows, the parameter selected is in video inverse.

– Acquisition parameters

Used for the OTDR acquisition– Alarms parameters

– Analysis parameters

– Link parameters
Used for the OTDR results saving

– File parameters 

Figure 14 OTDR setup in Expert OTDR mode
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Configuring the Acquisition parameters
You can choose the OTDR acquisition parameters. 

1 Once the Setup page is displayed, press Acquisition menu key to 
configure the Acquisition parameters.

The Acquisition Setup page is divided into two parts: the Acquisition box 
and the Launch cable box.

Parameters

Laser

The acquisition will be carried out on the wavelength(s) selected (for 
multiple-wavelength modules). In case of a multi-wavelength module, 
select All to perform a measurement for all the wavelengths available (this 
parameter visible exclusively on modules with one single OTDR port). The 
possible values depend on the module used. 

Acquisition

Select the kind of acquisition to be performed:

Manual The acquisition parameters Pulse / Range / Resolution 
can be set by user.

Auto The acquisition parameters Pulse / Range / Resolution 
are defined automatically and cannot be modified

The Measurement time will be set to Auto, but can be modified (see 
"Time" page 29).

If some acquisition parameters are not accessible (not visible or 
displayed in grey), check in the Home page that the Expert 
OTDR function is selected (see "Selecting the OTDR Expert 
function" page 21).
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Range

The possible range depends on the pulse length selected. This range is 
given for each pulse length in the paragraph "Ranges" page 258. This 
parameter is exclusively configurable if Acquisition parameter is set to 
Manual. It depends on the module/SmartOTDR used.

Auto allows to detect automatically the range.The range is 
selected as a function of the end of the fiber.

Pulse

From 3ns to 20µs according to module/SmartOTDR used. Parameter 
selectable only if Acquisition parameter is set to Manual.

See "Typical specifications" page 256.

Resolution

This parameter is exclusively configurable if Acquisition parameter is set 
to Manual.

Auto resolution is selected automatically according to the last 
two parameters above.

High Resolution the highest resolution is applied

High Dynamic the highest dynamic is applied

Time

Real time the equipment performs up to ten acquisitions per second 
(see "Performing OTDR acquisitions" page 56).

NOTE

According to the value selected for Pulse parameter, the Range 
parameter can be automatically modified, and vice-versa.
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Manual Enter the acquisition time desired (from 5 s. to 5 minutes 
max).

Predefined Select one of the acquisition times predefined: 10 seconds 
/ 20 seconds / 30 seconds / 1 minute / 2 minutes / 3 
minutes.

Smart Acquisition (not available in Multimode) 

This parameter allows to launch a short acquisition before the standard 
one.

The first acquisition is performed with the shortest pulse in order to detect 
more precisely the events at the beginning of the fiber.

To configure the Smart Acq. parameter:

Auto a first short acquisition is performed with the shortest pulse 
in the range, before the standard one.

No the standard acquisition is directly launched.

If the option OptiPulses is available, see “Configuring the OTDR acquisi-
tion with OptiPulses TM mode” on page 105 to configure the OTDR acquisition 
with this option.

NOTE

Whatever is the acquisition mode selected, an acquisition in real 
time mode can be launched maintaining the START/STOP button 
pushed for about 2 seconds.

NOTE

If the Acquisition parameter is defined to Auto, then the Time 
parameter is defined to Auto, but can be modified.
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Otdr Connector test

This parameter allows to choose if a test of the front connector must be 
performed when acquisition is launched.

No the OTDR connection is tested with indication Bad/
Good.

Yes & Continue the OTDR connection is tested, and if the state is not
good, the acquisition continues but a warning displays.

Yes & Abort the OTDR connection is tested, and if the state is bad,
a warning displays and the acquisition stops.

Launch cable parameters

Launch Cable End / Receive Cable Start

No All the results are displayed and referenced on the basis of 
the board of the module.

Evt 1, 2, 3 The results relating to the launch cable are eliminated from 
the table. Attenuation and distances are then measured on 
the basis of the marker Evt 1, 2 or 3 selected.

Distance Use the Edit Number key to enter a distance (Min= 0 / 
Max=50 km / 164.042 kfeet / 31.075 miles) or affect the 
active cursor value, using the Set Cursor Distance key.
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Include Link Start Connector / Include Link End Connector 

Defining the Launch Cable End parameter with an event number or a 
distance will automatically activate the corresponding parameter Include 
Link Start Connector. This parameters can be set to Yes if the budget 
must include the connectors loss of the launch cable at end 

Defining the Receive Cable Start parameter with an event number or a 
distance, will automatically activate the corresponding parameter Include 
Link End Connector. This parameters can be set to Yes if the budget must 
include the connectors loss of the launch cable at start 

If those parameters are set to No, the budget only displays the connector 
loss of the fiber.

Figure 15 Launch Cable / Receive Cable

OTDR 

Launch Cable Receive Cable
Fiber Under Test

Launch 
Cable end

Receive 
Cable start

Distance of the 
launch cable

Distance of the 
receive cable
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Configuring the Alarms parameters
In the Setup page, press Alarms softkey (if one parameter is selected in 
the current screen, press Top Menu soft key to display the right menu keys 
and click on Alarms).

Once the Alarms page is displayed, configure the parameters for applying 
thresholds to results displayed.

Threshold

None The alarm function is not active.

User Thresholds can be defined for: Splice Loss / Connector 
Loss / Reflectance / Splitter Alarm / Slope / Fiber Length 
Min and Max / Link Loss Min and Max / ORL.

TIA-568 C / ISO/IEC 11801 / Default / G.697/G.98x PON / G.697/IEEE 
PON

Select one of this parameter to configure the alarm thresholds with 
predefined values:

Table 1 Singlemode Modules

Default
G.697/G.98x PON
G.697/IEEE PON

TIA-568C
ISO/IEC 11801

Splice Loss > 0.20 dB > 0.30 dB > 0.30 dB

Connector loss > 0.50 dB > 0.50 dB > 0.75 dB

Slope1 > 1.00 dB/km - > 1.00 dB/km

Reflectance > - 35 dB > - 35 dB

ORL < 27 dB

Splitter Alarm

1 X 2 > 5.0 dB > 4.2 dB

1 X 4 > 8.0 dB > 7.8 dB

1 X 8 > 11.0 dB > 11.4 dB

1 X 16 > 14.0 dB > 15.0 dB
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If results are above those thresholds, they are highlighted in red in the table 
of results, and the icon  appears at the top right of the screen.

If all the results lie within the thresholds (no result is in red or yellow), they 
are displayed in green in the table and the icon  is displayed at the right 
top of the trace.

1 X 32 > 17.0 dB > 18.6 dB

1 X 64 > 21.0 dB > 22.0 dB

Link Loss Max Select: No/ Manual or: 

• for G.697/G.98x PON: 
20 dB (A) / 25 dB (B) / 
30 dB (C)

• for G.697/IEEE PON: 
30 dB (C) / 23 dB (PX-
10) / 26 dB (PX-20)

1. This parameter is not available in OEO-OTDR configuration

Table 1 Singlemode Modules

Default
G.697/G.98x PON
G.697/IEEE PON

TIA-568C
ISO/IEC 11801

Table 2 Multimode Modules (not available in SmartOTDR)

Default
TIA-568C 
ISO/IEC 11801

Splice Loss > 0.20 dB > 0.30 dB

Connector Loss > 0.50 dB > 0.75 dB

Slope 850 nm > 3.50 dB/km > 3.50 dB/km

Slope 1300 nm > 1.50 dB/km > 1.50 dB/km

Reflectance > - 35 dB -

ORL < 27 dB -
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Configuring the Analysis parameters
In the Setup page, press Analysis softkey (if one parameter is selected in 
the current screen, press Top Menu soft key to display the right menu keys 
and click on Analysis).

The Analysis Setup page is divided into two parts: the Parameters box and 
the Measurement box.

Parameters

Section Attenuation

dB/km Displays the section slope in the table of results. When the 
fiber is too short to measure the slope accurately, no value 
is displayed (empty field).

dB Displays the section Loss in the table of results. With short 
fiber where the slope cannot be measured with a good 
accuracy, the loss in dB is approximate and displayed.

None The section attenuation and Loss values are not displayed 
in the table of results.

Index of refraction

Choice of group refraction index of the whole fiber. 

User Define for each wavelength (1310 SM, 1360-1510 SM, 
1550 SM, 1625 SM) a refraction index of 1.30000 to 
1.69999. The selection of an index alters the value of the 
section AB (actual distance between cursors A and B).

or,

If the actual distance between the cursors A and B is 
known, enter its value under Section AB to establish the 
index of the fiber. Selection of this distance causes the 
display of the indices. The extreme distance values are 
given by the index values (1.30000 à 1.70000).
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Predefined It is possible to choose one of the predefined values given 
for certain cables. The corresponding indices given in the 
table below are repeated on the screen.

Figure 16 Predefined index values (Single Mode)

Wavelength (nm)
1310 
SM

1360 - 1510 
SM

1550 
SM

1625 - 1650 
SM

Generic G652 G657 1.46750 1.46800 1.46800 1.46850

Generic G653 G655 1.46750 1.46800 1.46800 1.46850

ATT SM 1.46600 1.46700 1.46700 1.46700

Corning SMF-28 1.46750 1.46810 1.46810 1.46810

Corning SMF-DS 1.47180 1.47110 1.47110 1.47110

Corning SMF-LS 1.47100 1.47000 1.47000 1.47000

Corning-Leaf 1.46890 1.46840 1.46840 1.46900

Draka SMF 1.46750 1.46800 1.46800 1.46850

Draka Longline 1.46700 1.46700 1.46710 1.46750

Draka Teralight 1.46820 1.46820 1.46830 1.46850

Draka Benbright 1.46750 1.46750 1.46800 1.46850

Fitel Furukawa 1.47000 1.47000 1.47000 1.47000

OFS Lucent Allwave 1.46750 1.46750 1.46750 1.46850

Lucent Truewave 1.47100 1.47100 1.47000 1.47000

SpecTran SM 1.46750 1.46810 1.46810 1.46810

Sterlite 1.46700 1.46700 1.46750 1.46750

Sumitomo Litespec 1.46600 1.46600 1.46700 1.47000

Sumitomo Pure 1.46600 1.46600 1.46700 1.47000
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Scatter coefficient
User Selects for each wavelength, the backscatter coefficient of 

-99 dB to -50 dB by increments of 0.1dB. Modification of 
the backscatter coefficient K changes the measurements 
of reflectance and ORL. 

Auto Backscatter coefficients are selected automatically for 
each wavelength.

In Multimode, two predefined scatter coefficients are available:

Generic 50 850 MM - >  -66.3 dB

1300 MM -> -73.7 dB

Generic 62.5 850 MM ->  -66.1 dB

1300 MM -> -70.3 dB

The default values are given in the paragraph "Reflectance" page 3.

Distance Unit

Define the unit of the distances displayed: km, kfeet, miles, meter, feet.

Figure 17 Predefined index values (Multi Mode) - Not available in 
SmartOTDR

Wavelength (nm) 850 MM 1300 MM

Corning 62.5 1.50140 1.49660

Corning 50 1.48970 1.48560

SpecTran 62.5 1.49600 1.49100

Generic 50 1.49000 1.48600

Generic 62.5 1.49000 1.48700

Generic OM1-62/125 1.49600 1.49100

Generic OM2-3- 4  50/125 1.48200 1.47700
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Results on trace

None the trace alone

All the trace with results and markers.

Graphics the trace with markers only.

If All or Graphics is selected, the reflectometry trace is displayed with a 
dotted vertical line set on the end of launch cable  (if the Launch Cable 
is defined in the SETUP menu) and a dotted vertical line on the end of fiber 

.

Event Notes1

No no display of notes

Notes display of notes entered by the user 

Uncertainty display of indicators of the level of confidence in the 
measurement result.

Measurement

Otdr Connector Measurement

This parameter allows to choose if a measurement of the front connector 
must be performed when acquisition is launched.

No In the results table, the first line corresponds to the first 
event detected.

Yes In the results, the first result corresponds to the front 
connector measurement, at 0 meter (estimated value).

Number of Splitters (not available in Multimode) 

Once parameter is selected, press Edit Number key to display the numeric 
keypad and select the wished value:

1.Available exclusively if Super Expert license is installed
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None there is no splitter set onto the network.

Discover Auto-detection and identification of PON splitter types.

1 to 3 If the number of splitters if known, select it from the list 
(from 1 splitter to 3 splitters).

This selection opens a sub menu into which the splitters types must be 
defined for all splitters installed.

  Splitters types

Splitter 1: define the splitter type among the list:

– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64

– 2x2 / 2x4 / 2x8 / 2x16 / 2x32 / 2x64

Splitter 2 and Splitter 3: define the splitter type among the list:

– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64

Detection
Splice Select if a level of detection for splice must be defined.

Press Edit Number soft key and select a value:

– Enter a min level of detection, from 0.01 to 1.99 dB

– No: no splice detection

– Auto: to automatically detect splice

Reflectance Select if level of detection for reflectance must be defined.

Press Edit Number soft key and select a value:

– Enter a min level of detection, from -98 to -11 dB

– None: no reflectance detection

– All: all reflectances are detected

Ghosts Choice (Yes / No / No Analysis) of whether information 
relating to ghosts is to be displayed. If ghosts are 
displayed, the reflection icon in the table of results appears 
dotted and the reflection value is displayed in brackets on 
the trace, for example «(R:-50 dB)».
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Fiber end Once parameter is selected, press Edit Number key to 
display the numeric keypad and select the wished value:

– Auto (recommended): option in which the T-BERD/MTS auto-
matically detects the end of a fiber.

– > 3 to > 20 dB (steps of 1 dB): threshold of detection of end of 
fiber. 

Bend (not available in Multimode) With any dual or triple-wave-
length measurement module, the user will have access to 
the macro bend detection function in the test setup. Each 
event of the selected wavelengths will then be compared.

Once parameter is selected, press Edit Number key to display the 
numeric keypad and select the wished value:

– None: Bend will not be detected.

– Auto: Bend will be automatically detected.

– Define by user: Enter the bend value (in dB), with direction 
keys or numeric keypad.

Configuring the Link parameters
In the Setup page, press Link softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys and 
click on Link).

NOTE

The softkey Copy File/Link to all is displayed when one param-
eter is selected in the Link or File Setup page and when the Pow-
ermeter or Source function is active. 

It allows to apply the Link and File configuration parameters of 
the current applications to all the other active Fiber Optic applica-
tions (powermeter, and source).
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The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters. When a 
trace is recalled without recall of the configuration, the parameters of this 
trace will be present only in its signature.

Fiber ID

Select the parameter Fiber Id and enter a name for the fiber, using the 
edition keypad.

Fiber Number / Fiber Code

The parameter Fiber Number becomes Fiber Code if, in the Cable Struc-
ture window, the Cable Content parameter is defined on another param-
eter than Fiber (Ribbon/Fiber, Tube/Fiber or Tube/Ribbon/Fiber). See 
page 43.

The fiber code corresponds to the fiber number if, in the Cable Structure, 
the parameter Color coding is defined on No. 

The fiber code corresponds to the fiber color if, in the Cable Structure, the 
parameter Color coding is defined on Yes.

1 Select the parameter Fiber Number/Fiber Code and modify the 
parameter using the left and right direction keys.

The fiber number can be automatically incremented/decremented at 
each new file save if it has been configured in the File Setup page 
(see “Configuring the file storage parameters” on page 47).

NOTE

The Fiber Code and the fiber number concatenated with Fiber 
Name are interdependent: they are incremented or decremented 
at the same time. However, the fiber number remains a number 
only, while the fiber code is alphanumerical. Whether it includes a 
color code or not (see “Cable structure” on page 43), it may be 
composed of one, two or three parts (see figure Table 18 on 
page 42). 
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Change Fiber Nbr 

Increment the fiber number is automatically incremented at each new 
file-save.

Decrement the fiber number is automatically decremented at each 
new file-save

User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the 
number. Example: -1.

Min: -999 / Max: 999 / Auto: 0

 No the Fiber number must not automatically modified.

Extremities are different1

In some cases, it is interesting to save different information for the origin 
and the extremity of the cable.

Figure 18 Example of incrementation of fiber code

Fiber and cable parameters used in the example:

Fiber Name: ’Fiberx’
Cable Content: ’Tube/Fiber’
Max Tube: 12
Max Fiber: 24
Coding used for the fiber and the tube: TIA

Fiber N Fiber N+1

 Color Code  Yes No Yes  No

<Fiber Name> Fiberx24 Fiberx24 Fiberx25 Fiberx25

<Fiber Code> Bl/Aq- 1/24 Gold/Bl 2/1

1.Available exclusively if Super Expert license is installed
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If this option is validated, it is possible, after selecting the extremity to be 
edited in the Cable Structure menu, to modify the values specific to the 
cable (cable name, color coding, content of the coding), for each of these 
extremities. See chapter “Cable structure” on page 43) 

To display/modify the data specific to the fiber (name and code), it is neces-
sary to change direction temporarily. In the "O->E" direction, the informa-
tion on the origin can be edited, and in the "E->O" direction, that on the 
extremity.

Cable Id

This parameter allows to enter an identification of the cable, using the 
Edition menu.

Direction

The direction shows if the acquisition has been made from the origin to the 
extremity (A->B) or from the extremity to the origin (B->A). Changing direc-
tion makes it possible, when different extremities are handled, to see the 
parameters of the fiber for the other extremity.

Location A

The name of the Location A of the link may be entered here.

Location B

The name of the Location B of the link may be entered here.

Cable structure1

This line opens a sub-menu, all the parameters of which can be different 
for each extremity.

1.Available exclusively if Super Expert license is installed
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View extremity
If extremities are declared as different (see “Extremities 
are different” on page 42), this parameter allows to navi-
gate between the Extremity and Origin parameters.

Cable Id If the extremities are different, you can specify the cable 
identification for the origin and the extremity.

Color Coding Choice of whether or not to apply a color coding to the 
fiber. This choice is made at link level, as all the fibers of a 
given link, for a given extremity, will be coded the same 
way. This choice modifies the result of the <Fiber Code> 
line. See “Fiber Number / Fiber Code” on page 41.

Cable content Shows how the color code is to be used (see figure “Cable 
structure menu” on page 44):

– FiberOnly the color code of the fiber is proposed (example: 
«Gold»)

Figure 19 Cable structure menu

NOTE

The Cable Structure window is specific to an extremity. Each 
struc-ture keeps its own parameters by default. Modifications 
made to the one are not automatically applied to the other. Thus, 
after the values relating to the origin have been modified, it is nor-
mal not to find these same values entered for the extremity.
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– Ribbon/Fiber The color code of the fiber is preceded by that of 
the ribbon, and separated by a ’/’ (example: ’Bl/Or’)

– Tube/Fiber The color code of the fiber is preceded by that of the 
tube, and separated by a ’/’ (example: ’Br/Or’)

– Tube/Ribbon/Fiber
The color code of the fiber is preceded by that of the tube, then 
by that of the ribbon; the three being separated by a ’/’ (example: 
’Br/Bl/Or’). See “Fiber Number / Fiber Code” on page 41. 

Max tube Shows the maximum number of tubes in the cable for the 
extremity selected. This information influences the auto-
matic coding of the fiber. See “Fiber Number / Fiber Code” 
on page 41.

Max ribbon Shows the maximum number of ribbons in the cable for 
the extremity selected. This information influences the 
automatic coding of the fiber. See “Fiber Number / Fiber 
Code” on page 41.

Max fiber Shows the maximum number of fibers in the cable for the 
extremity selected. This information influences the auto-
matic coding of the fiber. See “Fiber Number / Fiber Code” 
on page 41.

Tube Coding, Ribbon Coding, Fiber Coding

The lines Tube Coding, Ribbon Coding and Fiber Coding 
enable selection of the color coding of the tube, the ribbon 
and the fiber from 5 different codes described below: TIA, 
USER 1, USER 2, USER 3 and USER 4.

NOTE

Certain parameters are not valid in the configuration selected. 
Thus, if no tube is selected in Cable Content, all the lines relat-
ing to the tube concept will be deactivated (grayed out in the 
menu).
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Code Definition
The Code Definition line opens a sub-menu, with which 
the different color codes possible on the instrument can be 
displayed and modified.

Five different codes can be managed by the T-BERD/MTS, including a 
standard code. 

The standard code (TIA) may be displayed but it cannot be modified.

The other codes, called by default USER1, USER2, USER3 and USER4, 
can be entirely personalized.

– Edited codeselects the code for display or modification.

– Code nameto give a new name to the code selected, press the 
 key, which calls up the edit menu.

– View codesdisplays the color codes 1 to 12, 13 to 24 or 25 to 36.

– Code 1...23Use the arrow  to modify the codes if necessary.

Operator

Use the arrow  to enter the name of the operator carrying out the 
measurement.

Job Id

Use the arrow  to enter a description of the measurement to be 
performed.

Comment

In contrast to the other data in this menu, the comment is specific to a fiber. 
This line is thus used to enter a new comment and not to display it. The 
comment appears at the top of the screen, with the other parameters of the 
fiber.
This comment will remain available for the next acquisition, unless it is 
deleted. It is also saved when a trace is saved with a comment.
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Configuring the file storage parameters
The File storage parameters must be also configured, in order to define 
how the results traces will be saved onto the MTS/T-BERD 2000.

In the Setup page, press File softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys and 
click on File).

Dir

This parameter cannot be configured, and display the directory selected by 
default into which the file(s) will be saved (the last directory selected).

To modify the directory, go to the Explorer page and select another direc-
tory.

Filenaming

Select Filenaming parameter and press the right arrow key to modify the 
name of the file for the result trace.

In the edition keypad, enter a name manually for the file and/or use 
the predefined parameters available (Cable_Id, Fiber_Num...). 
Then, press Enter to validate.

NOTE

The softkey Copy File/Link to All is displayed when one param-
eter is selected in the Link or File Setup page and when the Pow-
ermeter or Source function is active. 

It allows to apply the Link and File configuration parameters of 
the current applications to all the other active Fiber Optic applica-
tions (powermeter, and source). 
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or

Press Default Filename to apply the name by default to the file:

Fiber[Cable_Id][Fiber_Num]_[Lambda]_[Direc-
tion][Pulse]

The name of the file is displayed in grey under Filenaming parameter

File Content

In this parameter, select the file content for traces saving:

One Trace in case of traces in overlay, each trace is saved in a 
distinct file (.sor extension).

All Traces in case of traces in overlay, all traces are saved in one 
single file (.msor extension).

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can 
select three types of methods for storing traces:

File Only only the trace(s) is/are stored in one/several file(s), with its 
extension (.sor, .msor)

Figure 20 Filenaming - Edition keypad

Predefined 
parameters for 
naming files
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File + txt the trace(s) is/are stored in one/several file(s), with its 
extension and one txt file is also generated.

File + pdf the trace(s) is/are stored in one/several file(s), with its 
extension and one pdf file is also generated.

All the trace(s) is/are stored in one/several file(s), with its 
extension and one pdf file + one txt file are also generated.

Auto Store

Select Yes to store automatically the trace or traces resulting from each 
acquisition according to the filenaming rules.

Configuration in Test Auto mode
The Test Auto key imposes the parameters for acquisition, measurement 
and display of results defined as default settings in factory.

ACQUISITION Acquisition Laser All

Acquisition Auto

Time Auto

Smart Acq No

OTDR Connector Test Yes & Cont

Launch Cable Launch Cable End No

Launch Cable Start No

ALARMS Alarms Thresholds None

ANALYSIS Parameters Section Attenuation dB/km

Index of Refraction G652 G657

Scatter Coefficient Auto

Results on trace Graphics

Measurement OTDR Connector Meas. No
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Saving OTDR configuration in a file
Once File and Measurement parameters have been configured, those 
parameters can be kept in memory and saved in a configuration file.

This configuration file can then be recalled in two cases:

• in order to be applied when acquisition in Smart Test mode is 
performed.

• in order to be recalled for future acquisition in Expert OTDR

To save parameters in a configuration file:

1 If necessary, press SETUP to return to Setup page.

2 Select one parameter in one of the setup page (acquisition, link..)

3 Press menu key .

An edition keypad displays

4 Enter a name for the configuration file (max. 20 characters).

Number of Splitters None

Splice Auto

Reflectance All

Ghost No

Fiber End Auto

Bend Auto

LINK Link Description Change Fiber Nr Increment

FILE File configura-
tion

Filenaming Auto filenaming

Fiber[Cable_Id][Fiber_Num]_[Lambda][Direc-
tion][Pulse]

Auto Store Yes
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5 Press Enter to validate

A sound is emitted to indicate the file is saved.

The configuration file is saved with the extension .fo_cfg (icon ) 
and can be recalled at any time from the Explorer page.

This configuration file can be selected in Smart Test (see “Selecting the 
configuration file” on page 24) or loaded for Expert OTDR.

Loading an existing OTDR configuration
To load a configuration file previously created or available in the T-BERD/
MTS/ SmartOTDR and apply parameters to new OTDR Expert tests:

NOTE

Configuration file is saved by default in the directory disk/con-
fig.

Figure 21 Save Configuration file - Edition keypad

Directory into 
which file will 
be saved
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From the File Explorer page

1 Press FILE hard key

2 Select the configuration file desired

3 Press Load > Load Config.

• Press SETUP hard key to display the OTDR acquisition parameters 
saved in the selected configuration file.

You can modify some acquisition or file storage parameters, and save them 
in a new configuration file (see “Saving OTDR configuration in a file” on 
page 50).

From the Setup page

1 Select one header in either Setup page (Acquisition, Link, File...)

2 Press Load Config. menu key.

The file Explorer page displays

3 Select the configuration file desired

4 Press Load Config. to load the configuration file for acquisition in 
OTDR Expert mode.

A sound is emitted to confirm the loading.

The Setup screen is displayed again.

If the menu key Load as SMART Config. is pressed, the config-
uration is applied for acquisition in OTDR Expert, and in Smart 
Test mode too.

NOTE

Most of the configuration files are available into the equipment, in 
disk/config.
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Figure 22 Loading a configuration file

Configuration file will 
be used for Expert 
OTDR acquisition 
only

Configuration file will 
be used for Expert 
OTDR and Smart-
Test acquisitions

The main parameters available in the selected 
configuration file are displayed in the File signature.
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Chapter 5Launching a reflectometry 

test and displaying results

Once the configuration for acquisition and file storage has been defined, 
the instrument is ready to launch an OTDR measurement.

Pressing the START/STOP key is all that is needed to start or stop an OTDR 
measurement on the MTS/T-BERD or on the SmartOTDR.

This chapter describes the different stages in a reflectometry measure-
ment. It then describes the functions available on trace(s).

The topics discussed in this chapter are as follows:

• "Performing OTDR acquisitions" page 56

• "Results display" page 66

• "Advanced functions in Expert OTDR mode" page 81

• "Saving the trace(s) and generating a report" page 96

• "SLM (Smart Link Mapper) option" page 100

• "OptiPulsesTM option" page 104
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Performing OTDR acquisitions

Performing an acquisition in Real Time mode

Principle of the Real time mode

Acquisition in real time must not be used if a precise measurement is 
required because of the high noise level, but it is sufficient for rapid optimi-
zation of a connection and for observing a fiber in process of utilization.

Performing acquisition in Real Time

To carry out an acquisition in real time:

1 Hold the START/STOP key down for about three seconds, to launch 
the acquisition in real time, either in Smart Test or Expert OTDR 
mode, whatever is the acquisition mode selected.

or

If the Time parameter is defined with Real Time in Setup page in 
Expert OTDR mode, press START/STOP hard key.

The red Testing indicator will go on to show that real time acquisition 
is in progress. The trace acquired is displayed in real time. 

An indicator of the state of the connection (Good/Bad) is displayed 
below the trace:
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If the state of the connection is bad, it is still possible to carry out a 
measurement, but the results will not be very reliable.

Traffic detection

Traffic on the fiber under test is automatically detected and reported.

Press the START/STOP key to begin the measurement. A message indi-
cates there is traffic on the fiber and asks you if you wish to continue or not:

Table 3 Connection indicator

State Connection

Good The connection is OK

Bad • There are several connectors close to the external connector of 
the MTS/T-BERD.

• One of the connectors is dirty or badly connected. Replace the 
launch cable, make the connection again properly or clean the 
connector of the OTDR or of the jumper.

• No fiber is connected.

Figure 23 Example of acquisition in Real Time (with Expert OTDR)
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• If you click on NO, the measurement is not launched.

• If you click on YES, the measurement is performed, despite the traffic.

The functioning of Traffic Detection is then indicated in the scaled down 
representation of trace, on the upper left part of screen .

During an acquisition in real time, several actions can be made on results 
in progress: see "Actions on trace during acquisition" page 63.

Stopping the real time acquisition

To stop or interrupt an acquisition in real time mode, press the START/STOP 

key at any time.

Performing a measurement with Smart Test
The acquisition is carried out with the parameters saved in the Configura-
tion file. It may be stopped at any time using the START/STOP key.

At the end of test, the results page displays.

1 Press START/STOP hard key to launch measurement.

The red Testing indicator goes on to show that the T-BERD/MTS is 
in process of acquisition and the screen displays the trace in process 
of acquisition.

NOTE

If the measurement is validated despite the traffic (key YES), the 
next measurement will be automatically performed, even if traffic 
is still detected on fiber.

If the measurement is cancelled (key NO), and the START/STOP 
pushed another time, the box asking if you wish to continue or 
not is displayed.
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2 The quality of the connection is displayed for a 
few seconds (see Table 3 on page 57)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

At the end of the acquisition, a beep is emitted, and the measurements are 
displayed.

Figure 24 Acquisition in progress in Smart Test

Number of 
averages 

Elapsed 
acquisition 

Total acquisition 
time

Elapsed 
time

NOTE

During acquisition, the traffic on fiber is automatically detected 
(see "Traffic detection" page 57)
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Performing an acquisition with Expert OTDR
In this mode, the equipment carries out a number of averagings defined as 
a function of the maximum acquisition time specified in the Acquisition 
menu, and then terminates the acquisition. 

The acquisition is carried out with the parameters previously selected in the 
Acquisition menu. It may be stopped at any time using the START/STOP 

key.

1 Press the START/STOP key to start the acquisition.

The red indicator goes on to show that the product is in process of 
acquisition and the screen displays the trace in process of acquisi-
tion.

2 The quality of the connection is displayed for a 
few seconds (see Table 3 on page 57)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

Figure 25 Acquisition in progress with Expert OTDR

Number of aver-
ages calculated

Elapsed acqui-
sition time

Total acqui-
sition time

Elapsed 
time
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At the end of the acquisition, a beep is emitted, the trace is displayed and 
an automatic measurement is started.

Performing an acquisition from Results page
Once the results page is displayed, you can perform a new acquisition 
modifying the main acquisition parameters.

1 On Results page:

in Expert OTDR mode, press the softkey Quick Setup: the acquisi-
tion parameters that can be modified display under the results trace.

In Smart Test mode, press the softkey Setup: the Setup screen 
displays (see Figure 13 on page 26).

NOTE

During acquisition, the traffic on fiber is automatically 
detected (see "Traffic detection" page 57)

NOTE

To stop the acquisition, the START/STOP key may be pressed at 
any time. Then an automatic measurement is carried out, but 
some events cannot be detected (a manual measurement must 
then be made).

Before launching a new OTDR acquisition, make sure the 
trace(s) displayed have been previously saved if necessary, 
as the new acquisition will automatically delete the dis-
played results.
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2 Modify the acquisition parameters wished in the displayed menu:

– In Expert OTDR mode: Laser / Acquisition / Range / Pulse / 
Time

See page 28 and page 29.

– In Smart Test mode: Laser / Fiber Number / Distance unit

See page 24.

3 Once configured, launch the new OTDR test pressing the START/
STOP hard key.

Press again (Quick) Setup menu key to hide the menu under the trace.

Multi-wavelength acquisition 
If the module possesses several lasers, to perform successive acquisitions 
on all the wavelengths:

1 In the SETUP menu, check in Laser line, that several lasers are 
selected (or select All if a module with only one OTDR port is 
used).

2 Start the acquisition by pressing the START/STOP button.

Figure 26 Results page and Quick Setup menu (Expert OTDR)
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3 Once the acquisition for the first wavelength is finished, the acquisi-
tion for the following wavelength starts automatically.

or 

To stop manually the acquisition for current wavelength, click on 
Stop Wavelength. This will allow to automatically start the measure-
ment for the following wavelength.

The different traces appear in the same window and can be handled simi-
larly to overlaid traces (see "Overlay trace function" page 90).

Actions on trace during acquisition
During an acquisition, several actions are available on results in progress.

Positioning Cursors A and B

1 Select Cursor A or Cursor B and:

– Set both cursors A & B to control distance between two points.

– Set one cursor A or B to get the distance from one point.

– Set one cursor A or B to zoom on this cursor

Zooming on trace

1 Select Zoom function:

– use the menu key  in Smart Test 

– use the menu key  in Expert OTDR

2 Use touchscreen or validation key to zoom in and zoom out on trace 
(see “Zoom function” on page 74)
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Shifting the trace (Expert OTDR only)

In Expert OTDR mode only, the trace can be shifted vertically or horizon-
tally during the acquisition:

1 Select Shift function on menu key 

2 Use touchscreen or direction keys to shift horizontally or vertically the 
trace (see “Shift function (Expert OTDR only)” on page 77)

Displaying Trace or Summary page

1 Use the menu key Trace/Summary to display either:

• the acquisition trace in progress and the bar graph of time

• the Summary page with exclusively the bar graph of time.

In the case of measurement on several wavelengths, once a measurement 
is completed for one wavelength:

• the Trace function allows to display the trace and results table for this 
wavelength: once Trace is selected, press validation key (  or 
ENTER) to pass from Trace + results table on 1 line to Trace + results 
table on 4 lines, and vice-versa,

• the Summary function allows to display a summary of results for this 
wavelength.

Modifying acquisition parameters (in Real Time mode 
only)

You can modify the acquisition parameters without returning to the SETUP 

menu. 

1 Press the Acquisition Param key

2 Use displayed keys to scroll through the possible values of the 
various acquisition parameters.
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Zooming on the fiber end (in Real Time mode only)

During a real time acquisition, you can reach the end of the fiber under test 
at any time:

1 Press Zoom to End menu key.

The display automatically reaches the end of the fiber under test.

The menu key Zoom to End becomes Zoom to Start.

Press Zoom to Start to display the start of the fiber under test.

Performing measurements during acquisition (Real Time 
mode only)

The real time mode allows to make Loss, ORL or Reflectance measure-
ment using the A & B cursors and the key Loss / ORL / Reflect.:

1 Position A & B cursors on the trace

2 Click as many times as necessary on key  to get the 
measurement between A & B cursors.

Figure 27 Example of acquisition in Real Time
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Results display
The traces acquired or recalled from a memory are displayed on the 
Results page. According to the mode of acquisition (Expert OTDR or Smart 
Test), the results page offers similar functions, but also different functions.

Figure 28 Example of loss measurement

Figure 29 Example of results trace with Smart Test
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• On the upper right side, the alarm icon is displayed (if some alarm 
thresholds are defined in the pre loaded configuration file).

Common functions

Display of events on the trace

Each event detected is referenced under the trace by a serial number. The 
reflectometry trace is displayed with a dotted vertical line set on the start of 

Figure 30 Example of results trace with Expert OTDR

Table 4 Alarms display

Fail Indicates that at least one result exceeds the alarm thresh-
olds defined in the configuration file used for acquisition
Results are displayed in red in table.

Valid Indicates that all the results lie within the thresholds (no 
result is in red or yellow).
Results are displayed in green in the table.
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launch cable  (if the Launch Cable End parameter is defined in the 
SETUP menu)

The trace can also be displayed with a dotted vertical line on the end of 
fiber .

The icon  is displayed on trace if the Receive Cable Start parameter 
has been defined in the Setup menu.

The results of the measurements of attenuation, reflectance and slope can 
be marked on the trace.

The reflectance of a ghost event is displayed in brackets on the trace.

Criteria for display of an event

An event will be displayed if its attenuation or its reflectance exceeds the 
corresponding threshold selected in the SETUP menu (see "Configuring the 
test in Expert OTDR" page 27). Attenuation and reflectance results for an 
event will be displayed if they can be calculated

The reflectance of an event is always measured except when the event 
causes a saturated Fresnel peak or if it is drowned out by noise. In this 
case, the T-BERD/MTS displays > to show that the actual reflectance 
exceeds the value displayed. 

Results table

Under the trace is displayed the results table with all the events detected 
during acquisition.

• In Smart Test: if the Total Loss and End of fiber values are displayed 
under the trace (see Figure 29 on page 66)

– click on the trace overview (upper left part of the screen) to 
display the 4-lines results table
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or

– select Trace on Trace/Summary softkey and press validation 
key (  or ENTER) to display the 4-lines results table

Repeat one of this method to come back to Total Loss and End of fiber 
values.

• In ExpertOTDR mode, once Trace is selected, press validation key 
(  or ENTER) to pass from Trace + results table on 1 line to Trace + 
results table on 4 lines, and vice-versa 

The table with one line displayed under the trace gives the type and 
characteristics of the event nearest to the cursor.

The 4 lines table gives the type and the characteristics of all the 
events detected during the measurement: the 4 first lines displayed 
correspond to the 4 first events nearest to the cursor. The line corre-
sponding to the event nearest to the cursor is highlighted. This high-
lighting moves if the cursor is moved.

Figure 31 Trace + Table results in Smart Test
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At the top of the table, a line shows the generic parameters of the fiber: 
numbers of events present, total ORL of the link and, in ExpertOTDR 
mode, reference trace icon (if trace is the reference trace - see “Reference 
Trace function” on page 93).

Each event is referenced under the trace by a number which is repeated in 
the first column of the table. The table then shows:

• icon symbolizing the type of the event: 

Receive cable Start

Launch cable End: the attenuation and distances are measured on 
the basis of the corresponding marker.

Non-reflective attenuation (e.g. splice).

Splitter.

Reflective event. (e.g. connector)

Ghost reflection

Figure 32 Example of trace and results table in Expert OTDR
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Slope of the fiber (when no fault follows the slope).

End of fiber

OTDR connector

Merged Connectors Loss 

– Total group loss = loss on last connector

– Loss connector N-1 = 0 dB)

Event marker when a measurement cannot be carried out. If the 
event to be added is too close to an existing event, the icon appears 
on the trace and the table, but no measurement is carried out: to 
obtain the results for this event, a manual measurement is neces-

sary.

The event underlined in yellow is the one the nearest of the cursor set on 
trace. To visualize an event, click on this event on the table to set the cursor 
on it onto the trace.

Detailed description of an event

Click on one event icon in the results table to display the event type and the 
alarm threshold defined for this event (if Alarms have been defined in the 
Setup page).

If the value of the event selected exceeds the defined threshold, then the 
possible causes for this alarm are described in the window:
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The following columns are then displayed next to each event icon:

Cursors

The cursors A and B are represented by vertical lines of different colors:

• in a solid line if the cursor is selected.

• in a dotted line if the cursor is not selected.

Figure 33 Event description
C

lic

Distance
The distance of the event from the beginning of 
the fiber, in meters (or miles)

Loss The attenuation due to the event, in dB

Reflect. The reflectance of the event, in dB

Slope
(Expert OTDR only)

The slope before the event, in dB/km (or dB/kft) if 
it can be measured

Section
(Expert OTDR only)

The length of the section = the distance between 
the marker of the event and the previous marker.

T. Loss
The total attenuation of the fiber (total loss), in 
dB
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Positioning the cursor

1 Press the key  to active the cursor.

2 Touch the screen on the required location on trace where the active 
cursor must be set.

You can also use the direction keys  and  to move the selected 
cursor along the trace

Above the trace is shown the 2-points loss measurement between the two 
cursors, together with the distance between the two cursors.

When the cursor function is selected, the keys  and  move the trace 
vertically.

Cursors information

The information related to cursors are displayed exclusively when the 
Cursor function is selected (menu key  selected).

Above the trace are shown the co-ordinates of the points of intersection of 
the cursors A and B with the trace, together with the distance between the 
two points.

The cursors data are displayed exclusively if the Cursor 
menu key is active. If another key is active, the display 
shows help tooltips, different according to the selected 
function.
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Cursor function not selected

When Cursor menu key is not selected, the upper banner displays informa-
tion, different according to the menu key selected:

• If the Trace/Summary key is selected, with Trace function valid, the 
upper banner indicates that to change the displayed trace, you can 
click on the banner or on the right arrow key

• If the Zoom/Shift key is selected, and the Zoom function valid, the 
upper banner indicates that to get an automatic or full zoom, you 
must press validation key (  or ENTER).

Zoom function

The Zoom function is used to analyze part of the trace in greater detail. The 
zoom is centred on the active cursor.

The position of the section of trace displayed with respect to the complete 
trace is represented by a red rectangle on the mini-trace at the top left-hand 
corner of the screen. 

Figure 34 Cursors information

The Cursor function 
is not selected

The Cursor function 
is selected
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Defining a zoom on the trace using the touchscreen or 
screen deported on PC

1 Press Zoom or Zoom/Shift softkey to activate the zoom function

– menu key  in Smart Test 

– menu key  in Expert OTDR

2 Press once in one location on the screen, which will represent the 
upper left corner of the zoomed area.

The icon  is displayed on the screen.

3 Press another time on the location which will represent the lower right 
corner of the zoom.

Defining a zoom level on the trace using direction keys

1 Select Cursor A or B and center it on the zone to be examined

2 Press Zoomsoftkey.

3 Use the or key to increase or reduce the zoom factor, keeping 
the selected cursor centered on screen.

Figure 35 Zoom on trace using touchscreen

First 

Second 

Zoomed 
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Swapping from an automatic zoom to full trace and vice-
versa

The automatic zoom allows to get an optimized display of the trace.

To apply an automatic or entire zoom on the trace:

1 Press Zoom softkey.

2 Press validation key (  or ENTER) to apply an auto zoom on trace.

Press again validation key (  or ENTER) to display the trace in full 
screen.

Specific functions of the zoom with a touchscreen

With the touchscreen, once the Zoom function is selected on menu key 
Zoom, you can:

• maintain your finger pressed on screen and shift the traces horizon-
tally or vertically

• position your finger on a cursor and move it on trace maintaining your 
finger pressed and moving it toward left or right

• once a zoom is performed, double click on the zoomed zone to undo 
the zoom

Zooming on the different events in succession

1 Set the cursor on one event

2 Define a zoom on this event.

3 Click on another event in the results table.

The cursor is automatically positioned on this event, which is always 
centered on the screen, keeping the zoom level selected.
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Shift function (Expert OTDR only)

The Shift function is used to displace the displayed section of the trace by 
pressing the direction keys or directly clicking on the touchscreen. 

The horizontal shift is performed maintaining the point of intersection 
between the trace and the selected cursor at the same level, scrolling the 
trace horizontally while following it vertically, so that it never goes off the 
screen.

To use this function:

1 Select the zoom factor as described above.

2 Choose cursor A and cursor B position.

3 On the Zoom/Shift key, select Shift.

4 Displace trace manually on touchscreen toward left/right or upward/
backward.

or

Use the direction keys to shift the trace in the desired direction 

Summary

To display a summary of the results, select Summary function on Trace/
Summary menu key.

The upper table displays a summary of results for each wavelength onto 
which measurement has been performed.

Some results can be displayed in color (green or red) if they lie within or 
exceed the alarm thresholds defined in the Setup screen in ExpertOTDR 
mode and defined in the configuration file used for acquisition in Smart Test 
mode (see “Selecting the configuration file” on page 24).
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In the lower part of the screen, the Alarms table, gives the summary of the 
alarms detected (Reflectances, Splices, Splitters, Connectors, Bends...).

Select one event in the Alarm table and click on Event Diagnosis menu 
key or directly on the event icon in the Alarm table to get a detailed descrip-
tion of the event.

Click on Trace View softkey to return to display of Trace + Results Table.

Figure 36 Summary page & Alarms table

Figure 37 Summary key - Event Diagnosis
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Display of traces in overlay
• The traces are shown in different colors (the active trace is green).

• The mains acquisition parameters are displayed at the top of the 
screen.

Selecting one trace from overlaid traces

To make actions on a trace in overlay (move on events, set a cursor...), it 
must first be swapped with the active trace. To do this:

1 Press the Trace key

2 Press the direction keys  and , as many times as 
necessary, until the active trace is displayed in green. 

or

Click on the trace numbers in the upper right side of the 
result page until the trace desired is selected.

or

Click on the upper part of the screen, in Trace information zone to 
scroll the traces.

Figure 38 Traces in overlay

traces 
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Traces display in double acquisition mode

When a double acquisition has been performed, i.e. a short acquisition 
preceding a standard one (see “Smart Acquisition (not available in Multi-
mode)” on page 30), two traces are displayed in the same window.

The short trace is the one resulting from the short acquisition and stops 
while the standard one continues until the end of measurement.

NOTE

Actions relative to traces (move cursors, move on events...) are 
exclusively done on the active trace (in green), not on the other 
ones.

Figure 39 Traces display in double acquisition mode

Short acquisi-
tion (in blue)

Standard acquisi-
tion (in green)

Figure 40
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Advanced functions in Expert OTDR mode
Several actions on trace displayed can be performed in ExpertOTDR mode 
only.

Automatic measurement and detection
If the instrument does not detect all the expected events, additional manual 
measurements can be carried out.

To delete all the markers:

1 Press the Advanced key

2 Press the Modify meas.key, 

3 Select Delete.

4 Press validation key (  or ENTER)

The following procedure is then recommended:

1 By default, the instrument locates the events and proceeds to the 
measurements.

2 Addition of events (see “Addition of events” on page 82) in the cases 
of splices showing low attenuation and of close events. The T-BERD/
MTS then automatically measures the slope before and after the 
markers selected and measures the attenuation of the splice.

3 Addition of manual measurements if necessary (for deeper analysis). 
The T-BERD/MTS performs the measurements requested by the 
user.

To start an automatic measurement while a measurement is already in 
progress:

1 Press the Advanced key.

2 Press the Modify meas.key
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3 Select Delete and press validation key (  or ENTER).

4 Select Auto Meas. and press validation key (  or ENTER).

Addition of events
You can also manually place markers in addition to those positioned auto-
matically during automatic measurement.

Representation of the events

The events are represented by the symbol : if they are set during a 
measurement.

The events are represented by the symbol  if they are set manually in 
Advanced mode.

To add markers of events:

1 Select a cursor (A or B).

2 Use the direction keys or touchscreen to move the cursor to the place 
where you want to position a marker.

3 Press the keys: Advanced > Set Event.

4 An event marker  is displayed at the position of the cursor and a 
measurement is carried out on the event. 

Measurement of slope before the marker starts just after the previous 
event (or at the end of the dead zone at the beginning of the fiber); 
measurement of slope after the marker stops just before the next 
marker or at the end of the fiber.
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Hints on the positioning of markers

• Do not add markers (with the Set Event key) after a manual 
measurement, as all the results will be recalculated automatically by 
the instrument.

• If two markers are too close together, they will appear on the trace 
and the table but no measurement will be carried out on the second 
marker: to obtain results for this marker, a manual measurement is 
necessary.

• If you press the Set Event key when the cursor is very close to a 
marker, the latter will be deleted.

Deleting events

To delete an event, move the cursor onto the event and press the Set 
Event key. The event selected will be deleted and a complete measure-
ment, without this event, is carried out.

Deletion of events can cause incorrect measurement results.

Manual measurements
As soon as you have made an acquisition, with or without automatic 
measurement, you can make manual measurements on any event on the 
trace by means of the cursors A and B, in association with the functions of 
slope, detection of splice and calculation of ORL.

1 The manual measurements are accessible in the Results page, after 
pressing the keys: Advanced, Modify meas, then Manual Measure-
ment.
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Measurements of slope

To make a manual measurement of slope, press the RESULTS button to call 
up the trace and then:

1 Place the cursor A at the beginning of the section of the trace where 
the slope is to be measured.

2 Place the cursor B at the end of this section.

3 Press the Advanced key

4 Press the Modify Meas. key

5 Press the Manual key, then select Slope. 

6 Press validation key (  or ENTER) : the slope of the specified trace 
section is displayed.

Figure 41 Manual Measurement results

Slop
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Result of slope measurement

The result is displayed on the screen between the two slope indicators 
[ and ]. 

The measurement results are also available in the table:

1 Press Exit to return to the initial results page.

2 Select Trace using Trace/Summary soft key

3 Press validation key (  or ENTER)  to display results table under the 
trace.

"Distance" shows the distance between the beginning of the trace and the 
end of the slope; 

If no result is displayed in the table, this means that the distance between 
the cursors A and B is too small.

Deleting a slope measurement 

To delete a particular slope measurement result:

1 Superimpose the cursors A and B on the slope concerned

2 Select Slope (after, if necessary, pressing Advanced > Modify 
Meas.> Manual Meas.).

3 Press validation key (  or ENTER) : the slope of the specified trace 
section is deleted.

Measurement of ORL

It is possible to carry out an ORL measurement on a part of the fiber.

Follow the following procedure to measure a part of the fiber:

1 Position the cursors A and B to delimit the section that you wish to 
measure.
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2 Press the Advanced > Modify Meas.> Manual Meas., then select 
ORL.

3 Press validation key (  or ENTER) .

The ORL is measured for the section of trace defined. 

ORL on a saturated trace

If saturation occurs during an ORL measurement, the result is given with 
the sign <. This means that the actual ORL value is less than the value 
displayed.

Measurement of Reflectance

It is possible to carry out a reflectance measurement of a Fresnel for a 
reflective event.

Follow the following procedure to measure the reflectance:

1 Position the cursor A at the base of the peak 

Figure 42 Result of ORL measurement

MTS2100 4100 Module US rev11.book  Page 86  Jeudi, 7. janvier 2016  1:29 13



Chapter 5 Launching a reflectometry test and displaying results
Advanced functions in Expert OTDR mode

User Manual 77000010208 Rev. 011 87

2 Position the cursor B at the top of the peak of the required Fresnel, or 
after the peak to calculate automatically the maximum reflectance.

3 Press the Advanced > Modify Meas.> Manual Meas., then select 
Reflec..

4 Press validation key (  or ENTER) .

The Reflectance value is defined in dB, and displayed in the trace in purple.

Splice measurements

There are two methods of carrying out manual measurements of splices on 
the trace: the two-cursor method and the five-cursor method.

The five-cursor method is the more accurate, as it takes into account the 
difference of level between the slope before the splice and the slope after 
the splice. This method should be used whenever possible.

If very close events have created a dead zone preventing the measure-
ment of slope by the five-cursor method, it is possible to use the two-cursor 
method. This considers the difference in level between the cursors.

Figure 43 Reflectance measurement
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Before performing one of these measurements, define in the Setup menu 
the splice detection threshold.

Two points method

To perform a splice measurement by the "two-points" method, display the 
Results page, then:

1 Place cursor A exactly on the fault, then place cursor B after the 
splice that you wish to define.

2 Press the Advanced key, then Modify Meas.> Manual Meas., then 
select the function 2 Pt Loss.

3 Press validation key (  or ENTER).

The splice marker is placed at the point defined by the first (left-hand) 
cursor and the result is displayed on the screen. If the fault is reflec-
tive, the reflectance value is also measured and displayed. These 
results are added to the table of results.

Five points method

To carry out a splice measurement by the "five points" method:

1 Measure the slope preceding the fault to be measured, then the 
slope following it.

2 Place the cursor on the fault (between the two sections).

3 Press the Advanced key, then Modify Meas.> Manual Meas., then 
select 5 Pt Loss.

4 Press validation key (  or ENTER).

NOTE

If you try to measure a splice on a slope, the measurement is not 
carried out and the following error message is displayed: "Slope 
found between two cursors".
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The splice event marker is placed on the cursor and the result is 
displayed on the trace and in the table of results.

Memorization of the position of events
To memorize the position of events with a view to repeating the measure-
ments at the same place during a future acquisition or on another trace, 
press the Advanced key, then select Lock Evts. The event memorization 
icon  will appear in the title bar. 

The positions memorized will then be used in the subsequent measure-
ments, either at the end of the manual acquisition, or when a stored trace 
is recalled.

The following procedure is recommended to start a measurement with 
markers:

1 Carry out an automatic measurement.

NOTE

If no result is displayed, it is possible that the display threshold of 
the attenuation measurement result is higher than the attenua-
tion that you are trying to measure.

NOTE

If you try to measure a splice on a slope, the measurement is not 
carried out and the following error message is displayed: Slope 
found between two cursors.

NOTE

This function memorizes the markers placed on the current trace.
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2 Memorize the position of the events selecting Lock with the key in 
the Advanced menu .

3 Add the manual measurements required (keys: Advanced > Manual 
Meas.).

CAUTION

If an event is added (with the Set Events key) after manual measure-
ments have been performed, then all the events on the trace will be con-
verted into AUTO markers and an automatic measurement will be 
performed using these events. The previous manual measurements will 
be lost.

Provided the event memorization icon  is displayed, the automatic 
measurement following the acquisition is carried out using the events 
which were present before the acquisition.

If you wish to make a measurement without events, deactivate memoriza-
tion of events by pressing the Free Events key.

Overlay trace function 
This very useful function enables up to eight traces to be displayed on the 
screen at once:

• either to compare traces acquired on a number of different fibers in 
the same cable, 

• or to observe changes over time in traces taken of one and the same 
fiber.
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Overlaying several traces stored in memory

To display up to 8 traces from the memory, deleting the current trace(s) 
already loaded:

1 Press the FILE button. 

2 Select the files of the traces for display.

3 Press the Load key.

4 Press View trace(s).

5 When loading is complete, the Results screen appears: the first 
trace selected is the active trace (in green), the other traces being 
overlaid.

Display of traces in overlay
• The traces are shown in different colors (the active trace is green).

• Their serial numbers are repeated at the top of the screen.

• The OTDR markers are referenced on the active trace by the symbol 
, and on the other traces by vertical dashes.

Figure 44 Example of overlaid traces
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Adding traces in overlay

With one or more traces already displayed, to add further traces to the 
display (the number of traces displayed cannot exceed 8):

1 Define at least one trace as reference (see “Reference Trace func-
tion” on page 93)

2 Press the FILE button, and in the Explorer , select the files of the 
traces to be added.

3 Press Load key.

4 Press the View Trace(s) or  Load Trace + Config.

When loading is complete, the new traces are displayed in overlay 
with those that were defined as reference traces (see.“Reference 
Trace function” on page 93)

Swapping overlay traces

Measurements can only be made on the active trace and not on overlaid 
traces. To make measurements on a trace in overlay, it must first be 
swapped with the active trace. 

1 Press the Trace key, 

2 Press the  and  direction keys, as many times as necessary, until 
the active trace is displayed in green.

NOTE

If the number of files selected exceeds the display capacity, a 
message gives warning that loading will be incomplete: only the 
trace or traces selected first will be displayed, up to the permitted 
limit of 8 traces.
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or

Click on the trace numbers in the upper right side of the 
result page until the trace desired is selected.

Removing a trace

Removing the current trace in overlay

It is possible to remove a trace displayed. To do this, first select it (see 
previous paragraph), then successively press Advanced > Overlay > 
Remove Current Trace.

Removing all the traces in overlay

To remove all the traces except the current trace, then successively press 
Advanced > Overlay > Remove Other Traces.

Quitting the overlay menu 

To quit the overlay menu, press the Exit key. 

Reference Trace function
The reference trace function consists in defining trace(s) which will be 
«blocked» on screen and used as models before acquiring or loading other 
standard trace(s).

traces 
numbers
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Use of the reference trace function in the Result 
page

Once one or several trace(s) is/are displayed, after an acquisition or loaded 
from the explorer:

1 If several traces are in overlay, check the correct current trace is 
selected

2 Go in the Advanced menu

3 Click on Overlay

4 Click on Set curve As Reference key.

The active trace becomes the reference trace; 

• the icon  appears on the upper right hand part of the results 
table.

To define all the traces displayed as reference traces, click on Set All As 
Reference key (whatever is the active trace).

Removing the reference trace(s)

To change one reference trace into a «standard» trace, select it using the 
Trace/Event key, and in the Advanced > Overlay menu, click once again 
on Set curve As Reference.

To change all the reference traces displayed into «standard» traces, what-
ever is the active trace, go in the Advanced > Overlay menu and click on 
Set All As Reference.

Performing an acquisition once one or several trace(s) is/
are defined

Three situations can occur once an acquisition is performed:
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• Only reference trace(s) is/are displayed: the trace acquired is added 
to the reference ones.

• Reference trace(s) and «standard» trace(s) are displayed: the refer-
ence trace(s) are «blocked», the standard ones are removed and the 
new trace acquired is displayed with the reference one(s).

• No reference trace(s) defined: all the «standard» traces are removed 
and only the new trace acquired is displayed.

Using the reference trace function in the explorer

A trace stored in memory can be set as reference trace before loading one 
or several «standard» trace(s).

To open one or several reference trace(s):

1 Go on the File Explorer

2 Select the trace(s) to be defined as reference

3 Click on Load and select Reference = Yes on the key 

4 Click on View Trace(s) or Load Trace + Config.

The icon  appears on the upper right part of the results table.

To open «standard» traces to be added to the reference 
ones:

1 Go back to the Explorer

2 Select the trace(s) to be opened in the same screen as the reference 
traces

3 Click on Load and select Reference = No on the key 

4 Click on View Trace(s) or Load Trace + Config.
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Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report 
can be generated directly from the results screen.

The traces saving and report generation can have already been performed 
automatically if the parameter Auto Store was defined on Yes in the Setup 
screen (see “Auto Store” on page 49) with the appropriate Save Mode (file 
only or file + txt or + pdf).

Saving results and creating a report from 
results page

To save the trace and generate a report:

1 Press Fast Report key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

a In the Save Mode parameter, select:

File Only to save exclusively the trace in a sor file

File + txt to save the trace in a sor file and to generate a txt file 
of the results

Figure 45 Fast report configuration
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File + pdf to save the trace in a sor file and to generate a report 
in a pdf format

b In the Cable Id parameter, enter/modify the name of the Cable 
using the edition keypad.

c Modify the Fiber Number using the key .

d In the Direction parameter, select/modify the direction, to define 
if the measurement has been performed from Origin to 
Extremity (A -> B) or from Extremity to Origin (B -> A)

e In the Location A and Location B parameters, enter/modify the 
name of Origin and Extremity.

3 Once saving is configured as wished, press Save All menu key 

4 Enter a name for the file in the edition keypad.

or

Click on Auto Filenaming menu key to apply the file name defined in 
the Setup screen, in Filenaming parameter (see “Filenaming” on 
page 47)

5 Press Enter to validate

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and 
directory selected.
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Saving and report for traces in overlay

If several traces are displayed in overlay in the results page, one or several 
file(s)/report(s) is/are generated:

• If in the File Setup page (SETUP > File), the parameter File Content 
is defined with One Trace, one .sor file and one pdf/txt report will be 
generated for each trace 

Example: if 3 traces are displayed in overlay, 3 .sor files and 3 pdf/txt 
files will be saved.

• If in the File Setup page (SETUP > File), the parameter File Content 
is defined with All Traces, one single .msor file and one single txt/pdf 
report will be generated, bringing together all traces.

Example: if 3 traces are displayed in overlay, one single .msor file 
and one single txt/pdf file (with one trace per page; except if the 
results table is too long for one page) will be saved.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is: 

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the T-BERD/MTS.
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Figure 46 PDF report

NOTE

A PDF Report can also be generated from the File Explorer page 
onto the T-BERD/MTS 2000/4000 (see “Generating pdf report(s)” 
on page 249).
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SLM (Smart Link Mapper) option
The SLM function is delivered as a license, available on option with the 
MTS/T-BERD.
It is usable with OTDR trace exclusively and can be used either with a trace 
just acquired or with OTDR trace(s) saved onto the equipment.

Once the installation of the license is completed (see Base-Unit manual):

1 Return to the result trace pressing RESULTS hard key (or load an 
OTDR file from the Explorer).

The Trace/Summary key is replaced by the Trace/SmartLink key.

2 Click on this menu key to select SmartLink.

A screen as the following one is displayed:

NOTE

The SLM option is automatically available with the FTTH and 
FTTA options.

Figure 47 SmartLink function

Zone 1

Zone 2

Zone 3
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The screen is divided into three zones:

• Zone 1: Graphical representation of the link, with icons symbolizing 
the different events detected.

• Zone 2: Link Table, which gives a summary of results for each wave-
length, with results within/without thresholds in green/red (according 
to Alarm thresholds defined in the setup screen).

• Zone 3: Alarms table (if any)

Show the detailed information of one event
The information concerning the event, its type and the alarm thresholds 
defined for this event, can be displayed from the SmartLink screen.

1 Select the event for which information must be displayed, on the 
graphic using the touchscreen or direction keys.

The event is highlighted in yellow once selected.

2 Click on the Event Diagnosis menu key.

A small window displays. It describes: 

– the event type 

– the value above which it is on defect

Figure 48 Event Diagnosis
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Event View
1 Click on Event View menu key to display a detailed description of 

one event detected on trace.

2 Select the event to be described on graphic (highlighted in yellow).

The corresponding event description is displayed on the Zone 3, with 
a recall of alarm threshold for this event:

3 Click on View Trace to display the selected event in the results table 
and zoomed on trace.

Figure 49 SmartLink: Event View

NOTE

The event is framed in red if it is above the alarm thresholds 
defined in the setup menu.
It is framed in green if it lies within the thresholds.
It is framed in grey if no alarm has been defined in the Setup 
menu
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Changing the type of an event

Once the Event View is displayed, the type of event can be modified:

1 Select the event to be modified (framed in yellow)

2 Press Event Code menu key

3 Click on the event type to be applied to the selected event:

4 Click on Exit to return to Event View.

5 Click back on Event View menu key to return to Summary screen

or

Click on Trace View menu key to return to trace (and table) results 
screen.

Figure 50 Event Code

NOTE

The event modification is automatically applied on trace and in 
the results table.
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Splitter sub-menus

The Splitter icon is different according to the menu key pressed in the 
Splitter sub-menus.

Example:

If the menu key  is pressed, the icon  is displayed

If the menu key  is pressed, the icon  is displayed.

Moreover, the icon and splitter configuration is different according to the 
number of «clicks» on one menu key.

Example with the menu key :

• Click once: the icon is 

• Click twice: the icon is 

• Click three times: the icon is 

• Click four times: the icon is 

Click a sixth time to reset the event by default.

OptiPulsesTM option
The OptiPulses TM option is automatically available with the FTTH-SLM 
option.

OptiPulses TM is a software license key for OTDR applications that uses 
multipulse acquisitions and advanced algorithms to deliver detailed infor-
mation on every element of the link (available in the ExpertOTDR module).

This option is configurable in ExpertOTDR mode.

MTS2100 4100 Module US rev11.book  Page 104  Jeudi, 7. janvier 2016  1:29 13



Chapter 5 Launching a reflectometry test and displaying results
OptiPulsesTM option

User Manual 77000010208 Rev. 011 105

Configuring the OTDR acquisition with 
OptiPulses TM mode

Once the installation of the licence is completed (see Base-Unit manual) 
and the Expert OTDR icon is selected in the Home page:

1 Press SETUP hard key to display the configuration parameters

2 In the Acquisition parameters, select OptiPulses and configure the 
acquisition:

No No OTDR short acquisition with the shorted pulsewidth is 
performed before the standard one

Auto this parameter allows to perform a short acquisition, 
before the standard one, with the Short Pulse and Short 
Range parameters defined automatically.

Manual this parameter allows to perform a short acquisition, 
before the standard one, with the Short Pulse and Short 
Range parameters defined by the user in the two following 
lines.

See “Smart Acquisition (not available in Multimode)” on page 30 for infor-
mation on principle of the acquisition.

1 Configure the other parameters for the OTDR acquisition to be 
performed

Figure 51 OptiPulses configuration
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2 Launch the acquisition pressing START/STOP key

A beep is emitted at the end of the acquisition.

Results in OptiPulses TM mode
Once the acquisition is completed, a screen as the following one displays:

With the OptiPulses TM option, the screen is as follows:

– Two traces for each wavelength measured: the trace with 
shortest pulse and the standard one, 

– One single results table per wavelength with results from both 
traces merged.

Example: if OTDR acquisition if performed on two wavelengths, the 
screen displays 4 traces and 2 results table.

Click on one event in the results table to automatically turns the trace on 
which it has been detected active

In the Summary page, the Link Table is displayed in one single line 
is displayed for the wavelength.

Figure 52 OTDR Traces with OptiPulses

event detected on 
trace with shortest 
pulse
events detected 
on standard trace
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OptiPulses and SmartLink option

If the OptiPulses option is used with the SmartLink option, then the Smar-
tLink screen displays the graphical representation of the link with all the 
events detected, whether they are detected on the trace with shortest pulse 
or on standard trace.

Figure 53 OptiPulses results in SmartLink mode

events detected on trace 
with shortest pulse

events detected on 
standard trace
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Chapter 6Power meter and Source 

options of the OTDR Modules

A variety of options are available when ordering an OTDR Module.

With the T-BERD/MTS 2000 and T-BERD/MTS 4000:

• E41OTDRPM is the power meter option for the OTDR Modules

• E41OTDRLS is the Light Source option for the OTDR Modules.

With the SmartOTDR:

• E10PM is the built-in  powermeter option

The topics discussed in this chapter are as follows:

• “Connection to the power meter” on page 110

• “Configuring the Power meter” on page 111

• “Activating the Source function” on page 121

• “Result page” on page 122

• “Performing the power level measurement” on page 126

• “Performing the insertion loss measurement” on page 127

• “Storing and reloading results” on page 133
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Connection to the power meter

The type of optical connector used for the power meter is the same as the 
OTDR port.

With 2 OTDR ports, select the port of connection according to the wave-
length available at each port (a label gives information at the back of the 
OTDR module).

Figure 54 Optical connector for the Powermeter or Source on the OTDR 
Module (T-BERD/MTS 2000/4000)

Connector

It is not possible to use simultaneously the Source function 
and the Power meter function, when both options are set 
onto the OTDR module, as they use the same connector.
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Configuring the Power meter
For T-BERD/MTS 2000/4000, the power meter function is an option chosen 
at the time of order and incorporated into the OTDR module in the factory.

To activate the function:

1 Press the HOME button

2 Select the power meter icon in the section of the OTDR Module

The icon turns yellow .

The effect of this action will to be to bring the power meter into use.

Configuring the measurement parameters of 
the power meter

The measurement parameters can be accessed with the SETUP key.

The Powermeter icons of the singlemode port and the one of the 
Multimode port cannot be selected at the same time. When one 
is selected, it automatically deselects the other one.

Figure 55 Configuration of power measurement

MTS2100 4100 Module US rev11.book  Page 111  Jeudi, 7. janvier 2016  1:29 13



Chapter 6 Power meter and Source options of the OTDR Modules
Configuring the Power meter

112 User Manual 77000010208 Rev. 011

Configuring the alarm parameters
Alarm Activation of the Alarm function: any result below the

lower threshold or above the upper threshold will be
displayed in red on the Results page.

Min and max thresholds

Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm (selected
with the direction keys).

Configuring the Measurement parameters

In the Setup page, press Measur’t soft key (if one parameter is selected 
in the current screen, press Top Menu soft key to display the right menu 
keys and click on Measur’t) 

Wavelength Select wavelength:
Auto: the wavelength of the input signal will be
automatically detected and selected to perform the
measurement:
1310, 1490, 1550, 1625 or 1650 nm: measurement
performed at specified wavelength.

NOTE

To copy one value of the Lower or/and Upper threshold for all 
wavelengths, select the reference value and click on Update for 
All Wavel..

NOTE

A continuous push on direction keys increments the value by 10 
dBm.
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Beep on modulation
Select if a sound must be heard when a modulation
occurs (Yes / No)

Unit Unit of power displayed:
Watt, dBm for displaying absolute power
dB for displaying a result relative to a reference (link
loss)

Reference level
If dB units were chosen in the previous line, selection
of the reference value for the wavelength selected.
Using the direction keys, first choose the wavelength,
then press the > key to access choice of the value
(+XXX.XX), then confirm this value with the ENTER

key.This reference is also automatically available, in
the Results page, using the Set as Reference key.

Attenuator compensation
Choice of level to be applied to the wavelength chosen
for measurement to compensate for the loss due to the
external attenuator (+XX.XX dB). First use the
direction keys to choose the wavelength, then press 
to access choice of value, then confirm this value
pressing ENTER.

NOTE

Using MP 60 or MP80 power meter, set manually to Auto the 
Lambda to automatically detect the wavelength: in results page, 
press Power Config. > Wavelength key multiple times until Auto 
is displayed.

NOTE

To copy a Reference Level/Attenuator Compensator on all wave-
lengths, select the reference wavelength and click on Update for 
All Wavel..
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Configuring the Link parameters

In the Setup page, press Link soft key (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys 
and click on Link).

The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters. When a 
trace is recalled without recall of the configuration, the parameters of this 
trace will be present only in its signature.

Fiber ID

Select the parameter Fiber Id and enter a name for the fiber, using the 
edition keypad.

Fiber Number / Fiber Code

The parameter Fiber Number becomes Fiber Code if, in the Cable Struc-
ture window, the Cable Content parameter is defined on another param-
eter than Fiber (Ribbon/Fiber, Tube/Fiber or Tube/Ribbon/Fiber). See 
page 117.

The fiber code corresponds to the fiber number if, in the Cable Structure, 
the parameter Color coding is defined on No. 

The fiber code corresponds to the fiber color if, in the Cable Structure, the 
parameter Color coding is defined on Yes.

NOTE

The softkey Copy File/Link To all is displayed when one param-
eter is selected in the Link or File Setup page and when the Pow-
ermeter or Source function is active. 

It allows to apply the Link and File configuration parameters of 
the current applications to all the other active Fiber Optic applica-
tions (powermeter and source).
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Select the parameter Fiber Number/Fiber Code and modify the parameter 
using the left and right direction keys.

The fiber number can be automatically incremented/decremented at 
each new file save if it has been configured in the File Setup page 
(see "Change Fiber Nbr" page 115).

Change Fiber Nbr 

Increment the fiber number is automatically incremented at each new 
file-save.

Decrement the fiber number is automatically decremented at each 
new file-save

NOTE

The Fiber Code and the fiber number concatenated with Fiber 
Name are interdependent: they are incremented or decremented 
at the same time. However, the fiber number remains a number 
only, while the fiber code is alphanumerical. Whether it includes a 
color code or not (see "Cable structure" page 117), it may be 
composed of one, two or three parts (see Figure 56). 

Figure 56 Example of incrementation of fiber code

Fiber and cable parameters used in the example:

Fiber Name: ’Fiberx’
Cable Content: ’Tube/Fiber’
Max Tube: 12
Max Fiber: 24
Coding used for the fiber and the tube: TIA

Fiber N Fiber N+1

 Color Code  Yes No Yes  No

<Fiber Name> Fiberx24 Fiberx24 Fiberx25 Fiberx25

<Fiber Code> Bl/Aq- 1/24 Gold/Bl 2/1
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User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the 
number. Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Extremities are different

In some cases, it is interesting to save different information for the origin 
and the extremity of the cable.

If this option is validated, it is possible, after selecting the extremity to be 
edited in the Cable Structure menu, to modify the values specific to the 
cable (cable name, color coding, content of the coding), for each of these 
extremities. See chapter "Cable structure" page 117) 

To display/modify the data specific to the fiber (name and code), it is neces-
sary to change direction temporarily. In the "O->E" direction, the informa-
tion on the origin can be edited, and in the "E->O" direction, that on the 
extremity.

Cable Id

This parameter allows to enter an identification of the cable, using the 
Edition menu.

Direction

The direction shows if the acquisition has been made from the origin to the 
extremity (A->B) or from the extremity to the origin (B->A). Changing direc-
tion makes it possible, when different extremities are handled, to see the 
parameters of the fiber for the other extremity.

Location A

The name of the Location A of the link may be entered here.
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Location B

The name of the Location B of the link may be entered here.

Cable structure

This line opens a sub-menu, all the parameters of which can be different 
for each extremity.

View extremityIf extremities are declared as different (see "Extremities 
are different" page 116), this parameter allows to navigate 
between the Extremity and Origin parameters.

Cable Id If the extremities are different, you can specify the cable 
identification for the origin and the extremity.

Figure 57 Cable structure menu

NOTE

The Cable Structure window is specific to an extremity. Each 
struc-ture keeps its own parameters by default. Modifications 
made to the one are not automatically applied to the other. Thus, 
after the values relating to the origin have been modified, it is nor-
mal not to find these same values entered for the extremity.
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Color Coding Choice of whether or not to apply a color coding to the 
fiber. This choice is made at link level, as all the fibers of a 
given link, for a given extremity, will be coded the same 
way. This choice modifies the result of the <Fiber Code> 
line. See "Fiber Number / Fiber Code" page 114.

Cable content Shows how the color code is to be used (see figure “Cable 
structure menu” on page 117):

– FiberOnly the color code of the fiber is proposed (example: 
«Gold»)

– Ribbon/Fiber The color code of the fiber is preceded by that of 
the ribbon, and separated by a ’/’ (example: ’Bl/Or’)

– Tube/Fiber The color code of the fiber is preceded by that of the 
tube, and separated by a ’/’ (example: ’Br/Or’)

– Tube/Ribbon/Fiber
The color code of the fiber is preceded by that of the tube, then 
by that of the ribbon; the three being separated by a ’/’ (example: 
’Br/Bl/Or’). See "Fiber Number / Fiber Code" page 114. 

Max tube Shows the maximum number of tubes in the cable for the 
extremity selected. This information influences the auto-
matic coding of the fiber. See "Fiber Number / Fiber Code" 
page 114.

Max ribbon Shows the maximum number of ribbons in the cable for 
the extremity selected. This information influences the 
automatic coding of the fiber. See "Fiber Number / Fiber 
Code" page 114.

Max fiber Shows the maximum number of fibers in the cable for the 
extremity selected. This information influences the auto-
matic coding of the fiber. See "Fiber Number / Fiber Code" 
page 114.
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Tube Coding, Ribbon Coding, Fiber Coding

The lines Tube Coding, Ribbon Coding and Fiber Coding 
enable selection of the color coding of the tube, the ribbon 
and the fiber from 5 different codes described below: TIA, 
USER 1, USER 2, USER 3 and USER 4.

Code Definition
The Code Definition line opens a sub-menu, with which 
the different color codes possible on the instrument can be 
displayed and modified.

Five different codes can be managed by the SmartOTDR, including a stan-
dard code. 
The standard code (TIA) may be displayed but it cannot be modified.

The other codes, called by default USER1, USER2, USER3 and USER4, 
can be entirely personalized.

– Edited code: selects the code for display or modification.

– Code name: to give a new name to the code selected, press the 
 key, which calls up the edit menu.

– View codes: displays the color codes 1 to 12, 13 to 24 or 25 to 
36.

– Code 1...23: Use the arrow  to modify the codes if necessary.

Operator

Use the arrow  to enter the name of the operator carrying out the 
measurement.

NOTE

Some parameters are not valid in the configuration selected. 
Thus, if no tube is selected in Cable Content, all the lines relat-
ing to the tube concept will be deactivated (grayed out in the 
menu).
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Comment

In contrast to the other data in this menu, the comment is specific to a fiber. 
This line is thus used to enter a new comment and not to display it. The 
comment appears at the top of the screen, with the other parameters of the 
fiber.
This comment will remain available for the next acquisition, unless it is 
deleted. It is also saved when a trace is saved with a comment.

Configuring the File parameters

The File storage parameters must be also configured, in order to define 
how the results will be saved on to the MTS/T-BERD 2000.

In the Setup page, press File soft key (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys 
and click on File).

Dir

This parameter cannot be configured, and display the directory selected by 
default into which the file(s) will be saved (the last directory selected).

To modify the directory, go to the Explorer page and select another direc-
tory.

Filenaming

Select Filenaming parameter and press the right arrow key to modify the 
name of the file for the result trace.

In the edition keypad, enter a name manually for the file and/or use 
the predefined parameters available (Cable_Id, Fiber_Num...). 
Then, press Enter to validate.
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or

Press Default Filename to apply the name by default to the file:

Fiber[Cable_Id][Fiber_Num]_[Lambda]_[Direction]

The name of the file is displayed in grey under Filenaming parameter

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can 
select three types of methods for storing traces:

File Only only the trace(s) is/are stored in one/several file(s), with its 
extension (.sor, .msor)

File + txt the trace(s) is/are stored in one/several file(s), with its 
extension and one txt file is also generated.

Activating the Source function
The Source function is an option chosen at the time of order and incorpo-
rated into the OTDR module in the factory.

To activate the function:

Figure 58 Filenaming - Edition keypad

Predefined 
parameters for 
naming files

MTS2100 4100 Module US rev11.book  Page 121  Jeudi, 7. janvier 2016  1:29 13



Chapter 6 Power meter and Source options of the OTDR Modules
Result page

122 User Manual 77000010208 Rev. 011

1 Press the HOME button

2 Click on the icon Source in the OTDR Section 

The icon turns yellow .

Result page
The results page, automatically displayed after the icon selection, gives the 
information relating to the measurement in progress, results previously 
saved and the commands available for measurement and saving.

Result page of the Power meter
The power measured by the power meter is displayed in large characters, 
in the units selected in the Setup menu, together with:

• the mode of transmission of the signal measured: continuous (CW) 
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

• the wavelength of the signal measured. 

• the reference level expressed in dB.

• the level of Attenuation Compensation.

Table of results

For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The table shows the 

CAUTION

The Singlemode and Multimode Source icons cannot be 
selected at the same time. When one is selected, it automatically 
deselects the other one.
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power measured in dBm, the relative power (in dB) and the reference level 
in dBm (if units = dB), together with the mode.

• A measurement result is displayed in the table when the Keep 
Result softkey is pressed. 

• The Clear Table softkey orders deletion of all the results displayed in 
the table. 

• If the Alarm function has been activated, any result that exceeds the 
selected thresholds appears in red in the table. Otherwise, results 
are shown in the table in green.

• When the instrument is switched off, results present in the table are 
saved.

Commands of the power meter parameters

When the Powermeter function is selected, the following softkeys are avail-
able on the results page:

The different configuration buttons are displayed:

Wavelength selection of the wavelength

Unit choice of the unit

Figure 59 Results and commands of the power meter

Results
of  the
power meter

MTS2100 4100 Module US rev11.book  Page 123  Jeudi, 7. janvier 2016  1:29 13



Chapter 6 Power meter and Source options of the OTDR Modules
Result page

124 User Manual 77000010208 Rev. 011

Zero Adjustment of the Zero value when the power meter’s
optical input is closed with a plug (a validation is
required).

On the results page, the following actions are available:

Set as Reference Selects the current result as reference value to
measure the attenuation of a link. This reference is
displayed under the measurement result until a new
reference value is chosen.

Keep Result Saves the result on the corresponding line of the table.

Clear Table Deletes all the results recorded in the table.

If the Source function is selected (either on this Platform, on the base Unit 
or on an OTDR module, or on another Platform), the Power meter results 
page is different:

• The Wavelength, Unit and Zero menu keys are accessible via the 
menu key Power Config.

• The Power Ref. menu key allows to reach the Standard Ref menu 
key. It also allows to reach the Jumper Ref menu key if Power meter 
function is associated with Source function onto another unit (see 
“Carrying out the reference in loopback mode” on page 130).

Result page of the Source
Once the source icon is selected, the results page displays and the Source 
can be configured.
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Laser On / Laser Off
Activation or shut-down of the laser (same function as
the START/STOP button)

When the laser is on, the icon  is displayed.

The parameters of the source can be accessed directly on the result 
screen:

Wavelength To change the wavelength when a multi-wavelength
source is present (depending on option).

The wavelength value is displayed.

Mode To vary the mode of emission of the source. Possible
modulation values are:

–  270 Hz / 330 Hz / 1 kHz / 2 kHz

• Auto (the sources emit on determined frequencies to enable the 
power meter to detect the wavelength used automatically)

• TwinTest (cyclical emission on all available wavelengths for a few 
seconds on each wavelength), compatible with the Viavi OLP 34/35/
38.

• CW (continuous emission)

The mode used is displayed, above the icon .

Standard Reference: to perform a side by side reference measurement
(see “Carrying out the side by side reference” on
page 128).

Figure 60 Source result page

MTS2100 4100 Module US rev11.book  Page 125  Jeudi, 7. janvier 2016  1:29 13



Chapter 6 Power meter and Source options of the OTDR Modules
Performing the power level measurement

126 User Manual 77000010208 Rev. 011

If the power meter function is selected onto the equipment (either on Base-
Unit or on OTDR module) the menu keys are different on screen:

• Source Config: allows to display the Wavelength and Mode menu 
keys

• The Source Reference menu key allows to open a sub-menu with 
the following keys:

Standard Ref: to perform a reference in side by side mode (see
“Carrying out the side by side reference” on page 128).

Jumper Ref: to perform a reference measurement in loopback
mode (see “Carrying out the reference in loopback
mode” on page 130).

Performing the power level measurement
The power meter is started up as soon as the function  is activated 
in the HOME page.

1 Connect the light source to be tested to the rear connector (see 
"Connection to the power meter" page 110).

2 In the SETUP menu, choose the units dBm or Watts.

3 Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in 
the table (see "Table of results" page 122).

It is not possible to use simultaneously the Source function 
and the Powermeter function, when both options are set 
onto the OTDR module, as they use the same connector.

Power measurement is automatically updated in consequence. 
The value «<-50 dBm» is displayed when the laser is switched 
off and if the source output is looped on to the power meter input.
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4 Press the START/STOP key to stop the measurement.

Performing the insertion loss measurement
Using light source and power meter options, an insertion loss measure-
ment can be performed, having previously carried out a reference 
measurement.

Setting the zero value of the power meter
1 Fix the plug over the optical input of the power meter so that no light 

can reach the photodiode of the power meter. If the zero adjustment 
is made without this plug, an error message may be displayed, as the 
photodiode will detect too much light.

2 In the Results page, press Powermeter config. > Zero soft key and 
validate.

Carrying out the reference
Using two T-BERD/MTS platforms or two SmartOTDR, with an OTDR 
module including  a laser source option and a Power meter option, an inser-
tion loss measurement in continuous wave can be performed.

Two types of reference are available: referencing in side by side mode and 
referencing in loopback mode.

It is important to set the zero of the power meter before making 
any measurements where accuracy is required, as the noise 
from the germanium photodiode fluctuates over time and with 
variations in temperature.
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Carrying out the side by side reference 

This reference can be carried out when both units are connected together 
meaning they have to be at the same location.

1 Before connecting fiber/jumper, use appropriate cleaning tool to 
clean connector end-faces.

2 Connect the two jumpers together via a bulkhead connector.

Figure 61 Side by side reference

OTDR

Source

Mainframe, USB or 
OTDR module
Power meter

T-BERD/MTS / SmartOTDR(2)T-BERD/MTS / SmartOTDR (1) Bulkhead 
connector

Jumpers

NOTE

The reference can be performed with one T-BERD/MTS 2000 at 
one side and one T-BERD/MTS-4000 at the other side.
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3 Set, on equipment (1), the OTDR light source as "Standard Ref"

a Press the HOME key

b Use the arrow keys or touchscreen to select the Source function 

on Home page .

c Press RESULTS key 

d In the Results page, press Source Config.> Source Reference 
> Standard Ref

e Press Exit and go back to the result Page

f Select the Twintest mode by skipping through the different 
modes

g Press Laser On key to activate the source

4 Set, on equipment (2), the power meter (from OTDR module, from 
the Base-unit or from USB) as "Standard Ref"

a Press the HOME key

b Use the arrow keys or touchscreen to select the Powermeter 
function in Home page .

c Press RESULTS key 

d In the Results page, press Pow.Reference > Standard Ref. 

The actual power level is set as the new reference level for the 
selected wavelength. Then, the displayed value is around 00.00 
dB. 

e Press Exit and go back to the Results page.

The reference levels are stored into the unit, and have been automatically 
filled into the setup.
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Carrying out the reference in loopback mode

This reference can be carried out when the units are separated, at different 
locations. It is made using the OTDR source and the power meter built-in 
the platform.

1 To reference the OTDR light source, on T-BERD/MTS (1)

a Select the OTDR Source icon in Home page , on the 
OTDR area.

b Press RESULTS key

c In the LTS result page, press Source Config. > Source Refer-
ence > Jumper Ref..

A popup message appears

d Connect the jumper from the OTDR source to the mainframe 
power meter, and then press OK.

The reference measurement is performed automatically.

A popup message appears when it's done: press any key to 
continue

NOTE

Each platform must be equipped with a power meter set onto the 
base-unit.

Figure 62 Reference in loopback mode

OTDR

MTS / BERD / SmartOTDR (1)
Mainframe

Source of the 
OTDR 
module

Power meter 
of Base unit

OTDR
Source of the 
OTDR module

Power meter 
of Base unit

MTS / BERD / SmartOTDR (2)

Mainframe
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2 To reference the mainframe power meter, on T-BERD/MTS (2)

a Select the Optical powermeter icon of the mainframe in Home 
page  (on the upper part, on the base options line)

b In the LTS result page, press Pow. Reference > Jumper Ref..

A popup message appears

c Connect the jumper from the OTDR port to the mainframe power 
meter, and then press OK

The reference is performed automatically.
A popup message appears once done. Press any key to 
continue

The reference levels are stored into the unit, and have been automatically 
filled into the setup.

Measurements on the fiber under test
Once the references have been performed on both units:

1 After a reference in loopback mode, disconnect the jumper from the 
powermeter port on the T-BERD/MTS (1) and the jumper from the 
Source port on the T-BERD/MTS (2).

After a reference in Side by side mode, disconnect the bulkhead 
connector and keep the jumpers connected to the Source and 
Powermeter ports.

2 Connect the jumpers to the fiber under test using the appropriate 
method (ex. keying mechanism for FC/PC types).

3 On MTS / T-BERD (1) select Laser On to activate the light source.
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Measurement using a mode conditioner

To perform an Insertion Loss measurement with a Source that is compliant 
to IEC 61280-4-1 Ed2 Standard on encircled flux, it is recommended to use 
a mode conditioner after the OTDR Source port.

Once the Source on T-BERD/MTS (1) and the Powermeter on T-BERD/
MTS (2) are referenced in loopback or side-by-side mode:

1 Connect the Multimode source (1) to the mode conditioner 

2 Connect the Powermeter port (2) to the jumper

3 Connect extremities of the mode conditioner and jumper to the fiber 
under test using the appropriate method (ex. keying mechanism for 
FC/PC types).

4 On T-BERD/MTS (1) select Laser On to activate the light source.

Figure 63 Measurement of the fiber under test

OTDR Module:

Source port

Mainframe

Power meter port

Fiber Under Test

Equipment (1) Equipment (2)
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Figure 64 Measurement of the Insertion Loss with a mode conditioner
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Storing and reloading results

File Setup
Click on the button FILE to access the File setup. See "Description of the 
explorer" page 240 for a complete description of all parameters, options 
and the explorer.

Storing results
In order to save the results of a measurement, click on FILE and select 
Store trace. Two files are being saved :

• The first file is to be used with the product and allows to retrieve all 
measurement results. It is saved with the extension .Lts.

• The second file is a ASCII file using tabulations to separate values. It 
is saved with the extension «.txt» and can be opened by the 4000 
Platform via the Web Browser. It has been designed to be used with 
a spreadsheet program on a PC where it allows to retrieve all 
measurement results and format them in a nice customized table. 

Loading results
In order to load the results of a measurement, select a file  with the 
extension «.Lts» in the file explorer (see Chapter 11), click on Load > View 
trace.

The LTS tab is displayed with the loaded results in the table.
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Chapter 7FTTA-SLM Software option

This chapter describes the use of the FTTA-SLM option, when the software 
license has been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of FTTA-SLM” on page 136

• “Configuring the Reflectometry test for FTTA network” on page 138

• “Launching the acquisition” on page 147

• “Results page” on page 148

• “Saving the trace(s) and generating a report” on page 155
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Principle of FTTA-SLM
FTTA-SLM is an OTDR software application that is delivered as an option 
of the OTDR module (see references in the ordering information section), 
and is installed onto the mainframe as a license key (see the 2000/4000 
base-unit user manual for the instructions on license files installation).

FTTA-SLM simplifies OTDR testing for cell-tower technicians and elimi-
nates complexities of result interpretation.

In a FTTA environment, the OTDR module, associated with the FTTA-SLM 
application, allows to:

• Characterize and measure the fiber link loss, measure the loss and 
reflectance of each passive element, and provide the position for 
each one: Acceptance Testing

• Locate and identify causes of failure on a fiber link: Troubleshooting 
/ Maintenance.

Acceptance Testing
One way to judge installation quality is to use a loopback device (a retract-
ible/expandable fiber leash cable or a patchcord) on duplex fiber to test at 
the junction box or RRU location and shoot with an OTDR from the BBU or 
fiber-patch panel location to qualify the entire fiber channel.
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Troubleshooting Testing
An OTDR from the BBU or fiber patch panel location will troubleshoot the 
fiber link up to the RRU/RRH. Before performing the OTDR measurement, 
make sure that the fiber being tested has no signal and the equipment is 
shut down.

Figure 65 Acceptance Testing
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Configuring the Reflectometry test for FTTA 
network

Once the OTDR module is set into the T-BERD/MTS, and the FTTA-SLM 
license installed:

1 Select the FTTA-OTDR icon .

The results page automatically displays.

Figure 66 Troubleshooting Testing
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2 Press SETUP hard key to display the OTDR configuration screen for 
FTTA network.

FTTA setup

Acquisition (FTTA)

In the first screen, configure the following parameters:

Laser

The acquisition will be carried out on the wavelength(s) selected (for 
multiple-wavelength modules). In case of a multi-wavelength module, 
select All to perform a measurement for all the wavelengths available (this 
parameter visible exclusively on modules with one single OTDR port). The 
possible values depend on the module used. 

Figure 67 FTTA OTDR Setup
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Network Config.1

This parameter is used to identify the network type:

Cell Tower Typical macro cell tower topology

Rooftop Tenant Rooftop topology 

Rooftop Penthouse Rooftop topology

Das Ditributed Antenna System 

1.Active exclusively if the License «FTTA Extended» is installed

Figure 68 Network configurations
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DAS
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Config.

This parameter displays the last configuration file loaded and cannot be 
modified unless a new configuration file is loaded.

Alarms
In the Setup page, press the Alarm menu key (if one parameter is selected 
in the current screen, press Top Menu soft key to display the right menu 
keys and click on Alarms).

Alarms > Threshold
None The alarm function is not active.

User Define your own thresholds values for one or several
elements: Splice Loss / Connector Loss / Reflectance /
Fiber Length Min / Link Loss Max / ORL

TIA-568 C / ISO/IEC 11801 / Default
Select one of this parameter to configure the alarm
thresholds with predefined values:

If results are above the thresholds, they will be highlighted in red in the 
table of results, and the icon  will appear at the top right of the screen.

If all the results lie within the thresholds (no result is in red), results are 
displayed in green in the table and the icon is .

Default TIA-568C & ISO/IEC 11801

Splice Loss > 0.20 dB > 0.30 dB

Connector 
Loss

> 0.50 dB > 0.75 dB

Slope1

1. This parameter is not available in OEO-OTDR configuration

> 1.00 dB/km > 1.00 dB/km

Reflectance > - 35 dB -

ORL < 27 dB -
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Analysis
In the Setup page, press Analysis softkey (if one parameter is selected in 
the current screen, press Top Menu soft key to display the right menu keys 
and click on Analysis).

This screen allows to configure the network:

BBU Jumper

Test from the patchcord that will be plugged into BBU.
(not applicable for DAS networks)

RRU Jumper

Test from the patchcord that will be plugged into RRU.
(not applicable for DAS networks)

Mode

Select the kind of acquisition to be performed:

Construction Select this mode to perform the OTDR acquisition in
the case of an Acceptance Testing (see “Acceptance
Testing” on page 136).

Maintenance Select this mode to perform the OTDR acquisition in
the case of Troubleshooting (see “Troubleshooting
Testing” on page 137).

Loopback Cable

Select if a loopback cable is used (parameter available exclusively in 
Construction mode).

Launch Cable End / Receive Cable Start (not available in 
Maintenance mode)

No All the results are displayed and referenced on the basis 
of the board of the module.
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Evt 1, 2, 3 The results relating to the launch cable are eliminated from 
the table. Attenuation and distances are then measured on 
the basis of the marker Evt 1, 2 or 3 selected.

Distance Use the Edit Number key to enter a distance (Min= 0 / 
Max=50 km / 164.042 kfeet / 31.075 miles) or affect the 
active cursor value, using the Set Cursor Distance key.

Link
In the Setup page, press Link softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys 
and click on Link).

The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters. When a 
trace is recalled without recall of the configuration, the parameters of this 
trace will be present only in its signature.

Base Station Id or Headend Id (in case of DAS)

If known, enter the name of the Base Station using the edition keypad, 
displayed pressing the right arrow key.

RRU Id or Remote End Id (in case of DAS)

If known, enter the name of the RRU/RRH (Remote Radio Unit / Head) 
using the edition keypad, displayed pressing the right arrow key.

NOTE

The name of Location A entered in ExpertOTDR configuration is 
displayed by default in this parameter (see “Location A” on 
page 43).
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Fiber Code / Fiber Num

To use the Fiber Code convention, with Rx/Tx labeling, choose between 
the following config files: FTTA_Rx_Tx.SM-OTDR or FTTA_Rx_Tx.MM-
OTDR.

For a simple labeling of the fiber number (1 to 24), load one of the following 
config files: FTTA_Simple.SM-OTDR or FTTA_Simple.MM-OTDR

Example of fiber code in:

• Construction mode (with loopback): from 1-Rx_1-Tx to 24-Rx_24-Tx

• Maintenance mode: from 1-Rx to 24-Rx

Change Fiber Nbr

Select if the fiber number must be automatically Incremented or Decre-
mented at each new file save.

Increment the fiber number is automatically incremented at each new 
file-save.

Decrement the fiber number is automatically decremented at each 
new file-save

User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the 
number. Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified

NOTE

The name of Location B entered in ExpertOTDR configuration is 
displayed by default in this parameter (see “Location B” on 
page 43).
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Distance unit

Select the unit to be used for distance (km / kfeet / miles / meter / feet).

File
In the Setup page, press File softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys 
and click on File).

Dir

The Dir parameter displays the directory (and sub-directory) into which 
file(s) will be saved and cannot be modified.

To modify the location of files saved, go to explorer page (pressing File 
hard key) and select another media storage/directory.

Filenaming

Select the parameter and modify the name of the file for the result trace.

a In the edition keypad, enter a name manually for the file and/or 
use the predefined parameters available (RRU_Id, Lambda...). 

b Press Enter to validate.

The name of the file is displayed in grey under Filenaming parameter

Figure 69 Filenaming - Edition keypad

Predefined 
parameters for 
naming files
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File Content

In this parameter, select the file content for traces saving:

One Trace in case of traces in overlay, each trace is saved in a
distinct file (.sor extension).

All Traces in case of traces in overlay, all traces are saved in one
single file (.msor extension)Define the Auto Store
parameter

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can 
select three types of methods for storing traces:

File Only only the trace(s) is/are stored in one/several file(s),
with its extension (.sor or .msor)

File + txt the trace(s) is/are stored in one/several file(s), with its
extension and one txt file is also generated.

File + pdf the trace(s) is/are stored in one/several file(s), with its
extension and one pdf file is also generated.

All the trace(s) is/are stored in one/several file(s), with its
extension and one pdf file and one txt file are also
generated.

Auto store

Select Yes to store automatically the trace or traces resulting from each 
acquisition according to the filenaming rules.

Operator

Use the arrow  to enter the name of the operator carrying out the 
measurement.

Comment

Use the arrow  to enter a comment, which will be displayed in the file 
signature, on the upper part of the screen.
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Launching the acquisition

1 Press START/STOP hard key to launch measurement.

The red Test indicator goes on to show that the T-BERD/MTS is in 
process of acquisition and the screen displays the trace in process of 
acquisition.

2 The quality of the connection is displayed for a 
few seconds (see Table 3 on page 57)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

At the end of the acquisition, a beep is emitted, the trace is displayed 
and an automatic measurement is started.

Inspect & clean all fiber connections prior connecting fiber 
cables into the ports (BBU, distribution boxes, OVP and 
RRU/RRH and SFP ports).

Figure 70 Acquisition in progress

Number of aver-
ages calculated

Elapsed acqui-
sition time Total acquisi-

tion time
Elapsed time
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If the module possesses several lasers, to perform successive acquisitions 
on all the wavelengths:

1 In the SETUP menu, check in Laser line, that several lasers are 
selected or select All.

2 Start the acquisition by pressing the START/STOP button.

3 Once the acquisition for the first wavelength is finished, the acquisi-
tion for the following wavelength starts automatically.

or 

To stop manually the acquisition for current wavelength, click on 
Stop Wavelength. This will allow to automatically start the measure-
ment for the following wavelength.

A beep is emitted once the acquisitions on all lasers are completed.

The different traces appear in the same window and can be managed as 
traces in overlay (see “Overlay trace function” on page 90).

Results page
The trace(s) acquired or recalled from a memory is/are displayed on the 
Results page.

Trace View
The Trace view is displayed by default once OTDR acquisition is 
completed.

NOTE

During acquisition, the traffic on fiber is automatically detected 
(see “Traffic detection” on page 57)
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Once trace is displayed, you can:

• Zoom on trace (see “Zoom function” on page 74).

• Set Cursor A and/or Cursor B (see “Cursors” on page 72).

• Save the traces and launch a report of results (see “Saving the 
trace(s) and generating a report” on page 155).

The available event types are similar to the events for OTDR measurement 
(see “Results table” on page 68) except the Merged Connector Loss . 
In FTTA results:

Loss per connector = total group loss / nb of events in the group

Detailed description of an event

When clicking on one event icon in the results table, a popup window 
describes the event type and provides a diagnosis to help troubleshoot 
faulty optical elements (indicated in red).

Figure 71 FTTA OTDR Trace
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Press SETUP hard key to go back to FTTA Setup screen and modify the 
parameters before launching a new acquisition.

SmartLink view
1 Click on the menu key Trace/SmartLink to select SmartLink.

A screen as the following one is displayed:

Figure 72 Event description

C
lic
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The screen is divided into three zones:

• Zone 1: Graphical representation of the link, with icons symbolizing 
the different events detected.

• Zone 2: Link Table, which gives a summary of results for each wave-
length, with results within/without thresholds in green/red (according 
to Alarm thresholds defined in the setup screen).

• Zone 3: Alarms table (if any)

Merged connectors

When 2 or more connectors are very close to eahc others (in the attenua-
tion dead zone), usually the reflectances can be measured but the loss of 
the individuals can’t be - the loss of these connectors is "merged" 

.

The following formula is then applied (only in FTTA mode):

Figure 73 SmartLink function

Zone 1

Zone 2

Zone 3

If several traces are displayed in overlay, with the same 
wavelength, then only the Zone 2 is displayed, there is no 
graphical representation of the link (Zone 1).
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loss per connector = (total group loss) / (nb of connectors in the 
group)

Getting a diagnostic of an event

Diagnosis is used to provide further information about events and eventual 
problems, such as root cause possibilities of a failed optical element.

1 Select the event to be described (underlined in yellow).

2 Click on Event Diagnostic soft key

A new window, on the lower part of the screen, gives the details of 
the selected event: 

– its type

– the thresholds applied for this event.

– the possible causes of the alarm

Results Table

To display exclusively the results table from the SmartLink page, press the 
Results Table softkey.

Figure 74 Event Detail window
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Press again the Results Table menu key to return to SmartLink display.

Event View
1 Click on Event View menu key to display a detailed description of 

one event detected on trace.

In this view, an algorithm automatically detects the elements of the 
FTTA link and label them.

2 Select the event to be described on the graphic (highlight in yellow).

The corresponding event description is displayed on the Zone 3, with 
a recall of alarm threshold for this event:

Figure 75 FTTA Smart Link: Results Table
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3 Click on Trace View to display the selected event in the results table 
and zoomed on trace.

Changing the name of an event

Once the SmartLink screen is displayed, the name of an event can be 
modified:

1 Select the event to be modified (highlighted in yellow) .

2 Press Rename Event menu key

3 In the edition keypad, enter a new name for the event

Figure 76 SmartLink: Event View

NOTE

The event is framed in red if it is above the alarm thresholds 
defined in the setup menu.
It is framed in green if it lies within the thresholds.
It is framed in purple if no alarm has been defined for this type of 
event.
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4 Click on Enter to return to Event View.

The event name is displayed under the icon, and replaces the 
previous FTTA label .

Click on Replay Label to rename the event as it was previously (at last 
saving).

Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report 
can be generated directly from the results screen.

Saving and report can have been automatically generated if, in the file 
configuration, the Auto Store parameter has been set to Yes (see 
page 146) with the appropriate Save Mode.

Saving results and creating a report from 
results page

To save the trace and generate a report:

Figure 77 Rename Event
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1 Press Fast Report key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

a In the Save Mode parameter, select:

File Only to save exclusively the trace in a sor file

File + txt to save the trace in a sor file and to generate a txt file 
of the results

File + pdf to save the trace in a sor file and to generate a report 
in a pdf format

b Enter a name for the Cable in the Cable Id1 parameter.

c In the Fiber Code / Fiber Number parameter use the left and 
right direction keys to define the fiber code / fiber number by 
scrolling the available codes/numbers.

Figure 78 Fast report configuration

1.Available exclusively if the License «FTTA Extended» is installed
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Fiber Code: from 1-Rx_1-Tx to 24-Rx_24-Tx if the configura-
tion file selected is FTTA_Rx_Tx.SM-OTDR or 
FTTA_Rx_Tx.MM-OTDR.

Fiber Number: from 1 to 24 if the configuration file selected is 
FTTA_Simple.SM-OTDR or FTTA_Simple.MM-OTDR

d In the Direction2 parameter, select/modify the direction, to 
define if the measurement has been performed from Origin to 
Extremity (A -> B) or from Extremity to Origin (B -> A)

e In the Location A and Location B parameters2, enter/modify 
the name of Origin and Extremity.

3 Once all the parameters are configured, press Save All menu key.

4 Enter a name for the file in the edition keypad.

or

Click on Auto Filenaming menu key to apply the file name defined in 
the Setup screen, in Filenaming parameter (see page 145).

5 Press Enter to validate

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Adding a logo to a pdf report

To display a logo, or any other image (other than the logo displayed by 
default) on the upper left part of the report:

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and 
directory selected.
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1 Reach the System Settings screen:

– on the T-BERD/MTS 2000, on the Home page, press the 
Settings icon

– on the T-BERD/MTS 4000, on the Home page, press the 
System Settings menu key.

2 On the T-BERD/MTS 2000, in the Reports menu, in the Mode 
parameter, select Report

On the T-BERD/MTS-4000, in the Printer menu, reach the Printer 
parameter and select File (Formatted).

3 Select the File Format of the report: JPG, PNG or PDF.

4 In the Logo parameter, enter the full path of the image file (with file 
extension) 
Example: disk/Logo.jpg

5 Click on Exit to return to Home page.

6 Press FILE and in the Explorer, open the file for which a pdf report 
must be generated.

7 Launch the report.

Once report is generated, the logo is displayed on the upper left part 
of the page.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is: 

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the T-BERD/MTS.
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Figure 79 Fast Report with FTTA-SLM option

NOTE

A pdf report can also be generated from the File Explorer page 
onto the T-BERD/MTS (see “Generating pdf report(s)” on 
page 249).
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Chapter 8FTTH-SLM Software option

This chapter describes the use of the FTTH option, when the software 
license has been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of FTTH” on page 162

• “Configuring the Reflectometry test for FTTH network” on page 163

• “Launching the acquisition” on page 170

• “Results page” on page 172

• “Saving the trace(s) and generating a report” on page 179
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Principle of FTTH
FTTH-SLM is an OTDR software application that is delivered as an option 
of the OTDR module (see references in the Chapter 13 on page 269), and 
is installed onto the mainframe as a license key (see the 2000/4000 base-
unit user manual for the instructions on license files installation).

FTTH-SLM application brings an FTTH user interface and a specific algo-
rithm for OTDR measurements, especially through PON splitters (Passive 
Optical Network).

In a FTTH environment, the OTDR module, associated with the FTTH-SLM 
application:

• Selects optimized test parameters to conduct reliable measurements, 
especially through optical splitters, and to detect close events near 
the start (Central Office splices/ connectors) (OptiPulses Automatic 
Algorithm).

• Automatically identifies all network elements such as PON splitter 
types/ratios (Discover Mode).

• Iconically displays a map of OTDR trace results (SmartLink View)

• Guarantees measurements with automatic PASS/FAIL analysis to 
ITU-T/IEEE PON standards or customer-defined specifications.

Figure 80 FTTH network
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Configuring the Reflectometry test for FTTH 
network

Once the OTDR module is set into the T-BERD/MTS, and the FTTH-SLM 
license installed:

1 Select the FTTH-OTDR icon .

The results page automatically displays.

2 Press SETUP hard key to display the OTDR configuration screen for 
FTTH network.

FTTH setup
In the first screen, configure the following parameters:

Figure 81 FTTH OTDR Setup
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FTTH (PON) Setup

Laser

The acquisition will be carried out on the wavelength(s) selected (for 
multiple-wavelength modules). In case of a multi-wavelength module, 
select All to perform a measurement for all the wavelengths available (this 
parameter visible exclusively on modules with one single OTDR port). The 
possible values depend on the module used. 

Direction
• OLT: Optical Line Terminal (switch at the Central Office)

• ONT: Optical Network Terminal (media converter and gateway in the 
Home)

Select the direction of the measurement:

– Downstream: from OLT to ONT (OLT -> ONT) 

– Upstream: from ONT to OLT (ONT -> OLT)

Number of Splitters

If known, enter the number of splitters installed in the FTTH network.

None: no splitter is installed

Discover: auto-detection and identification of PON splitter types.

1 / 2 / 3: select the number of splitters.

It is preferred to know the number of splitters in order to get 
Pass/Fail status for the splitters’ loss.

NOTE

The Discover mode does not allow Pass/Fail analysis
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This selection opens a sub menu into which the splitters types must be 
defined for all splitters installed.

Splitters types

Splitter 1: define the splitter type among the list:

– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64

– 2x2 / 2x4 / 2x8 / 2x16 / 2x32 / 2x64

Splitter 2 and Splitter 3: define the splitter type among the list:

– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64

Launch Cable End / Receive Cable Start

No All the results are displayed and referenced on the basis of 
the board of the module.

Length Use the Edit Number key to enter a distance (Min= 0 / 
Max=50 km / 164.042 kfeet / 31.075 miles) or affect the 
active cursor value, using the Set Cursor Distance key.

Distance Unit

Define the unit of the distances displayed: km, kfeet, miles, meter, feet

Config.

This parameter displays the configuration file selected for acquisition, and 
cannot be modified from Setup page. To modify the configuration file to be 
used:

1 Click on the menu header FTTH (PON) Setup 

2 Click on Load Config. menu key 

3 Select the file in the Explorer.
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Alarms parameters
Press the Alarm menu key (or Next key when one parameter of the Setup 
page is selected) to configure the alarm thresholds for the OTDR measure-
ment.

None The alarm function is not active.

User Define your own thresholds values for one or several 
elements: Splice Loss / Connector Loss / Reflectance / 
Splitter Alarm / Fiber Length Min / Link Loss Max / ORL

Default / TIA-568 C / ISO/IEC 11801 / G.697/G.98x PON / G.697/IEEE 
PON

Select one of this parameter to configure the alarm thresholds with 
predefined values:

Default
G.697/G.98x PON & 
G.697/IEEE PON

TIA-568C & 
ISO/IEC 11801

Splice Loss > 0.20 dB > 0.30 dB > 0.30 dB

Connector Loss > 0.50 dB > 0.50 dB > 0.75 dB

Slope > 1.00 dB/km - > 1.00 dB/km

Reflectance > - 35 dB > - 35 dB

ORL < 27 dB < 27 dB

Splitter Alarm

Splitter 1x2 > 5.0 dB > 4.2 dB

Splitter 1x4 > 8.0 dB > 7.8 dB 

Splitter 1x8 > 11.0 dB > 11.4 dB

Splitter 1x16 > 14.0 dB > 15.0 dB

Splitter 1x32 > 17.0 dB > 18.6 dB

Splitter 1x64 > 21.0 dB > 22.0 dB
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If results are above the thresholds, they will be highlighted in red in the 
table of results, and the icon  will appear at the top right of the screen.

If all the results lie within the thresholds (no result is in red), results are 
displayed in green in the table and the icon is .

Link parameters
In the Setup page, press Link softkey, or press Next if one parameter is 
selected in the current screen until the Link Setup page displays.

The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters. When a 
trace is recalled without recall of the configuration, the parameters of this 
trace will be present only in its signature.

Test Point / OLT Id / ONT Id / Distribution Id / Feeder Id

Those parameters allow to enter an identification for each element of the 
network (test point, OLT, ONT...) using the Edition menu.

Fiber Number

1 Select the parameter Fiber Number and modify the number of the 
fiber to be tested.

Link Loss Max Select: No, Manual or: 

• for G.697/G.98x PON: 
20 dB (A) / 25 dB (B) / 
30 dB (C)

• for G.697/IEEE PON: 
23 dB (PX-10) / 26 dB 
(PX-20)

Default
G.697/G.98x PON & 
G.697/IEEE PON

TIA-568C & 
ISO/IEC 11801
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The fiber number can be automatically incremented/decremented at each 
new file save if it has been configured in the Change Fiber Nbr parameter 
(see "Change Fiber Nbr" page 168).

Change Fiber Nbr 

Increment the fiber number is automatically incremented at each new 
file-save.

Decrement the fiber number is automatically decremented at each 
new file-save

No the Fiber number must not automatically modified.

User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the 
number. Example: -1.

Min: -999 / Max: 999 / Auto: 0

Operator

Use the arrow  to enter the name of the operator carrying out the 
measurement.

Comment

Use the arrow  to enter a comment, which will be displayed in the file 
signature, on the upper part of the screen.

File parameters
Press the File menu key (or Next key when one parameter of the File page 
is selected) to configure the File saving parameters for the OTDR measure-
ments.

Dir

The Dir parameter displays the directory (and sub-directory) into which 
file(s) will be saved and cannot be modified.
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To modify the location of files saved, go to explorer page (pressing File hard 
key) and select another media storage/directory.

Filenaming

Select the parameter and modify the name of the file for the result trace.

a In the edition keypad, enter a name manually for the file and/or 
use the predefined parameters available (ONT_Id, 
Feeder_Id...). 

b Press Enter to validate.

The name of the file is displayed in grey under Filenaming parameter

Press the Default Filename menu key to apply the name by default for the 
file: [Test_Point]_[Date_Time].

File Content

In this parameter, select the file content for traces saving:

One Trace in case of traces in overlay, each trace is saved in a
distinct file (.sor extension).

All Traces in case of traces in overlay, all traces are saved in one
single file (.msor extension)

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can 
select three types of methods for storing traces:

Figure 82 Filenaming - Edition keypad

Predefined 
parameters for 
naming files
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File Only only the trace(s) is/are stored in one/several file(s),
with its extension (.sor or .msor)

File + txt the trace(s) is/are stored in one/several file(s), with its
extension and one txt file is also generated.

File + pdf the trace(s) is/are stored in one/several file(s), with its
extension and one pdf file is also generated.

All the trace(s) is/are stored in one/several file(s), with its
extension and one pdf file and one txt file are also
generated.

Auto store

Select Yes to store automatically the trace or traces resulting from each 
acquisition according to the filenaming rules.

Launching the acquisition

1 Press START/STOP hard key to launch measurement.

The red Test indicator goes on to show that the T-BERD/MTS is in 
process of acquisition and the screen displays the trace in process of 
acquisition.

2 The quality of the connection is displayed for a 
few seconds (see Table 3 on page 38)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

Inspect & clean all fiber connections prior connecting fiber 
cables into the ports (patch panels, OLT or ONT...).
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At the end of the acquisition, a beep is emitted, the trace is displayed 
and an automatic measurement is started.

If the module possesses several lasers, to perform successive acquisitions 
on all the wavelengths:

1 In the SETUP menu, check in Laser line, that several lasers are 
selected or select All.

2 Start the acquisition by pressing the START/STOP button.

3 Once the acquisition for the first wavelength is finished, the acquisi-
tion for the following wavelength starts automatically.

or 

Figure 83 Acquisition in progress

Number of aver-
ages calculated

Elapsed acqui-
sition time

Total acquisition 
time

Elapsed time

NOTE

During acquisition, the traffic on fiber is automatically detected 
(see “Traffic detection” on page 39)
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To stop manually the acquisition for current wavelength, click on 
Stop Wavelength. This will allow to automatically start the measure-
ment for the following wavelength.

A beep is emitted once the acquisitions on all lasers are completed.

The different traces appear in the same window and can be managed as 
traces in overlay (see “Overlay trace function” on page 63).

Results page
The trace(s) acquired or recalled from a memory is/are displayed on the 
Results page.

Trace View
The Trace view is displayed by default once OTDR acquisition is 
completed.

Figure 84 FTTH OTDR Trace
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Once trace is displayed, you can:

• Zoom on trace (see “Zoom function” on page 51).

• Set Cursor A and/or Cursor B (see “Cursors” on page 50).

• Save the traces and launch a report of results (see “Saving the 
trace(s) and generating a report” on page 179)

Detailed description of an event

When clicking on one event icon in the results table, a popup window 
describes the event type and provides a diagnosis to help troubleshoot 
faulty optical elements (indicated in red).

Press SETUP hard key to go back to FTTH Setup screen and modify the 
parameters before launching a new acquisition.

SmartLink view
1 Click on the menu key Trace/SmartLink to select SmartLink.

A screen as the following one is displayed:

Figure 85 Event description

C
lic
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The screen is divided into three zones:

• Zone 1: Graphical representation of the link, with icons symbolizing 
the different events detected.

• Zone 2: Link Table, which gives a summary of results for each wave-
length, with results within/without thresholds in green/red (according 
to Alarm thresholds defined in the setup screen).

• Zone 3: Alarms table (if any)

Getting a diagnostic of an event

Diagnosis is used to provide further information about events and eventual 
problems, such as root cause possibilities of a failed optical element.

Figure 86 SmartLink function

Zone 1

Zone 2

Zone 3

If several traces are displayed in overlay, with the same 
wavelength, then the Zone 2 indicates the results for each 
wavelength. The graphical representation of the Zone 1 is a 
combination of multiple pulses and wavelengths acquisi-
tions.
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1 Select the event to be described on the graphic (underlined in 
yellow).

2 Click on Event Diagnostis soft key

A popup window, on the lower part of the screen, gives the informa-
tion related to the selected event: 

– its type

– thresholds applied for this event.

– possible causes for the fail status of the selected link element

Results Table

To display exclusively the results table from the SmartLink page, press the 
Results Table softkey.

Figure 87 Event Diagnosis window
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Press again the Results Table menu key to return to SmartLink display.

Event View

«Event View» provides the possible loss and reflectance of the selected 
event, per tested wavelengths.

1 Click on Event View menu key.

In this view, an algorithm automatically identifies the elements of the 
FTTH link and label them.

2 Select the event to be described on the graphic (highlight in yellow).

The corresponding event description is displayed on the Zone 3, with 
a recall of alarm threshold for this event:

Figure 88 FTTH Smart Link: Results Table
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3 Click on Trace View to display the selected event in the results table 
and zoomed on trace.

Changing the type of an event

Once the Event View is displayed, the type of event can be modified:

1 Select the event to be modified (highlighted in yellow)

2 Press Event Code menu key

3 Click on the event type to be applied to the selected event:

Figure 89 SmartLink: Event View

NOTE

The event is framed in red if it is above the alarm thresholds 
defined in the setup menu.
It is framed in green if it lies within the thresholds.
It is framed in purple if no alarm has been defined for this type of 
event.
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4 Click on Exit to return to Event View.

5 Click back on Event View menu key to return to Summary screen

or

Click on Trace View menu key to return to trace (and table) results 
screen.

Splitter sub-menus

The Splitter icon is different according to the menu key pressed in the 
Splitter sub-menus.

Example:

If the menu key  is pressed, the icon  is displayed

Figure 90 Event Code

Click on one event code to 
modify the selected event

NOTE

The event modification is automatically applied on trace and in 
the results table.
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If the menu key  is pressed, the icon  is displayed.

Moreover, the icon and splitter configuration is different according to the 
number of «clicks» on one menu key.

Example with the menu key :

• Click once: the icon is 

• Click twice: the icon is 

• Click three times: the icon is 

• Click four times: the icon is 

Click a fifth time to reset the event by default.

Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report 
can be generated directly from the results screen.

Saving and report can have been automatically generated if, in the file 
configuration, the Auto Store parameter has been set to Yes (see 
page 170) with the appropriate Save Mode.

Saving results and creating a report from 
results page

To save the trace and generate a report:

1 Press Fast Report key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)
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a In the Save Mode parameter, select:

File Only to save exclusively the trace in a sor file

File + txt to save the trace in a sor file and to generate a txt file 
of the results

File + pdf to save the trace in a sor file and to generate a report 
in a pdf format

All to save the trace in a sor file and to generate two reports: 
one in a pdf format and one in txt format.

b In the Fiber Number parameter use the left and right direction 
keys to define the fiber number by scrolling the available 
numbers.

3 Once all the parameters are configured, press Save All menu key.

4 Enter a name for the file in the edition keypad.

or

Click on Auto Filenaming menu key to apply the file name defined in 
the Setup screen, in Filenaming parameter (see page 169).

5 Press Enter to validate

Figure 91 Fast report configuration
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The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Adding a logo to a pdf report

To display a logo, or any other image (other than the logo displayed by 
default) on the upper left part of the report:

1 Reach the System Settings screen:

– on the T-BERD/MTS 2000, on the Home page, press the 
Settings icon

– on the T-BERD/MTS 4000, on the Home page, press the 
System Settings menu key.

2 On the T-BERD/MTS 2000, in the Reports menu, in the Mode 
parameter, select Report

On the T-BERD/MTS-4000, in the Printer menu, reach the Printer 
parameter and select File (Formatted).

3 Select the File Format of the report: JPG, PNG or PDF.

4 In the Logo parameter, enter the full path of the image file (with file 
extension) 
Example: disk/Logo.jpg

5 Click on Exit to return to Home page.

6 Press FILE and in the Explorer, open the file for which a pdf report 
must be generated.

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and 
directory selected.
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7 Launch the report.

Once report is generated, the logo is displayed on the upper left part 
of the page.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is: 

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the T-BERD/MTS.
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Figure 92 Fast Report with FTTH-SLM option

NOTE

A pdf report can also be generated from the File Explorer page 
onto the T-BERD/MTS (see “Generating pdf report(s)” on 
page 249).
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Chapter 9Cable-SLM option

This chapter describes the use of the Cable-SLM option, when the software 
license has been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of Cable-SLM” on page 186

• “Configuring the Cable-SLM project” on page 186

• “Starting project test process” on page 189

• “Results of project cable” on page 191

• “Files and Project storage” on page 194
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Principle of Cable-SLM
The Cable-SLM option is a function used to manage a cable commis-
sioning or a multi-fiber test project.

The aims of this option is to:

• improve workflow in cable commissioning (P2P links even with 
different distances, for example FTTH drops)

• ensure test consistency

• reduce manipulation errors / issue

• generate a report text file

Configuring the Cable-SLM project

Configuring the project
Once the OTDR module is set into the T-BERD/MTS, and the Cbale-SLM 
license installed:

1 From the Home page, select the Expert OTDR function.

The results page automatically displays.

If not, press RESULTS hard key to display results page.

2 Press SETUP hard key to display the OTDR configuration screen and:

– Configure the OTDR Acquisition parameters (see page 28)

– Configure the OTDR Alarms parameters (see page 33)

– Configure the OTDR File parameters (see page 47)

3 Press Link Cable menu key .

4 Configure the Link Description parameters (see page 40)
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5 In the new window Cable Project, configure the project as required:

– Use the Edition keypad to enter a name for Contactor Id / Sub 
Contractor Id / Engineer Id.

– On the parameter Start Fiber, press Edit Number soft key to 
enter the number of the first fiber of the cable to be tested (Min 1 
/ Max 100)

– On the parameter Number Of Fibers, press Edit Number soft 
key to enter the total number of fibers of the cable (Min 1 / Max 
100)

OR

Press Load Project soft key to load an existing project (see “Loading 
a existing project” on page 188).

Saving the project
Once all configuration parameters are defined, save the project:

1 Press Save Project soft key (displayed when one parameter of the 
Cable Project window is displayed).

2 In the Edition keypad opened, enter a name for the project and press 
Enter to validate.

Figure 93 Smart Link Cable Setup

Cable Commissioning 
configuration
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The project file (.prj) contains Acquisition / Alarms / Link / File param-
eters and is saved in root disk or Harddisk under cable_co > OTDR 
directory.

A directory is automatically generated with the project name, and it is saved 
under disk > cable_co > OTDR. Measurements are stored into this 
directory, as well as a summary text file.

Loading a existing project
To open the project just created or to load an existing project:

1 Press the Load Project soft key on the Setup screen .

2 Select the project file to be used (.prj) in disk > cable_co > OTDR 
directory.

Figure 94 Enter a name for the project

NOTE

Once a project is created, the parameters cannot be modified 
except the acquisition ones.
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3 Press Load Project softkey.

A summary table of all fibers and measurements performed is 
displayed.

Starting project test process

Once the project is loaded, the following screen is displayed.

Figure 95 Loading a project

Recall of the 
Cable Project 
parameters

Inspect & clean all fiber connections prior to connecting 
fiber under test to the OTDR port.
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1 Click on the first fiber to be tested.

The fiber number is framed in black (n°1 in Figure above)

2 If necessary, press Quick Setup soft key to modify some acquisition 
parameters before launching the measurement

3 Press START/STOP hard key to start the acquisition.

Figure 96 Cable view

Figure 97 Quick Setup sub-menu
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4 Once all wavelengths have been measured, a window opens, asking: 

– Click on Yes to test next fiber

– Click on No to return to project table.

Trace saving
The traces are automatically stored into the project directory and according 
to defined filenaming convention.

Results of project cable
Once fibers have been tested, the project page updates on the fly:

If a test is launched onto a fiber already tested, a dialog box 
displays: «Test already done. Do you really want to 
repeat the test? Results files will be deleted.». 

Click on Yes to confirm the new test, and by consequence, to 
delete existing file(s). 

Click on No to cancel the test.
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Description of the table
The number of fiber is highlighted in different color according to the alarm 
status:

• Pass: 

• Fail: 

• No Alarm defined: 

• No test performed on the fiber 

Deactivate the fiber test
Before starting the test, some fibers can be deactivated so that the acqui-
sition will not be performed.

1 Select the fiber number which does not need to be tested (framed in 
black).

2 Click on the soft key Deactivate fiber test.

Figure 98 Cable project
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3 Repeat the process for the fibers which do not have to be tested.

The deactivated fibers will be skipped while moving to next fiber to test.

View Trace
1 In the project page, click on the fiber number for which you want to 

display the corresponding trace (e.g. ).

2 Click on View Trace(s) soft key.

The trace result page displays.

Figure 99 Fibers 4 and 6 deactivated

If a test is deactivated on a fiber already tested, a dialog box 
displays: «You’re about to delete acquisition files. 
Are you sure?». 

Click on Yes to confirm the deactivation, and by consequence, to 
delete corresponding trace(s). 

Click on No to cancel the deactivation.
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Click on View Cable to return to project page.

Files and Project storage
As soon as a project is saved from Setup page (see “Saving the project” on 
page 187), a folder is automatically generated with associated sub-directo-
ries.

The project and all corresponding test files are saved in the folder 
cable_co, automatically created.

The project file is saved in the directory cable_co > OTDR.

Figure 100 Trace from fiber selected in project

Name of the project Number of the fiber selected

Click to return 
to project
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For each project, a subdirectory with the project Id is created, containing 
test OTDR files and summary results (in text format): cable_co > OTDR 
> Project_Id.

Figure 101 Project files

The project file is not visible in the explorer until the project 
is closed.

Figure 102 Project directory structure with file contents
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Text file content
As soon as one acquisition is performed from the project, a summary text 
file (.txt) is associated to the OTDR test data. 

Each new test is inserted into the text file as project process evolves.

This file contains all the summary values of all tested fibers:

– Link loss

– Link distance

– Link ORL

This file uses tabulations to separate values. It is saved with the extension 
«.txt» and can be opened by the Platform.

Figure 103 Text file
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Chapter 10FiberComplete Modules

This chapter describes the functions of the FiberCompleteTM modules 
(Combined OTDR or Fault Finder and auto bidirectional IL/ORL and 
Distance) and their use.

The topics discussed in this chapter are as follows:

• "General introduction" page 198

• "Activating the function" page 202

• "Establishing References" page 202

• "Configuring the units" page 207

• "Performing the tests" page 224

• "Results screen" page 227

• "Saving results and generating a report" page 231

• "File management" page 235

This function is not available with SmartOTDR.
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General introduction

Principle
FiberComplete is used to perform automatically and through a single 
connection port, the following tests:

• Bidirectional insertion loss (IL)

• Bidirectional optical return loss (ORL) using the continuous wave 
method (OCWR) 

• Distance/length measurements

• Unidirectional / Bidirectional OTDR or fault analysis

To carry out the measurements, 2x T-BERD/MTS are needed, both 
equipped with FiberComplete capable modules (see references in 
Chapter 13) and broadband power meters on the mainframes. 

Using one unit at each end of the fiber under test and without any connec-
tion/disconnection, IL/ORL and distance measurements are performed and 
results exchanged via the fiber under test (FUT). 

If the OTDR is selected, an OTDR measurement is launched automatically:

• Unidirectional mode: the OTDR acquisition is performed from the 
primary unit where the test has be initiated. Traces are saved locally

• Bidirectional mode: the OTDR acquisition is initiated successively 
from each unit. The traces are saved locally.

A failed value of IL or ORL may trigger the Fault Finder function automati-
cally in order to identify the faulty event.
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Configurations
Two configurations are available, depending on the tests that have to be 
performed:

• Construction/Installation tests with loss, optical return loss, distance 
and OTDR.

• Acceptance Tests with loss, optical return loss and distance, and 
faults detection in case of problem.

Figure 104 Configuration for FiberComplete function

Local

Remote
IL / ORL / 
Distance / OTDR

Acquire
Measure Bidir IL 
& ORL and OTDR

Analyze
Locate failures 
with Fault Finder

Report
Save all the results 
automatically

NOTE

The FiberComplete function can be performed with one T-BERD/
MTS-2000 and one T-BERD/MTS-4000.
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Construction/Installation Test

In this configuration, bidirectional IL and ORL, length and/or unidirectional/
bidirectional OTDR measurements are performed. The bidirectional IL/
ORL and length results are stored on each unit, the OTDR traces are 
stored on the locally unit (where the test has been initiated).

Figure 105 Construction/Installation Test

Do an OTDR measurement and store it on the units

Next 
Fiber

Measure ORL A & ORL B, and store/display on both units

Measure Loss A->B, B->A, and Avg and store/display on 
both units

Press START/STOP button to launch the measurements

Setup Units A & B (Measurement and File parameters)

Reference Source and power meter on Units A & B

If a Bidirectional OTDR measurement is performed, the 
OTDR results are automatically saved on each unit;

• The OTDR results trace for acquisition performed from 
Location A to Location B is stored on the primary unit (Loca-
tion A)

• The OTDR results trace for acquisition performed from 
Location B to Location A is stored on the secondary unit 
(Location B)
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Acceptance Tests

In this configuration, the bidirectional IL, ORL and length measurements 
are performed and results are automatically stored on each unit.

If the Fault Finder function has been selected in the Setup menu, and if at 
least one result exceeds the defined thresholds, the predominant defects 
causing the failure are identified and located.

The FiberComplete screen displays an easy to interpret result table that 
prompts predominant issues for easy troubleshooting.

Figure 106 Acceptance Test

Pass

Next 
Fiber

Measure ORL A & ORL B, and store/display on both units

Measure Loss A->B, B->A, and Avg and store/display on 
both units

Press START/STOP button to launch the measurements

Setup Units A & B (Measurement and File parameters)

Reference Source and power meter on Units A & B

Compare results with defined thresholds

Fail

Fault finder
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Activating the function
1 Press the HOME button.

2 Select the icon FCOMP .

The icon turns yellow and Fiber Complete is displayed .

Establishing References
To get a meaningful measurement, the two leads or patch cords used for 
the measurement have to be referenced. The references are valid for all 
fibers that will be tested during the day with the same patch cords. If, at 
anytime, the patchcords are disconnected from the test instruments and/or 
have been contaminated by dirt or dust, the patchcords have to be re-
inspected and referencing stage has to be redone.

Reference methods for insertion loss and ORL testing

Table 5 Reference methods for Insertion Loss and ORL Testing

IL Loopback 
Reference Method

IL Side-by-side 
Reference method

Zero ORL 
reference method

Setup 
requirement

No specific require-
ment

Units shall be at the 
same location for ref-
erences

No specific 
requirement

Description

Each unit is per-
forming its own IL 
reference, with its 
source from the 
module port and 
powermeter from 
the base-unit, this 
with one dedicated 
jumper.

Each unit is perform-
ing its own IL refer-
ence, and units are 
connected using two 
jumpers and a bulk-
head adapter.

Each unit is per-
forming its own 
ORL reference, 
with its source / 
powermeter from 
the module, this 
with one dedi-
cated jumper
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Reference stage process
The Power Meter option is mandatory onto the Mainframe.

Each test equipment must set its own references and conform to the 
following process:

1 Press RESULTS button

2 Press References > Take Refs keys and follow the step by step 
instructions to perform references on each unit.

3 Choose between side by side or loopback for you loss referencing 
method

Recommen
dations

Easiest process.
Not recommended 
for short links.
One the reference 
is performed, do 
not disconnect 
jumper from the 
source

Most accurate setup, 
but both units must be 
at the same location 
for references.
Once the reference is 
performed, do not dis-
connect jumper from 
units ports.

Easy process.
Once the refer-
ence is per-
formed, do not 
disconnect jumper 
from the source.
Use of non reflec-
tive terminator is 
mandatory for 
bend insensitive 
jumper.

Loss 
principle

Link ORL, includ-
ing link connectors.

Link IL including one 
link connector

Link ORL mea-
surement after 
jumper, for opti-
mized testing. 
Requires mandrel 
wrap or non reflec-
tive termination at 
link end.

Table 5 Reference methods for Insertion Loss and ORL Testing

IL Loopback 
Reference Method

IL Side-by-side 
Reference method

Zero ORL 
reference method

Adap Adap
Link under 

Adap Adap
Link under 

MTS2100 4100 Module US rev11.book  Page 203  Jeudi, 7. janvier 2016  1:29 13



Chapter 10 FiberComplete Modules
Establishing References

204 User Manual 77000010208 Rev. 011

Loopback Referencing method
The loopback referencing is used when the two units are at different loca-
tion.

After clicking on Loopback, the wizard will guide you through two steps:

1 The self reference is used for loss and ORL testing. Connect the 
jumper from the module port to the mainframe powermeter and press 
Ok to start referencing.

Figure 107 Select the reference to be performed

Figure 108 Self reference

Power meter of 
the 2000 platform

OTDR 
Module port
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The reference values are stored and displayed at the end

1 The zero ORL reference is necessary for ORL testing. Once the self 
reference measurement has been carried out, the Zero ORL adjust-
ment can be performed

Connect the jumper from the module port to the non-reflective termi-
nation via a mating sleeve. If you don't have a non-reflective termina-
tion, a mandrel can be used. Press Ok to start referencing.

Side-by-Side referencing method
The side-by-side referencing is used when the two units are at the same 
location and is the preferred method for better loss measurement accuracy.

Figure 109 Zero ORL reference

Non-reflective termi-
nation (or mandrel)

OTDR port

NOTE

Non-reflective terminations are mandatory when bend insensitive 
jumpers are used.
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After clicking on Side/Side, the wizard will guide you through three steps:

1 The side-by-side reference is used for ORL testing. Connect the 
jumper from the module port to the mainframe powermeter and press 
Ok to start referencing.

2 The zero ORL reference is necessary for ORL testing. Once the self 
reference measurement has been carried out, the Zero ORL adjust-
ment can be performed

Connect the jumper from the module port to the non-reflective termi-
nation via a mating sleeve. If you don't have a non-reflective termina-
tion a mandrel can be used. Press Ok to start referencing.

3 For the loss reference, connect the jumper from the module port of 
the primary unit, toward the module port of the secondary one via a 
mating sleeve. Press Ok to start referencing.

NOTE

The side-by-side loss reference is bidirectional and performed 
automatically on both units.

Figure 110 Loss Reference

Mating 

Jump
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Factory References
In the Take Refs sub-menu, the softkey Factory Refs is available. 

It allows to apply the reference values defined by default in factory.

The following figure show the values defined by default in factory:

Configuring the units
Once references have been taken on both Units, the acquisition parame-
ters must be configured.

1 Press SETUP button to display the Setup menu of the FiberComplete 
function.

Figure 111 Factory References

The Laser selection and Analysis parameters must be con-
figured on both units. Other acquisition setups shall be set 
on the primary unit.
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Acquisition parameters
Laser select the desired wavelength(s).

All: acquisition is performed for all wavelengths
available in the instruments.

Loss measurement select the loss measurement mode.

Unidir.: loss is measured in one direction only

Bidir.: loss is measured in both direction

None: loss is not measured.

Figure 112 FiberComplete Setup

NOTE

It is possible to select individual wavelength per unit. For exam-
ple, one can make 1490/1550 nm test from one end, and 1310 
nm from the other end.

The following acquisition parameters are only taken into 
account if the test is performed from this unit. If not, those 
parameters are not taken into account.
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ORL measurement select the ORL measurement mode.

Unidir.: ORL is measured in one direction only

Bidir.: ORL is measured in both direction

None: ORL is not measured.

Length Measurement select if the fiber length must be measured during
the test.

Yes: the fiber length will be measured.

No: the fiber length will not be measured during
the test.

Length Measurement select if the fiber length must be measured during
the test.

Yes: the fiber length will be measured.

No: the fiber length will not be measured during
the test.

OTDR Measurement select the measurement method for OTDR.

None.: OTDR measurement is not performed
after FiberComplete test.

Unidir.: OTDR measurement is performed in one
way: from the primary unit toward the secondary
one.

Bidir.: OTDR measurement is performed with
parameters defined in automatic mode in the two
ways: from primary to seconday unit, and from
secondary to primary unit.

OTDR Acquisition if OTDR measurement is configured with Unidir
or Bidir parameter, select the acquisition mode
for OTDR.

Auto.: OTDR acquisition is performed with
parameters defined in automatic mode.

A measurement will be performed only if at least Loss or 
ORL parameter is selected.
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Manual; OTDR measurement is performed with
the parameters manually defined in the OTDR
Setup menu (see "Configuring the test in Expert
OTDR" page 27).

No: OTDR measurement is not performed.

Fault Finder select if Fault Finder function must be activated.

Yes: if a result for Loss and/or ORL exceeds one
limit value defined in the Thresholds parameters
(see “Alarms parameters” on page 211), the Fault
Finder function is automatically triggered in order
to identify the faulty events.

No: the Fault finder function is not activated (no
fault finding occurs, even if one value exceeds
the thresholds).

NOTE

This parameter is not available when only the Fault Finder func-
tion is available in the module.

If «Fault Finder» parameter is set to Yes, the «OTDR» 
parameter is automatically set to No, and vice-versa.

The following parameters, defined on master unit, are auto-
maticcaly appplied/transferred to the slave unit: Laser - IL/
ORL Bidir. - OTDR Acquisition Auto (if OTDR Acquisition is 
defined on Manual, both units will performed a manual measure-
ment, but according to their own configuration in the OTDR tab: 
the parameters can then be different).
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Alarms parameters
In the Setup page, press Alarms softkey (if one parameter is selected in 
the current screen, press Top Menu soft key to display the right menu keys 
and click on Alarms).

Thresholds select the user defined thresholds to be used:
User 1 / User 2 / User 3 / User 4 and enter limits
for:

- Loss: enter a loss threshold for each
wavelength (dB) 

- ORL: enter an ORL threshold for each
wavelength (dB)

Or select the Default parameter to define
thresholds by default for Loss and ORL values:

- Loss: > 40 dB for each wavelength 

- ORL: < 27 dB for each wavelength

Select None if alarm thresholds must not be
defined

Analysis parameters
In the Setup page, press Analysis softkey (if one parameter is selected in 
the current screen, press Top Menu soft key to display the right menu keys 
and click on Analysis).

Unit

Select the unit for the distance measurement: km / kfeet / miles.

Table View

Allows to choose the kind of table to be displayed at the end of acquisition.

Fiber displays detailed results for one fiber: Loss B -> A
and loss A -> B at each wavelength; the average
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loss at each wavelength and the ORL A and ORL
B at each wavelength. See "Fiber View" page
228.

Cable displays cable result of multiple fibers: the
average loss and the ORL A and ORL B at each
wavelength. See "Cable view" page 227.

Link parameters
In the Setup page, press Link softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys 
and click on Link).

NOTE

If Fiber View is selected, and if results are stored, then the file-
naming convention is; [fiber Id][fiber Num]. Therefore, the unit will 
generate one IL / OLR / Distance file per fiber.

NOTE

If Cable View is selected, and if results are stored, then the file-
naming convention is; [cable ID]. Therefore, the unit will generate 
one IL / OLR / distance file per complete cable.

NOTE

The softkey Copy File/Link to All is displayed when one param-
eter is selected in the Link or File Setup page and when the Pow-
ermeter or Source function is active. 

It allows to apply the Link and File configuration parameters of 
the current applications to all the other active Fiber Optic applica-
tions (powermeter, and source).
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The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters. When a 
trace is recalled without recall of the configuration, the parameters of this 
trace will be present only in its signature.

Fiber ID

Select the parameter Fiber Id and enter a name for the fiber, using the 
edition keypad.

Fiber Number / Fiber Code

The parameter Fiber Number becomes Fiber Code if, in the Cable Struc-
ture window, the Cable Content parameter is defined on another param-
eter than Fiber (Ribbon/Fiber, Tube/Fiber or Tube/Ribbon/Fiber). See 
page 215.

The fiber code corresponds to the fiber number if, in the Cable Structure, 
the parameter Color coding is defined on No. 

The fiber code corresponds to the fiber color if, in the Cable Structure, the 
parameter Color coding is defined on Yes.

1 Select the parameter Fiber Number/Fiber Code and modify the 
parameter using the left and right direction keys.

The fiber number can be automatically incremented/decremented at 
each new file save if it has been configured in the File Setup page 
(see "File parameters" page 219).

NOTE

The Fiber Code and the fiber number concatenated with Fiber 
Name are interdependent: they are incremented or decremented 
at the same time. However, the fiber number remains a number 
only, while the fiber code is alphanumerical. Whether it includes a 
color code or not (see “Cable structure” on page 215), it may be 
composed of one, two or three parts (see figure Table  on 
page 214). 
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Change Fiber Nbr 

Increment the fiber number is automatically incremented at each new 
file-save.

Decrement the fiber number is automatically decremented at each 
new file-save

User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the 
number. Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Extremities are different1

In some cases, it is interesting to save different information for the origin 
and the extremity of the cable.

If this option is validated, it is possible, after selecting the extremity to be 
edited in the Cable Structure menu, to modify the values specific to the 

Figure 113 Example of incrementation of fiber code

Fiber and cable parameters used in the example:

Fiber Name: ’Fiberx’
Cable Content: ’Tube/Fiber’
Max Tube: 12
Max Fiber: 24
Coding used for the fiber and the tube: TIA

Fiber N Fiber N+1

 Color Code  Yes No Yes  No

<Fiber Name> Fiberx24 Fiberx24 Fiberx25 Fiberx25

<Fiber Code> Bl/Aq- 1/24 Gold/Bl 2/1

1.Available exclusively if Super Expert license is installed
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cable (cable name, color coding, content of the coding), for each of these 
extremities. See chapter “Cable structure” on page 215) 

To display/modify the data specific to the fiber (name and code), it is neces-
sary to change direction temporarily. In the "O->E" direction, the informa-
tion on the origin can be edited, and in the "E->O" direction, that on the 
extremity.

Cable Id

This parameter allows to enter an identification of the cable, using the 
Edition menu.

Direction

The direction shows if the acquisition has been made from the origin to the 
extremity (A->B) or from the extremity to the origin (B->A). Changing direc-
tion makes it possible, when different extremities are handled, to see the 
parameters of the fiber for the other extremity.

Location A

The name of the Location A of the link may be entered here.

Location B

The name of the Location B of the link may be entered here.

Cable structure

This line opens a sub-menu, all the parameters of which can be different 
for each extremity.
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View extremity If extremities are declared as different (see
“Extremities are different” on page 214), this
parameter allows to navigate between the
Extremity and Origin parameters.

Cable Id If the extremities are different, you can specify
the cable identification for the origin and the
extremity.

Color Coding Choice of whether or not to apply a color coding
to the fiber. This choice is made at link level, as
all the fibers of a given link, for a given extremity,
will be coded the same way. This choice modifies
the result of the <Fiber Code> line. See “Fiber
Number / Fiber Code” on page 213.

Figure 114 Cable structure menu

NOTE

The Cable Structure window is specific to an extremity. Each 
struc-ture keeps its own parameters by default. Modifications 
made to the one are not automatically applied to the other. Thus, 
after the values relating to the origin have been modified, it is 
normal not to find these same values entered for the extremity.
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Cable content Shows how the color code is to be used:

– FiberOnly the color code of the fiber is proposed (example: 
«Gold»)

– Ribbon/Fiber The color code of the fiber is preceded by that of 
the ribbon, and separated by a ’/’ (example: ’Bl/Or’)

– Tube/Fiber The color code of the fiber is preceded by that of the 
tube, and separated by a ’/’ (example: ’Br/Or’)

– Tube/Ribbon/Fiber
The color code of the fiber is preceded by that of the tube, then 
by that of the ribbon; the three being separated by a ’/’ (example: 
’Br/Bl/Or’). See “Fiber Number / Fiber Code” on page 213. 

Max tube Shows the maximum number of tubes in the
cable for the extremity selected. This information
influences the automatic coding of the fiber. See
“Fiber Number / Fiber Code” on page 213.

Max ribbon Shows the maximum number of ribbons in the
cable for the extremity selected. This information
influences the automatic coding of the fiber. See
“Fiber Number / Fiber Code” on page 213.

Max fiber Shows the maximum number of fibers in the
cable for the extremity selected. This information
influences the automatic coding of the fiber. See
“Fiber Number / Fiber Code” on page 213.

Tube Coding, Ribbon Coding, Fiber Coding

The lines Tube Coding, Ribbon Coding and Fiber
Coding enable selection of the color coding of the
tube, the ribbon and the fiber from 5 different

NOTE

Certain parameters are not valid in the configuration selected. 
Thus, if no tube is selected in Cable Content, all the lines relat-
ing to the tube concept will be deactivated (grayed out in the 
menu).
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codes described below: TIA, USER 1, USER 2,
USER 3 and USER 4.

Code Definition The Code Definition line opens a sub-menu, with
which the different color codes possible on the
instrument can be displayed and modified.

Five different codes can be managed by the MTS/T-BERD 4000, including 
a standard code. 

The standard code (TIA) may be displayed but it cannot be modified.

The other codes, called by default USER1, USER2, USER3 and USER4, 
can be entirely personalized.

– Edited codeselects the code for display or modification.

– Code nameto give a new name to the code selected, press the 
 key, which calls up the edit menu.

– View codesdisplays the color codes 1 to 12, 13 to 24 or 25 to 36.

– Code 1...23Use the arrow  to modify the codes if necessary.

Technician Id

Use the arrow  to enter the name of the operator carrying out the 
measurement.

Job Id

Use the arrow  to enter a description of the measurement to be 
performed.

Comment

In contrast to the other data in this menu, the comment is specific to a fiber. 
This line is thus used to enter a new comment and not to display it. The 
comment appears at the top of the screen, with the other parameters of the 
fiber.
This comment will remain available for the next acquisition, unless it is 
deleted. It is also saved when a trace is saved with a comment.
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File parameters
The File storage parameters must be also configured, in order to define 
how the results traces will be saved onto the MTS/T-BERD 2000.

In the Setup page, press File softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys 
and click on File).

Dir

This parameter cannot be configured, and display the directory selected by 
default into which the file(s) will be saved (the last directory selected).

To modify the directory, go to the Explorer page and select another direc-
tory.

Filenaming

Select Filenaming parameter and press the right arrow key to modify the 
name of the file for the result trace.

The following parameters defined in the Setup > File page of 
the master unit are automatically applied/transferred to the 
slave unit: Filenaming - Save mode.

NOTE

The softkey Copy File/Link to All is displayed when one param-
eter is selected in the Link or File Setup page and when the Pow-
ermeter or Source function is active. 

It allows to apply the Link and File configuration parameters of 
the current applications to all the other active Fiber Optic applica-
tions (powermeter, and source). 
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In the edition keypad, enter a name manually for the file and/or use 
the predefined parameters available (Cable_Id, Fiber_Num...). 
Then, press Enter to validate.

or

Press Default Filename to apply the name by default to the file:

Default Filename for FCOMP results

Filenaming convention in Fiber View

In Fiber View, the filenaming convention is as follows:

[Fiber_Id][Fiber_Num]

Filenaming convention in Cable View

In Cable View, the filenaming convention is as follows:

[Cable_Id]

As soon as the Cable Id changes, the result table is cleared and the next 
tests are stored with the new Cable Id name.

Figure 115 Filenaming - Edition keypad

Predefined 
parameters for 
naming files
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The table view can be modified in the Setup page (see Figure 104 on 
page 199).

Filenaming convention for Fault Finder results

If the fault finder is selected, the fault finder sor trace is using the following 
filenaming convention:

[Cable_Id][Fiber_Id][Fiber_Num]

The name of the file is displayed in grey under Filenaming parameter

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can 
select three types of methods for storing traces:

File Only only the trace(s) is/are stored in one/several
file(s), with its extension (.sor, .msor)

File + txt the trace(s) is/are stored in one/several file(s),
with its extension and one txt file is also
generated.

File + pdf the trace(s) is/are stored in one/several file(s),
with its extension and one pdf file is also
generated.

Auto Store

Select Yes to store automatically the trace or traces resulting from each 
acquisition according to the filenaming rules.

Automatic configuration
Press the key Auto Setup to configure automatically the acquisition 
parameters as follows:
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• Lasers: All

• Loss Measurement: Bidir.

• ORL Measurement: Bidir.

• Distance: Yes

• OTDR Measurement: None

• Fault Finder: No

• Table View: Fiber

• Threshold: Default

Saving the parameters from FiberComplete 
configuration

Once the OTDR and FCOMP File and Measurement parameters are 
configured, it can be saved in a configuration file.

This configuration file can then be recalled for future acquisition in Fiber-
Complete mode.

To save parameters in a configuration file:

1 In the Setup page, select one parameter & press menu key .

An edition keypad displays

2 Enter a name for the configuration file.
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1 Press Enter to validate

The configuration file is saved with the extension «fo_cfg» (icon ).

Loading a configuration file FiberComplete 
FiberComplete configuration file includes OTDR and FCOMP setup and file 
parameters.

To load a configuration file previously created and apply parameters to new 
tests:

Figure 116 Save Configuration file - Edition keypad

Directory into 
which file will be 
saved

NOTE

Configuration file is saved in the current directory, the last one 
used.

NOTE

The FiberComplete configuration file includes data storage and 
measurement settings of FCOMP and SM_OTDR. This configura-
tion file can be shared and reused with other units.
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1 Press FILE hard key

2 Select the configuration file in the wished directory.

3 Press Load > Load Config.

• Press SETUP hard key to display the OTDR and FCOMP acquisition 
parameters saved in the configuration file.

You can modify some acquisition or file storage parameters, and save 
them in a new configuration file (see “Saving the parameters from Fiber-
Complete configuration” on page 222).

Performing the tests
Once Setup is configured on both units, they can be linked to the fiber to 
be tested.

1 Press RESULTS hard key to display the results page for FiberCom-
plete function

Automatic pairing / continuity check

As soon as the secondary (B) unit is connected to the fiber, the primary (A) 
unit detects it (and vice-versa).

NOTE

Some configuration files are available in the Platform: press FILE 
and select disk > config > FCOMP.
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Sending a message to the distant Platform
Once both Platforms are paired via the fiber to be tested, each one can 
send a message to the other Platform.

This message can be sent to launch a test, to wait before launching the 
test, to clean the connectors...

To send a message to the distant Platform:

1 Go to the Results page.

2 Press Send a message softkey.

A new screen displays.

3 Select the message to send.

One unit is disconnected of the fiber 
link, or there is a break Both unit are connected to the same fiber

Figure 117 Messages list
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4 Press the Send Message softkey.

The message displays automatically on distant Platform.

Starting the test
Below are described the steps when bidirectional IL/ORL and distance are 
selected in the Setup menu.

1 Press START/STOP button to launch the test

a Unit A and B are performing IL test and mutually exchange their 
result values

b Unit A and B are performing ORL test (using OCWR method) 
and mutually exchange their result values.

c Distance measurement is performed and recorded on both 
units.

NOTE

If the message "Go to Fiber Nb" is selected, use left and right 
direction keys to decrement/increment the fiber number.

Figure 118 Receipt of the message on the distant Platform
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d Once all tests are performed, results are displayed on both units

e If OTDR parameter is set to Auto or Manual in the Setup menu, 
the OTDR acquisition starts.

f If Fault Finder parameter is set to Yes and an IL or ORL value 
reaches one of the user defined thresholds, the Fault Finder 
starts.

See “Configuring the units” on page 207.

Results screen
Once the tests are completed, the results screen displays on both units.

Cable view
If, in the Setup page, the parameter Table View is set to Cable, the 
following result table is displayed:

Figure 119 Test in progress
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The Cable View allows to display results of multiple fibers:

– the average loss at each wavelength

– the ORL A and ORL B at each wavelength

– the distance is displayed on top of the screen

Fiber View
If, in the Setup page, the parameter Table View is set to Fiber, a screen 
as the following one displays:

Figure 120 Result Cable View

NOTE

In order to erase the results table, the Cable ID must be modified 
in the File Setup menu (see “Description of the explorer” on 
page 240).
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The Fiber View allows to display results of one fiber:

– Loss B -> A and loss A -> B at each wavelength

– the average loss at each wavelength

– the ORL A and ORL B at each wavelength

– the distance is displayed on top of the screen

Fault Finder
If, in the Setup page, the Fault Finder parameter is set to Yes, a Fault 
analysis is automatically launched, if one value exceeds the thresholds 
defined in the Setup menu.

As soon as the Fault Finder finishes its analysis, an easy to interpret table 
displays. It indicates the attenuation values and/or reflectance of the 
predominant defects that may have caused the IL / ORL values to fail.

1 Select Table IL/ORL - Fault to switch between the IL/ORL and Fault 
Finder result.

Figure 121 Result Fiber View
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OTDR
If the OTDR parameter has been set to Manual or Auto, the OTDR acqui-
sition is launched and the trace(s) can be seen by selected the OTDR tab 
at the bottom of the screen.

Figure 122 Fault finder result screen

Figure 123 OTDR trace
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Saving results and generating a report
Once the results page is displayed, the results can be saved and a report 
can be generated directly from the results screen.

Saving and report can have been automatically generated if, in the file 
configuration, the Auto Store parameter has been set to Yes (see 
page 221) with the appropriate Save Mode.

NOTE

In Unidir/Bidir modes, the wavelengths selected for IL/ORL are 
also used for OTDR testing.

In Manual mode, all the OTDR parameters can be adjusted in 
the OTDR setup menu.

NOTE

To go from one tab to the other one, press the RESULTS button 
or, with touchscreen, directly select the tab wished.

NOTE

In bidirectional mode:

- The OTDR results trace for acquisition performed from Location 
A to Location B is stored on the primary unit (Location A)

- The OTDR results trace for acquisition performed from Location 
B to Location A is stored on the secondary unit (Location B).
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Saving results and creating a report from 
results page

To generate a report:

1 Press Fast Report soft key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

a In the Save Mode parameter, select:

File Only to save exclusively the results in a blts file

File + txt to save the results in a blts file and to generate a txt 
file of the results

File + pdf to save the results in a blts file and to generate a 
report in a pdf file

b In the Cable Id parameter, enter/modify the name of the Cable 
using the edition keypad.

c Modify the Fiber Number / Fiber Code using the key .

The parameter is different according to the Cable Structure 
configuration (see “Cable structure” on page 215).

d In the Direction parameter, select/modify the direction, to define 
if the measurement has been performed from Origin to 
Extremity (A -> B) or from Extremity to Origin (B -> A)

Figure 124 Fast report configuration
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e In the Location A and Location B parameters, enter/modify the 
name of Origin and Extremity.

3 Once saving is configured as wished, press Save All menu key 

4 Enter a name for the file in the edition keypad

or

Press Auto Filenaming to apply the file name defined in the Setup 
screen, in Filenaming parameter (see “Filenaming” on page 219)

5 Press Enter to validate

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Adding a logo to a pdf report

To display a logo, or any other image (other than the logo displayed by 
default) on the upper left part of the report:

1 Reach the System Settings screen:

– on the T-BERD/MTS 2000, on the Home page, press the 
Settings icon

– on the T-BERD/MTS 4000, on the Home page, press the 
System Settings menu key.

2 On the T-BERD/MTS 2000, in the Reports menu, in the Mode 
parameter, select Report

NOTE

The blts file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and 
directory selected.
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On the T-BERD/MTS-4000, in the Printer menu, reach the Printer 
parameter and select File (Formatted).

3 Select the file format of the report: JPG, PNG or PDF.

4 In the Logo parameter, enter the full path of the image file (with file 
extension) 
Example: disk/Logo.jpg

5 Click on Exit to return to Home page.

6 Press FILE and in the Explorer, open the file for which a pdf report 
must be generated.

7 Launch the report.

Once report is generated, the logo is displayed on the upper left part 
of the page.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file of the 
report.

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf.

3 Press Load.

The file opens on the T-BERD/MTS.
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File management

Storing results 
Although each measurement is automatically stored, it is possible to save 
the results under a different file name, directory etc.

Once the results are displayed: 

1 Press the FILE button 

2 Select Setup with the key Setup/Explorer 

3 Modify the parameter you want in the File configuration menu

Figure 125 Example of PDF report

NOTE

A pdf report can also be generated from the File Explorer page 
onto the T-BERD/MTS 8000 V2 or 6000/6000A (see “Generating 
pdf report(s)” on page 249).

MTS2100 4100 Module US rev11.book  Page 235  Jeudi, 7. janvier 2016  1:29 13



Chapter 10 FiberComplete Modules
File management

236 User Manual 77000010208 Rev. 011

Filenaming convention
The filenaming convention is automatically generated by the unit.

Filenaming convention in Fiber View

In Fiber View, the filenaming convention is as follows:

[Fiber_Id][Fiber_Num]

One blts file is created per each individual fiber tested. The Fiber Number 
is automatically incremented.

Filenaming convention in Cable View

In Cable View, the filenaming convention is as follows:

[Cable_Id]

The cable results, which includes all fibers, are stored in a .blts file.

As soon as the Cable Id changes, the result table is cleared and the next 
tests are stored with the new Cable Id name.
The table view can be modified in the Setup page (see Figure 112 on 
page 208).

Filenaming convention for OTDR results

If the OTDR is set to Auto, the sor traces have the following filenaming 
convention:

[Cable_Id][Fiber_Id][Fiber_Num]

A pre formatted .txt file can also be generated automatically at each 
measurement. It includes the Fault Finder table.
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Please refer to Chapter 11 “File management” for more information on 
storage/recall functions.
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Chapter 11File management

The topics discussed in this chapter are as follows:

• “Description of the explorer” on page 240

• “Saving and loading files” on page 243

• “Exporting files” on page 246
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Description of the explorer

Opening the file explorer
To access the Explorer

1 Press the FILE button

The explorer is used to select the storage medium, and to create or rename 
directories and files:

– The left-hand part presents the storage architecture. Click on 
the left of the screen or use the keys  and  to move around 
among all the media and their respective directories. 

– The right-hand part displays all the files present in the directory 
selected.

The direction keys can be used to move horizontally between the two parts 
and vertically within each zone.

At the top of the screen, the file signature selected is repeated (see 
Figure 127 on page 241).

Figure 126 Example of explorer

Free space available 
on the selected media

MTS2100 4100 Module US rev11.book  Page 240  Jeudi, 7. janvier 2016  1:29 13



Chapter 11 File management
Description of the explorer

User Manual 77000010208 Rev. 011 241

Managing tabs
Tabs give access to the File menu of each application present in the 
modules of the instrument. 

It is possible to open a file even if the corresponding module is not present 
in the instrument. A new tab then temporarily manages this application.

When several different applications (corresponding to modules for different 
measurements) are managed by the SmartOTDR, pressing the FILE key 
several times in succession changes from one tab to another to give 
access to the file configuration of the desired application (e.g. FCOMP, LTS 
etc.).

File signature
The acquisition parameters of the trace contained in the selected file are 
displayed at the top of the screen together with a small-scale representa-
tion of the trace (provided it was acquired on a MTS / T-BERD).

Figure 127 Example of signature of an OTDR file (in the File Menu)

Date of acquisition 
of the signal

Pass / Fail indicator

Mini-trace

Comment Acquisition time Origin / End

Refraction IndexResolution

LaserModule used 
for acquisition Fiber Id Cable Id

Fiber NumberPulse width

Figure 128 Example of signature with FCOMP file

Date of acquisition

Pass / Fail 
indicator

Comment Origin / End

Measurement 
parameters

Module used

Fiber Id Cable IdFiber Number

MTS2100 4100 Module US rev11.book  Page 241  Jeudi, 7. janvier 2016  1:29 13



Chapter 11 File management
Description of the explorer

242 User Manual 77000010208 Rev. 011

Buttons on the right of the screen

 Saving traces

Three buttons are used to save one or more traces.

• Store Trace: allows to save the current trace opened.

• Store all Traces: allows to store all the traces displayed in 
overlay (OTDR) in one single file.

• The softkey Next Trace is used to activate the menu of the 
following trace, when several OTDR traces are in overlay.

Storage media
For saving or recalling data, the equipment offers a wide choice of media, 
both built-in and external.

Free space on selected media is clearly displayed at the bottom of the left 
panel.

NOTE

Remote Base Unit and data transfer

During a data transfer (with the option Data/Talkset), the distant 
Base-Unit hard drive connected by the fiber is displayed as a 
storage media. File and directory edition features may all be 
used in the same manner with this storage media as with the 
other ones
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Directories and files editing function
The Files and directories editing functions are similar to those available in 
the Explorer page of the Platform.
Refer to 2000/4000 Platform or SmartOTDR User Manual if you want to 
work on directories and files (copy/paste, rename...).

Saving and loading files

Saving files from the Explorer
When the explorer is displayed, the active trace for the selected tab is 
displayed in the File Signature.

You can then save the active trace:

1 Select a directory by clicking once on it

2 Click on Store to save the active trace

A new sub-menu displays

3 For OTDR traces only click on Next Trace to change the file signa-
ture on the top part of the screen and to save the next trace from 
traces in overlay

4 Click on Save All or on Save (OTDR files only).

The Save All menu key in OTDR tab allows to save all the traces 
opened, whereas the Save menu key allows to save exclusively the 
trace described in the file signature.

5 If you wish, click on FILE button to display the Explorer page for 
another application and save, using the same method, the active 
trace from this application.
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This will open automatically the edition keypad, in order to give a file-
name for the active trace.

Loading files and displaying traces
To access the functions for loading one or more files, select the file(s) in 
the explorer and press Load.

Simple loading

The key View Trace(s) enables simple loading of traces, using the current 
parameters of the SmartOTDR. The current trace is then replaced with this 
new trace.

Figure 129 Saving active trace from the explorer (with OTDR trace)

The trace described in the file signa-
ture will be saved in the directory 
selected (in this example: demo)

Displayed when two active 
overlaid traces are open.

The «Store» menu key is not available if the type of saving 
for OTDR files is defined to «All Traces» in the File Content 
parameter (see “File Content” on page 48).

NOTE

For TXT, PDF, LTS and FCOMP, only one file can be opened at a 
time.
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Load with configuration

The key Load Trace + Config will display the traces, recalling the configu-
ration recorded in the file. Thus the zooms, cursors and parameters 
present at the time of acquisition will be used for the display. 

This function also enables to recall and set the parameters defined in the 
screens corresponding respectively to the FILE and SETUP keys.

It is then possible to perform an acquisition under the same conditions as 
those of the trace recalled.

• If the SmartOTDR was equipped with a different module from the 
current one when the trace was acquired, certain configuration 
parameters cannot be updated. A message warns the user of this.

• If several traces are selected, the configuration used will be that of 
the first trace.

• If the number of traces added and the number of traces present is 
greater than 8, then the last traces added will not all be taken into 
account.

Loading several traces in overlay

Up to 8 traces in the same application (OTDR) can be displayed simulta-
neously in overlay. 
To obtain a display of multiple traces, two methods are possible:

• Select all the files to be loaded at the same time (see 2000 or 4000 
Platform User manual for multiple selection of files) and click on 
Load > View Trace(s)

• Define a reference trace in a first time, open it, then come back to the 
explorer to select the other traces to be added (see “Reference Trace 
function” on page 93).

The configuration cannot be recalled if the trace was not 
originally created by a SmartOTDR or SmartOTDR.
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Exporting files
Click on the Export menu key allows to display a sub-menu from which 
selected files can be:

• generated into one/several reports

• merged into one file (for txt/pdf files only)

• sent by e-mail

Explorer/Link Manager
Before exporting file(s), the display can be modified, and the Link Manager 
can be selected instead of the Explorer using the Explorer/Link Mgr menu 
key.
The Link Manager function allows to display the explorer with all the link 
information exclusively for the active application (the function must be acti-
vated in Home page, or at least one result trace must be opened to get the 
tab and display files in the Link Manager page).
For example, if the Link Mgr. function is selected in the tab OTDR, only the 
link information from the OTDR files will be displayed (wether in multimode 
or singlemode).
Select Link Mgr with the menu key Explorer/Link Mgr. to display the 
corresponding files for the active tab.

Figure 130 Explorer and Link Manager display

Tab
selectedExplorer View

Link Manager View

MTS2100 4100 Module US rev11.book  Page 246  Jeudi, 7. janvier 2016  1:29 13



Chapter 11 File management
Exporting files

User Manual 77000010208 Rev. 011 247

According to the application selected, the fiber information available are 
different. The table below describes the fiber information displayed for each 
selected tab:

Editing function
The same editing functions as those from the Explorer are available with 
the Link Manager function, except the merging function (as this is used with 
txt files):

• Directory: Copy (or cut) / Paste; Rename, Delete... See “Directories 
and files editing function” on page 243).

• File(s): Copy / Cut, Rename, Delete... See “Directories and files 
editing function” on page 243.

Moreover, the Edit menu from the Link Manager page allows to export the 
whole directory, with the files corresponding to the active tab, in a txt file.

NOTE

The files in the Link Manager window can be sorted according 
each column available for a tab.

Table 6 Fiber Information displayed

Column. OTDR & OEO FCOMP LTS

1st Alarm status (icon) & Fiber number

2nd Direction Distance Laser

3rd Lambda Lambda Power (dBm)

4th Total Loss Lambda Loss (dB)

5th Distance Lambda Ref (dBm)

6th Nb of Event ORL at 1310 nm -

7th Max Splice ORL at 1550 nm -

8th Total ORL ORL at 1625 nm -
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Exporting a directory in a txt file
1 Click on Export and select the Link Manager function

2 Select the tab corresponding to the files you want to use

3 Select the directory to open

4 Select one file from the list

5 Click on Export menu key.

The txt file is automatically generated, in the same directory as the 
one selected for the export.

The name by default for the txt file is: fiber_info_”name of 
application selected”.txt.

For example, for the export of the Fiber Information from the OTDR 
application, the txt file will be called: fiber_info_otdr.txt

This file is made of two parts:

• The Header, with general information: the equipment used and its 
serial number, the date and time of export, the location of the file, and 
the number of files exported.

• The table, containing all the fibers information coming from the files 
of the active tab.

Once generated, the txt file can be transferred onto a PC and opened via 
a spreadsheet program (e.g. Excel...).

NOTE

The txt file can be renamed once it is saved.
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Generating pdf report(s)
Several files of a same type (example: all OTDR files) can be generated in 
one/several pdf report(s).

1 Select the file(s) to be generated in a pdf report

2 Press Export menu key

3 Using the menu key  select:

– 1 Trace if the report must be generated with one trace per page 

– Multi if the report must be generated with up to three traces per 
page (for OTDR files only).

4 Click on Report

5 In the edition menu displayed, enter the name for the report

6 Press Enter to validate and launch the report

The icon  display during report generation.

Once report is generated, a beep is emitted.

Figure 131 Example of a directory exported in a txt file (open with Excel)

Header of 
the txt file

Recall of the Fiber 
Information displayed 
on the SmartOTDR 
(except alarm status)

File name
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Using the Merge key, with the txt/pdf files
The txt or pdf files that have been saved/generated from a results page can 
be merged into one txt/pdf file from the Explorer.

The key Merge is used to merge several txt or pdf files into one file, putting 
together the results of all files.

Figure 132 Report: 1 Trace and Multi (with OTDR files)

PDF Report: «1 Trace» mode PDF Report: «Multi» mode

NOTE

The report is saved in the same directory as the selected files.
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1 In the explorer, select the txt/pdf files generated with the trace files 
you want.

2 Click on Export > Merge key

The icon  displays during merging process, and a beep is emitted 
once process is completed.

The file is saved with the filename: merged_yyyy_mm_day__hr_mn_sec.pdf/
txt

It is automatically saved in the same directory as the one where the 
txt/pdf files have been selected.

Sending files by e-mail (T-BERD/MTS 4000 only)
Several files can be sent by e-mail.

1 Check in the Setup page that the File Export parameters are correctly 
configured (see 4000 Base Unit User Manual).

2 In the Explorer, select the file(s) to be sent by e-mail

3 Press Export menu key.

4 Click on Send by mail menu key .

5 If necessary, in the edition menus displayed, modify the e-mail 
address and/or the subject of the e-mail.

6 Press Enter to validate and send the file

The merging can be done exclusively from files of the same 
format. Pdf and txt files cannot be selected at the same time 
to generate a merged file.

NOTE

The file can be renamed once it is saved.
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The menu key Send by mail  turns inactive until the end of 
process 

Once mail is sent, menu key is active again and the message Mail 
Sent is displayed. 

Click on any key to follow.
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Chapter 12Technical specifications

This chapter shows the technical specifications of the OTDR modules and 
of the options available for the or T-BERD/MTS 2000 or MTS/T-BERD 
4000, and the OTDR technical specifications for SmartOTDR.

The topics discussed in this chapter are as follows:

• “OTDR modules for T-BERD/MTS 2000/4000” on page 254

• “Technical specifications of the Power meter function on module for 
T-BERD/MTS 2000/4000” on page 260

• “Technical specifications of the Source function on module for T-
BERD/MTS 2000/4000” on page 261

• “Technical specifications of the FiberComplete modules” on 
page 262

• “OTDR Technical specifications for SmartOTDR” on page 264
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OTDR modules for T-BERD/MTS 2000/4000

Characteristics of reflectometry measurements 

Distance measurement 

• Dual cursor 

• Distance displayed takes into account the calibration of the refractive 
index of the fiber.

• Index adjustable from 1,30000 to 1,70000 in steps of 0,00001

• Resolution of display: 1 cm max.

• Resolution of cursor: 1 cm max.

• Spacing of measurement points: from 4 cm, with up to 256 000 
acquisition points.

• Accuracy: ± 1m± sampling resolution ±10-5 x distance
(excluding errors of calibration of refractive index of the fiber).

• Display span: 3.25 m to 260 km

Attenuation measurement 

• Dual cursor

• Resolution of display: 0,001 dB

• Resolution of cursor: 0,001 dB

• Linearity: ± 0.05 dB/dB with LA Modules
± 0.03 dB/dB with MA, MAE, MP & QUAD/MM Modules

• Display span: 1.25 dB to 55 dB
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Reflectance Measurement

• Resolution of display: 0,01 dB

• Accuracy: ± 2 dB

Automatic measurement

• Automatic measurement of all the elements of the signal. Slope 
measurement by least squares or 2 points of measurement.

• Display threshold of faults:

- 0 to 5.99 dB in steps of 0.01 dB for event thresholds 
- -11 to -99 dB in steps of 1 dB for the reflectance
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

• Display of slope and attenuation for a segment of fiber.

• Display of the position of a fault and of attenuation.

• Display of the reflectance of the fault.

• Display of ORL

Manual Measurement
• Measurement of slope between the cursors.

• Measurement of attenuation between two segments of fiber.

• Measurement of reflectance of a reflecting element.

• Measurement of ORL between the two cursors.

• Measurement of splice by 2 or 5 points method 
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Typical specifications
Typical values, measured at 25°C unless specified.

Multimode OTDR Module 41XXMM

Central Wavelength1

1. Laser in CW mode, at 25° C

850 / 1300 nm ± 30 nm

Typical RMS Dynamic Range2

2. Typical value corresponding to the difference (in dB) between the level of back-diffusion 
extrapolated at the beginning of the fiber and the RMS noise level, after 3 minutes of 
averaging, with the largest pulse width.

26 / 24 dB

Distance Range Up to 80 km

Pulse width 3 ns to 1 µs

Event Dead Zone3

3. EDZ measured at +/- 1.5 dB below the peak of a non-saturated reflecting event at short-
est pulse width.

0.8 m

Attenuation Dead Zone4 

4. ADZ measured at +/- 0.5 dB on the basis of a linear regression, using a - 40 dB type 
reflectance, at shortest pulse width.

4 m

Singlemode Modules
LA

41xxLA
MA

41xxMA
MAE

41XXMAE
MP

41xxMP

Central Wavelength 1
1310 ± 20 nm
1550 ± 20 nm
1650 ± 20 nm

1310 ± 20 nm
1550 ± 20 nm
1625 ± 10 nm
1650 ± 20 nm

1310 ± 20 nm
1550 ± 20 nm

1310 ± 20 nm
1490 ± 20 nm
1550 ± 20 nm
1625 ± 10 nm
1650 ± 20 nm

RMS Dynamic Range 2
35 dB
33 dB
30 dB

40 dB
38 dB
37 dB
37 dB

40 dB
38 dB

43 dB
41 dB
41 dB
41 dB
40 dB

Distance Range up to 260 km
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Pulse width 5ns to 20 µs 3 ns to 20 µs 3 ns to 20 µs 3 ns to 20 µs

Event Dead Zone 3 1.5 m4 0.9 m 0.9 m 0.8 mf

Attenuation Dead 
Zone 5 

6 m 4 m

1. Laser at 10 µs and 25° C
2. Typical value corresponding to the difference (in dB) between the level of back-diffusion extrap-

olated at the beginning of the fiber and the RMS noise level, after 3 minutes of averaging, with 
the largest pulse width.

3. EDZ measured at 1.5 dB below the peak of a non-saturated reflecting event at shortest pulse 
width.

4. At 1310 nm
5. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/

UPC (-55 dB) at shortest pulse width, at 1310 nm.

Singlemode Modules
LA

41xxLA
MA

41xxMA
MAE

41XXMAE
MP

41xxMP

Multimode / Singlemode OTDR Module

Central Wavelength 1 850 / 1300 nm ± 30 nm 1310 / 1550 nm± 20 nm

Typical RMS Dynamic Range 2 26 / 24 dB 37 / 35 dB

Distance Range Up to 80 km Up to 260 km

Pulse width 3 ns to 1 µs 3 ns to 20 µs

Event Dead Zone 3 0.8 m 0.9 m

Attenuation Dead Zone 4 m4 4 m5

1. Laser in CW mode, at 25° C
2. Typical value corresponding to the difference (in dB) between the level of back-diffusion extrap-

olated at the beginning of the fiber and the RMS noise level, after 3 minutes of averaging, with 
the largest pulse width.

3. EDZ measured at +/- 1.5 dB below the peak of a non-saturated reflecting event at shortest 
pulse width.

4. ADZ measured at +/- 0.5 dB on the basis of a linear regression using a -40 dB type reflectance, 
at shortest pulse width.

5. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/
UPC (-55 dB) at shortest pulse width, at 1310 nm.
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Ranges

Ranges for LA Modules

Ranges for MA, MAE and MP Singlemode Modules

5 ns 30 ns 60ns 100 ns 300 ns 1 μs 3 μs 10 μs 20 μs

0.1 km x x

0.5 km x x

1 km x x x

2 km x x x x

5 km x x x x x

10 km x x x x x x

20 km x x x x x x x

40 km x x x x x x x x x

80 km x x x x x x x x

260 km x x x x x

3 ns 10 ns 30 ns 100 ns 300 ns 1 µs 3 µs 10 µs 20 µs 

0.5 km x x x

1 km x x x

2 km x x x x

5 km x x x x x

10 km x x x x x x

20 km x x x x x x x

40 km x x x x x x x x x

80 km x x x x x x x

160 km x x x x x

260 km x x x
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Ranges for Multimode Modules

Class of the lasers of the OTDR modules

OTDR modules measurement
Weight: approx. 300 g (0,66 lbs) (400g for the QUAD OTDR Module)

Dimensions (in mm) - w x h x d: 128 x 134 x 41

3 ns 10 ns 30 ns 100 ns 300 ns 1 µs

0.5 km x x

1 km x x x

2 km x x x x

5 km x x x x x

10 km x x x x x x

20 km x x x x x

40 km x x x

80 km x x x

Module Standard EN 60825-1, Ed 1.2, 2001 -08 FDA21CFR§1040.10

Singlemode LA, MA & 
MAE OTDR Modules

Class1 Class 1

Singlemode MP 
OTDR Module

Class 1M @ 1310 nm
Class 1 @ 1490, 1550, 1625 & 1650 nm

Class 1

Multimode OTDR 
Modules

Class 1M @ 850 nm
Class 1 @ 1300 nm

Class 1
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Technical specifications of the Power meter 
function on module for T-BERD/MTS 2000/
4000

Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

Power meter option for Singlemode Modules

Power meter option for Multi/Single mode Modules

Plug-ins Singlemode
Power meter of the MA, MAE 

& MP Modules
Power meter of the 
E4126 LA Module

Measurement Wave-
length

1310 / 1490 / 1550 / 1625 / 
1650 nm

1310 / 1490 / 1550 nm

Calibrated Wavelength
1310 / 1490 / 1550 / 1625 / 

1650 nm
1310 / 1550 nm

Accuracy at calibrated 
wavelengths

± 0.5 dB (at -30 dBm) ± 0.5 dB (at -30 dBm)

Input power range - 55 to 0 dBm - 50 to -2 dBm

Maximum resolution 0.01 dB / 0.01nW 0.01 dB / 0.01nW

Linearity within the 
specification range

± 0.5 dB
(- 50 to - 5 dBm)

-

Plug-ins Single / Multi mode Singlemode Power meter Multimode Power meter

Measurement Wavelength
1310 / 1490 / 1550 / 1625 / 

1650 nm
850 and 1300 nm

Calibrated Wavelength
1310 / 1490 / 1550 / 1625 / 

1650 nm
850 and 1300 nm

MTS2100 4100 Module US rev11.book  Page 260  Jeudi, 7. janvier 2016  1:29 13



Chapter 12 Technical specifications
Technical specifications of the Source function on module for T-BERD/MTS 2000/4000

User Manual 77000010208 Rev. 011 261

Technical specifications of the Source 
function on module for T-BERD/MTS 2000/
4000

• Laser Class 1 

• Wavelength lasers at 25°C, depending on the wavelengths available 
in the module:

– 850 ± 20 nm

– 1300 ± 30 nm

– 1310 ± 20 nm

– 1490 ± 20 nm

– 1550 ± 20 nm

– 1625 ± 20 nm

– 1650 ± 20 nm

The wavelengths available for the source are the same as those 
available for the OTDR module.

• Spectral bandwidth: 5 nm RMS typical

• Stability: 0.3 dBm

Accuracy at calibrated wave-
lengths

± 0.5 dB (at -30 dBm) ± 1 dB (at -15 dBm) 1

Input power range - 50 to - 2 dBm - 30 to -3 dBm

Maximum resolution 0.01 dB / 0.01nW

Linearity within the specifi-
cation range

± 0.5 dB (- 45 to - 5 dBm) -

1. Using a mode conditioner

Plug-ins Single / Multi mode Singlemode Power meter Multimode Power meter
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Output level

• - 3.5 dBm typical for continuous signal (CW)

• modulated mean level: - 6.5 dBm typical

Emission mode

• Continuous signal (CW), not available for the 1650 nm wavelength 
on the MP OTDR Module.

• Signal including lambda information for the power meter (Autoλ).

• Modulated signal to identify the fiber (at 270 Hz/330 Hz/1kH/2kHz).

• Wavelengths activated one after the other (TwinTest mode).

Technical specifications of the 
FiberComplete modules

Typical values, measured at 25°C unless specified.

This function is not available with SmartOTDR.

Bi-directional testing

Wavelength 1310 / 1490 / 1550 / 1625 nm 1

Insertion Loss

Dynamic range 40 dB typ

IL uncertainty +/- 0,25 dB2

IL repeatability < 0,05 dB3

Display resolution 0.01 dB
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For the OTDR specifications, please refer to page 254.

ORL

ORL range up to 55 dB

ORL uncertainty +/- 0,5 dB4

ORL repeatability < 0,1 dB5

Display resolution 0.01 dB

Length 6

Measurement range 150 km

Accuracy 
- From 50 m to 20 km range
- Above 20 km

+/- 30m
+/- 100m

1. 1625nm not available with filtered version
2. side by side reference
3. without disconnection
4. from 10 to 45 dB range
5. from 20 to 40 dB
6. measurement @ 1550 nm with an index of refraction n = 1.468
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OTDR Technical specifications for 
SmartOTDR

OTDR Optical Interfaces
Interchangeable optical connectors: FC, SC1

OTDR Optical characteristics

1.SC mandatory for E136FB configuration

Laser safety class (21 CFR) Class 1

Distance units Kilometer, meter, feet, and miles

Group index range 1.300000 to 1.700000 in 0.00001 steps

Number of data points Up to 256,000 data points

Distance measurement Automatic or dual cursor

Display range 0.1 km to 260 km for single-mode

Cursor resolution 1 cm

Sampling resolution 4 cm for single-mode

Accuracy
±1 m ±sampling resolution ±1.10–5 * x dis-
tance (Excluding group index uncertainties)
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Characteristics of reflectometry measurements 

Distance measurement 

• Automatic or Dual cursor 

• Distance displayed takes into account the calibration of the refractive 
index of the fiber.

• Index adjustable from 1,30000 to 1,70000 in steps of 0,00001

• Resolution of display: 1 cm max.

• Resolution of cursor: 1 cm max.

• Spacing of measurement points: from 4 cm, with up to 256 000 
acquisition points.

• Accuracy: ± 1m± sampling resolution ±1.10-5 x distance
(excluding errors of calibration of refractive index of the fiber).

• Display span: 0.1 km m to 260 km for single mode

Attenuation measurement 

• Automatic, manual, 2-point, 5-point, and LSA

• Resolution of display: 0,001 dB

• Resolution of cursor: 0,001 dB

• Linearity: ± 0.04 dB/dB for single mode

• Display span: 1.25 dB to 55 dB

Reflectance / ORL Measurement

• Resolution of display: 0,01 dB

• Accuracy: ± 2 dB
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Automatic measurement

• Automatic measurement of all the elements of the signal. Slope 
measurement by least squares or 2 points of measurement.

• Display threshold of faults:

- 0 to 5.99 dB in steps of 0.01 dB for event thresholds 
- -11 to -99 dB in steps of 1 dB for the reflectance
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

• Display of slope and attenuation for a segment of fiber.

• Display of the position of a fault and of attenuation.

• Display of the reflectance of the fault.

• Display of ORL

Manual Measurement

• Measurement of slope between the cursors.

• Measurement of attenuation between two segments of fiber.

• Measurement of reflectance of a reflecting element.

• Measurement of ORL between the two cursors.

• Measurement of splice by 2 or 5 points method 

Typical specifications
Typical values, measured at 25°C unless specified.

E136FB (2 ports) E126A

Central Wavelength1
1310 +/- 20nm
1550+/- 20nm

filtered 1625 nm +/- 20nm 

1310 nm +/- 20nm
1550 nm +/- 20nm

Typical RMS Dynamic Range2 40 / 40 / 41 dB 35 / 33 dB
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Distance Range3 Up to 150 km Up to 100 km

Pulse width 3 ns to 20µs 5 ns to 20µs

Event Dead Zone4 0.90 m 1.30 m

Attenuation Dead Zone5 2.5 m 4 m

Splitter Attenuation Dead Zone 45 m after 15dB splitter loss N/A

1. Laser, at 25° C and measured at 10 µs
2. Typical value corresponding to the one-way difference (in dB) between the extrapolated back-

scattering level at the beginning of the fiber and the RMS (SNR = 1) noise level, after 3 minutes 
averaging, using the largest pulse width.

3. At 1550 nm
4. EDZ measured at +/- 1.5 dB below the peak of a unsaturated reflective event using the shortest 

pulse width.
5. ADZ measured at +/- 0.5 dB from the linear regression, using a FC/UPC- type reflectance, at 

shortest pulse width.

E136FB (2 ports) E126A
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Chapter 13Options and accessories

This chapter shows the references of the options and accessories for the 
modules of the MTS/T-BERD 2000 or T-BERD/MTS-4000, and the refer-
ences for the SmartOTDR

The topics discussed in this chapter are as follows:

• “References of measurement modules for T-BERD/MTS 2000/4000” 
on page 270

• “References of the SmartOTDR” on page 273

• “User manual references” on page 274

• “References of optical connectors and adapters” on page 274
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References of measurement modules for T-
BERD/MTS 2000/4000

OTDR Modules1

Multimode Module

Singlemode Module

1. Specify optical connector of each OTDR ports

Modules Reference

Multimode 850 / 1300 nm OTDR Module E4123MM

LA Modules Reference

LA OTDR 1310/1550 nm Module with source option E4126LA

LA OTDR 1550 nm Module with source option E4115LA

LA OTDR filtered 1650 nm Module E4118RLA65

MA Modules Reference

Metro Access 1310/1550 nm OTDR Module E4126MA

Metro Access 1310/1550/1625 nm OTDR Module E4136MA

Metro Access Range filtered 1650 nm OTDR Module E4118RMA65

Metro Access Range 1310/1550 nm & filtered 1625 nm 
one port OTDR module

E4136RMA
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FiberComplete module with OTDR function

MAE Modules Reference

Extended Metro Access Range 1310/1550 nm OTDR 
Module

E4126MAE

MP Modules Reference

Metro PON 1310/1550 nm OTDR Module with Source 
option

E4126MP

Metro PON 1310/1550/1625 nm OTDR Module with 
Source option

E4136MP

Metro PON 1310/1490/1550 nm OTDR Module with 
Source option

E4138MP49

Metro PON 1310/1550 nm and Filtered 1625 nm 
OTDR Module with Source option

E4136RMP

Metro PON 1310/1550 nm and Filtered 1650 nm 
OTDR Module with Source option

E4138RMP65

Metro PON Filtered 1650 nm OTDR Module with 
Source option

E4118RMP65

Multimode/Singlemode Modules Reference

Multimode/Singlemode 850/1300/1310/1550 nm OTDR 
Module

E4146QUAD

Modules References

1310/1550 nm FiberComplete with 37/35 dB 
MA OTDR

E4126FCOMP-MA

1310/1550/1625 nm FiberComplete with 37/35 /
35 dB MA OTDR

E4136FCOMP-MA
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FiberComplete module with Fault Finder 
function

Options

1310/1550/ Filtered 1625 nm FiberComplete 
with 37/35/35 dB MA OTDR

E4136FCOMP-RMA

1310/1490/1550 nm FiberComplete with 41/39/
39 dB MP OTDR

E4138FCOMP-MP

Modules References

Modules References

1310/1550 nm FiberComplete E4126FCOMP-FF

1310/1550/1625 nm FiberComplete E4136FCOMP-FF

1310/1490/1550 nm FiberComplete E4138FCOMP-FF

Modules Reference

Power meter option for OTDR modules E41OTDRPM

Light source option for OTDR modules E41OTDRLS

Mode Conditioner for Multimode fiber References

Encircled flux mode conditioner embedded in a 
patchcord for 50 µm multimode fiber in FC/PC

EFJEF50CONFCPC 

Encircled flux mode conditioner embedded in a 
patchcord for 50 µm multimode fiber in SC/PC

EFJEF50CONSCPC
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References of the SmartOTDR

Non Reflective Terminator Packages References

SC/PC and SC/APC non-reflective terminator package ENRTERMSC

FC/PC and FC/APC non-reflective terminator package ENRTERMFC

OTDR Configurations1 References

SmartOTDR 1550nm A Range Handheld Tester With Continu-
ous Light Source & PC Connector

E100A-PC

SmartOTDR 1550nm A Range Handheld Tester With Continu-
ous Light Source & APC Connector

E100A-APC

SmartOTDR 1310/1550nm A Range Handheld Tester With 
Continuous Light Source & PC Connector

E126A-PC

SmartOTDR 1310/1550nm A Range Handheld Tester With 
Continuous Light Source & APC Connector

E126A-APC

SmartOTDR 1310/1550nm & Filtered 1625nm B Range Hand-
held Tester With Continuous Light Source & PC Connector2

E136FB-PC

SmartOTDR 1310/1550nm & Filtered 1625nm B Range Hand-
held Tester With Continuous Light Source & APC Connector

E136FB-APC

1. Comes with AC/DC converter/adapter, hands-free carrying case, stylus and getting started 
manual. 
OTDR connector adapter and battery type (LiPo mandatory for E126A and E136FB) are not 
included.

2. available with SC OTDR connector adapter (EUSCADS) only
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User manual references

References of optical connectors and 
adapters

User manuals for MTS/T-BERD modules References

Printed user manual for OTDR functions, Options 
and Software applications (French)

E4100M01

Printed user manual for OTDR functions, Options 
and Software applications (English)

E4100M02

Printed user manual for OTDR functions, Options 
and Software applications (German)

E4100M03

NOTENOTE

The User Manuals are available in pdf format, into the unit.

The printed versions are available on option, in French, 
English or German.

Front Panel Optical Connectors for modules1

Single-mode Universal OTDR (Except LA OTDR 
Modules)

Reference

Universal PC Connector with FC adapter EUNIPCFC

Universal PC Connector with SC adapter EUNIPCSC

Universal PC Connector with ST adapter EUNIPCST
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Universal PC Connector with DIN adapter EUNIPCDIN

Universal PC Connector with LC adapter EUNIPCLC

Universal APC Connector for SM only with FC adapter EUNIAPCFC

Universal APC Connector for SM only with SC adapter EUNIAPCSC

Universal APC Connector for SM only with ST adapter EUNIAPCST

Universal APC Connector for SM only with DIN adapter EUNIAPCDIN

Universal APC Connector for SM only with LC adapter EUNIAPCLC

1. A connector (universal) must be specified at time of order of the module

Front Panel Optical Connectors for Single-mode 
LA OTDR modules1

1. A connector (universal) must be specified at time of order of the module

Reference

Universal PC Connector with FC adapter for LA Mod-
ules (Screw Type)

EUNISPCFC

Universal PC Connector with SC adapter for LA Mod-
ules (Screw Type)

EUNISPCSC

Universal APC Connector ith FC adapter for LA Mod-
ules (Screw Type)

EUNISAPCFC

Universal APC Connector with SC adapter for LA Mod-
ules (Screw Type) 

EUNISAPCSC

Front Panel Optical connectors for plug-ins1

Multi-mode Universal OTDR
Reference

Universal PC Connector with FC adapter EUNIPCFCMM

Universal PC Connector with SC adapter EUNIPCSCMM

Front Panel Optical Connectors for modules1

Single-mode Universal OTDR (Except LA OTDR 
Modules)

Reference
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Universal PC Connector with ST adapter EUNIPCSTMM

Universal PC Connector with DIN adapter EUNIPCDINMM

Universal PC Connector with LC adapter EUNIPCLCMM

1.  A Connector (fixed or universal) must be specified at time of order of the plug-in

 Additional Adapters for Universal Connectors1

1. Interchangeable in the field

Reference

Universal FC Adapter EUFCAD

Universal FC Adapter (Screw Type) EUFCADS

Universal SC Adapter EUSCAD

Universal SC Adapter (Screw Type) EUSCADS

Universal ST Adapter EUSTAD

Universal DIN Adapter EUDINAD

Universal LC adapter EULCAD

Front Panel Optical connectors for plug-ins1

Multi-mode Universal OTDR
Reference
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MTS2100 4100 Module US rev11.book  Page 277  Jeudi, 7. janvier 2016  1:29 13



Index

278 User Manual 77000010208 Rev. 011

G
Ghost 38, 70

I
Index Of Refraction (IOR) 35

IOR
Specifications 254, 265

L
Laser 28

Laser classes 259

Launch cable 142

Loopback 130

LTS
Store 133

M
Mail

file expedition 242

Measurement
Attenuation measurement 5
Distance (specif.) 254, 265
Optical link loss 6
Power measurement 5
Reflectance (specif.) 255, 265

Module
fitting and removing 8

Multi-wavelength acquisition 61

O
ORL 85

Saturated trace 86

OTDR
Attenuation unit 35
Configuration 22, 24
Manual measurement

2 points 88

5 points 88
ORL 85
Slope 84, 85
Splice & Reflectance 87

Manual measurements 83
Measurement parameters 35
Module references 270
Options references 272
Principle of measurement 2
Results parameters 47, 120
Specif. measurement 254, 265

OTDR Events
Delete 83
Hints 83
Representation 82

OTDR module
Size 259

OTDR ranges 258

Overlay traces
Add 92
Display 79, 91
Remove 93

P
Platform

assembly 8
Power meter

Alarms 112
Attenuator 113
Configuration 111
Connection 110
Measurement process 126
Specifications 260
Zero value 127

Pulse 28, 142, 164

R
Range 29

Reference measurement 130
Loopback 130
Side by Side 128

Reference trace 93

References 269

MTS2100 4100 Module US rev11.book  Page 278  Jeudi, 7. janvier 2016  1:29 13



Index

User Manual 77000010208 Rev. 011 279

Reflectance 72
Definition 3
Specifications 255, 265

Resolution 29

S
Scatter coefficient 37

Shift function 77

Short acquisition 30, 80

Side by side 128

Slope 71, 84

Smart Link Cable
Cable project 192
Deactivated fiber 193
directory structure 195
Load project 189
Project files 195
Save project 188
Setup 187
Text file 196
Trace view 194

Source
Display 124

Specifications 253

Splice 87

T
Table Notes

OTDR 141, 167

U
Units 47, 120

User manual
References 274

Z
Zero value 127

MTS2100 4100 Module US rev11.book  Page 279  Jeudi, 7. janvier 2016  1:29 13



Index

280 User Manual 77000010208 Rev. 011

MTS2100 4100 Module US rev11.book  Page 280  Jeudi, 7. janvier 2016  1:29 13



MTS2100 4100 Module US rev11.book  Page 281  Jeudi, 7. janvier 2016  1:29 13



Viavi Solutions

North America: 1.844.GO VIAVI / 1.844.468.4284

Latin America +52 55 5543 6644

EMEA +49 7121 862273

APAC +1 512 201 6534

All Other Regions: viavisolutions.com/contacts

email TAC@viavisolutions.com

E4100M02/UM/06-15/AE
Rev 011, 01-16
English

MTS2100 4100 Module US rev11.book  Page 282  Jeudi, 7. janvier 2016  1:29 13


	OTDR Functions, Options and Software Applications
	Notice
	Copyright
	Trademarks
	Ordering information
	WEEE Directive Compliance

	Table of Contents
	About This Guide
	Purpose and scope
	Assumptions
	Technical assistance
	Recycling Information
	Conventions

	Chapter 1 Principle of Measurement
	Principle of reflectometry measurements
	Information yielded by the measurement
	Validity of Measurement ITU-T
	Reflectance

	Principle of optical power and attenuation measurements
	Power measurements
	Attenuation measurements (optical link loss)


	Chapter 2 Starting up
	Unpacking the device - Precautions
	Fitting and removing a module (not available with SmartOTDR)
	Fitting a module
	Removing a module

	Connecting fiber optic cable
	Inspecting and cleaning connector end faces
	Optical connector types
	Connecting Fiber optic cable to test port

	Optical connectors and interchangeable adapters
	Adapter types
	Switching adapter type
	Changing the adapter on a LA OTDR Module and on the SmartOTDR
	Cleaning universal connectors


	Chapter 3 Activating OTDR function
	Selecting the Smart Test
	Principle of the Smart Test
	Selecting Smart Test

	Selecting the OTDR Expert function
	Principle of the OTDR Expert
	Selecting OTDR Expert


	Chapter 4 Configuring the reflectometry test
	Configuring the unit for Smart Test
	Selecting the configuration file
	Modifying some parameters before the acquisition

	Configuring the test in Expert OTDR
	Configuring the Acquisition parameters
	Parameters
	Launch cable parameters

	Configuring the Alarms parameters
	Configuring the Analysis parameters
	Parameters
	Measurement

	Configuring the Link parameters
	Configuring the file storage parameters
	Configuration in Test Auto mode
	Saving OTDR configuration in a file
	Loading an existing OTDR configuration


	Chapter 5 Launching a reflectometry test and displaying results
	Performing OTDR acquisitions
	Performing an acquisition in Real Time mode
	Principle of the Real time mode
	Performing acquisition in Real Time
	Stopping the real time acquisition

	Performing a measurement with Smart Test
	Performing an acquisition with Expert OTDR
	Performing an acquisition from Results page
	Multi-wavelength acquisition
	Actions on trace during acquisition

	Results display
	Common functions
	Display of events on the trace
	Results table
	Cursors
	Zoom function
	Shift function (Expert OTDR only)
	Summary
	Display of traces in overlay
	Traces display in double acquisition mode


	Advanced functions in Expert OTDR mode
	Automatic measurement and detection
	Addition of events
	Manual measurements
	Measurements of slope
	Measurement of ORL
	Measurement of Reflectance
	Splice measurements

	Memorization of the position of events
	Overlay trace function
	Overlaying several traces stored in memory
	Display of traces in overlay
	Adding traces in overlay
	Swapping overlay traces
	Removing a trace
	Quitting the overlay menu

	Reference Trace function
	Use of the reference trace function in the Result page
	Using the reference trace function in the explorer


	Saving the trace(s) and generating a report
	Saving results and creating a report from results page
	Opening a report

	SLM (Smart Link Mapper) option
	Show the detailed information of one event
	Event View
	Changing the type of an event


	OptiPulsesTM option
	Configuring the OTDR acquisition with OptiPulses TM mode
	Results in OptiPulses TM mode


	Chapter 6 Power meter and Source options of the OTDR Modules
	Connection to the power meter
	Configuring the Power meter
	Configuring the measurement parameters of the power meter
	Configuring the alarm parameters
	Configuring the Measurement parameters
	Configuring the Link parameters
	Configuring the File parameters


	Activating the Source function
	Result page
	Result page of the Power meter
	Table of results
	Commands of the power meter parameters

	Result page of the Source

	Performing the power level measurement
	Performing the insertion loss measurement
	Setting the zero value of the power meter
	Carrying out the reference
	Carrying out the side by side reference
	Carrying out the reference in loopback mode

	Measurements on the fiber under test

	Storing and reloading results
	File Setup
	Storing results
	Loading results


	Chapter 7 FTTA-SLM Software option
	Principle of FTTA-SLM
	Acceptance Testing
	Troubleshooting Testing

	Configuring the Reflectometry test for FTTA network
	FTTA setup
	Acquisition (FTTA)

	Alarms
	Analysis
	Link
	File

	Launching the acquisition
	Results page
	Trace View
	SmartLink view
	Getting a diagnostic of an event
	Event View
	Changing the name of an event


	Saving the trace(s) and generating a report
	Saving results and creating a report from results page
	Opening a report


	Chapter 8 FTTH-SLM Software option
	Principle of FTTH
	Configuring the Reflectometry test for FTTH network
	FTTH setup
	FTTH (PON) Setup

	Alarms parameters
	Link parameters
	File parameters

	Launching the acquisition
	Results page
	Trace View
	SmartLink view
	Getting a diagnostic of an event
	Event View
	Changing the type of an event


	Saving the trace(s) and generating a report
	Saving results and creating a report from results page
	Opening a report


	Chapter 9 Cable-SLM option
	Principle of Cable-SLM
	Configuring the Cable-SLM project
	Configuring the project
	Saving the project
	Loading a existing project

	Starting project test process
	Trace saving

	Results of project cable
	Description of the table
	Deactivate the fiber test
	View Trace

	Files and Project storage
	Text file content


	Chapter 10 FiberComplete Modules
	General introduction
	Principle
	Configurations

	Activating the function
	Establishing References
	Reference stage process
	Loopback Referencing method
	Side-by-Side referencing method
	Factory References

	Configuring the units
	Acquisition parameters
	Alarms parameters
	Analysis parameters
	Link parameters
	File parameters
	Automatic configuration
	Saving the parameters from FiberComplete configuration
	Loading a configuration file FiberComplete

	Performing the tests
	Sending a message to the distant Platform
	Starting the test

	Results screen
	Cable view
	Fiber View
	Fault Finder
	OTDR

	Saving results and generating a report
	Saving results and creating a report from results page
	Opening a report

	File management
	Storing results
	Filenaming convention


	Chapter 11 File management
	Description of the explorer
	Opening the file explorer
	Managing tabs
	File signature
	Buttons on the right of the screen
	Storage media
	Directories and files editing function

	Saving and loading files
	Saving files from the Explorer
	Loading files and displaying traces
	Simple loading
	Load with configuration
	Loading several traces in overlay


	Exporting files
	Explorer/Link Manager
	Editing function
	Exporting a directory in a txt file
	Generating pdf report(s)
	Using the Merge key, with the txt/pdf files
	Sending files by e-mail (T-BERD/MTS 4000 only)


	Chapter 12 Technical specifications
	OTDR modules for T-BERD/MTS 2000/4000
	Characteristics of reflectometry measurements
	Manual Measurement

	Typical specifications
	Ranges
	Class of the lasers of the OTDR modules
	OTDR modules measurement

	Technical specifications of the Power meter function on module for T-BERD/MTS 2000/ 4000
	Technical specifications of the Source function on module for T-BERD/MTS 2000/ 4000
	Technical specifications of the FiberComplete modules
	OTDR Technical specifications for SmartOTDR
	OTDR Optical Interfaces
	OTDR Optical characteristics
	Characteristics of reflectometry measurements
	Typical specifications


	Chapter 13 Options and accessories
	References of measurement modules for T- BERD/MTS 2000/4000
	OTDR Modules
	FiberComplete module with OTDR function
	FiberComplete module with Fault Finder function
	Options

	References of the SmartOTDR
	User manual references
	References of optical connectors and adapters

	Index

